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chapter 1

Introduction
Plug-ins are special-purpose software compo-
nents that provide additional signal processing 
and other functionality to Pro Tools®.

The DigiRack™ plug-ins included with 
Pro Tools provide a comprehensive suite of dig-
ital signal processing effects that include EQ, dy-
namics, delay, and other essential functions.

Plug-in Formats
There are four plug-in formats used in Pro Tools: 

• TDM plug-ins (real-time, DSP-based)

• RTAS® plug-ins (real-time, host-based)

• AudioSuite™ plug-ins (non-real-time, file-
based processing)

• Elastic Audio plug-ins (both real-time and 
non-real time, host-based Time Compres-
sion and Expansion)

References to Pro Tools LE™ in this guide 
are usually interchangeable with Pro Tools 
M-Powered™ or Pro Tools Academic™, ex-
cept as noted in the Pro Tools M-Powered 
and Academic Getting Started Guides.
TDM Plug-ins
(Pro Tools HD Only)

TDM (Time Division Multiplexing) plug-ins 
function as track inserts, are applied to audio 
during playback, and process audio non-de-
structively in real time. TDM plug-ins are de-
signed for use with Pro Tools HD software on 
Pro Tools|HD® systems, and rely on the process-
ing power of Digidesign DSP cards.

The number and variety of TDM plug-ins that 
you can use simultaneously in a session are lim-
ited only by the amount of DSP available. You 
can increase available DSP by installing addi-
tional DSP cards (such as HD Core, HD Accel, or 
HD Process cards) in your computer. This 
power-on-demand aspect is a significant advan-
tage of Pro Tools|HD systems.
Chapter 1: Introduction 1
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RTAS Plug-ins 

RTAS (Real-Time AudioSuite) plug-ins provide 
features and functionality similar to their TDM 
counterparts, but unlike TDM plug-ins, they rely 
on and are limited by the processing power of 
your computer. The more powerful your com-
puter, the greater the number and variety of 
RTAS plug-ins that you can use simultaneously. 

Because of this dependence on the CPU or host 
processing, the more RTAS plug-ins you use con-
currently in a session, the greater the impact it 
will have on other aspects of your system’s per-
formance, such as maximum track count, num-
ber of available voices, the density of edits pos-
sible, and latency in automation and recording.

RTAS plug-ins can be used with Pro Tools HD, 
Pro Tools LE™.

AudioSuite Plug-ins 

AudioSuite plug-ins are used to process and 
modify audio files on disk, rather than nonde-
structively in real time. Depending on how you 
configure a non-real-time AudioSuite plug-in, it 
either creates an entirely new audio file, or alters 
the original source audio file. Audio-Suite plug-
ins can be used on all Pro Tools systems and 
Avid software.

Elastic Audio Plug-ins 

Elastic Audio plug-ins provide Time Compres-
sion and Expansion (TCE) algorithms for apply-
ing Real-Time and Rendered, track-based Elastic 
Audio processing. The selected Elastic Audio 
plug-in determines how the audio is processed. 
Each plug-in uses a unique algorithm appropri-
ate for different types of audio (for example, use 
the Rhythmic plug-in for processing drum 
loops). 
DigiRack Plug-ins Guide
Elastic Audio plug-ins have their own unique se-
lector that is only available in the Edit window. 
You cannot insert Elastic Audio plug-ins on 
track Plug-in inserts (TDM, RTAS, and hardware 
inserts).

Elastic Audio plug-ins can be used on all 
Pro Tools systems.

System Requirements
To use DigiRack plug-ins you need any the fol-
lowing:

• A Digidesign-qualified Pro Tools system 
running Pro Tools

• A Digidesign-qualified Pro Tools system 
and a third-party software application that 
supports the Digidesign TDM, RTAS, or 
AudioSuite plug-in standards

• A qualified Avid® Xpress®, Avid Xpress DV, 
or Avid DNA™ system (AudioSuite only)

• A qualified Digidesign VENUE system 
(TDM only)

For complete system requirements visit the 
Digidesign website (www.digidesign.com).

Compatibility Information

Digidesign can only assure compatibility and 
provide support for hardware and software it has 
tested and approved. 

For a list of Digidesign-qualified computers, op-
erating systems, hard drives, and third-party de-
vices, visit the Digidesign website 
(www.digidesign.com).

For information about working with Elastic 
Audio and using Elastic Audio plug-ins, see 
the Pro Tools Reference Guide.



Conventions Used in This 
Guide
All Digidesign guides use the following conven-
tions to indicate menu choices and key com-
mands:
:

The following symbols are used to highlight im-
portant information:

Convention Action

File > Save Choose Save from the 
File menu

Control+N Hold down the Control 
key and press the N key

Control-click Hold down the Control 
key and click the mouse 
button

Right-click Click with the right 
mouse button

User Tips are helpful hints for getting the 
most from your Pro Tools system.

Important Notices include information that 
could affect your Pro Tools session data or 
the performance of your Pro Tools system.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
this guide and other Digidesign guides.
About www.digidesign.com
The Digidesign website (www.digidesign.com) is 
your best online source for information to help 
you get the most out of your Pro Tools system. 
The following are just a few of the services and 
features available. 

Registration Register your purchase online. See 
the registration form included with your system 
for instructions.

Support Contact Digidesign Technical Support 
or Customer Service; download software up-
dates and the latest online manuals; browse the 
Compatibility documents for system require-
ments; search the online Answerbase or join the 
worldwide Pro Tools community on the Digide-
sign User Conference. 

Training and Education Study on your own using 
courses available online or find out how you can 
learn in a classroom setting at a certified 
Pro Tools training center. 

Products and Developers Learn about Digidesign 
products; download demo software or learn 
about our Development Partners and their plug-
ins, applications, and hardware. 

News and Events Get the latest news from 
Digidesign or sign up for a Pro Tools demo.

To learn more about these and other resources 
available from Digidesign, visit our website 
(www.digidesign.com). 
Chapter 1: Introduction 3
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chapter 2

Installation and Configuration
Installing Plug-ins
The Digidesign DigiRack plug-ins are installed 
when you install Pro Tools. For more informa-
tion about installing Pro Tools, see the Getting 
Started Guide that came with your system.

If installing multiple packages of plug-ins, do so 
in the following order:

1  DigiRack plug-ins (installed with Pro Tools). 

2  Packs and other bundles included with your 
Digidesign system. 

3  Any additional plug-ins. Check with the man-
ufacturer of your plug-ins for compatibility in-
formation and support. 
Organizing Plug-ins
You can customize how plug-in lists (plug-in 
menus) are organized in the Insert selector and 
Plug-in selector.

Use the “Organize Plug-in Menus By” pop-up 
menu in the Pro Tools Display Preferences page 
to organize plug-in menus in a Flat List (with 
plug-ins in alphabetical order), Category, Manu-
facturer, or Category and Manufacturer. 

Plug-ins organized by categories

Plug-ins organized by manufacturer
Chapter 2: Installation and Configuration 5
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“Organize Plug-in Menus By” Option

Flat List Organizes plug-ins in a single list, in al-
phabetical order.

Category Organizes plug-ins by process category 
(such as EQ, Dynamics, Effects, and Delay), with 
individual plug-ins listed in the category sub-
menus. Plug-ins that do not have a Category de-
fined will appear in the Other Category folder. 
Plug-ins can appear in more than one category.

Plug-in categories include:

• EQ

• Dynamics

• Pitch Shift

• Reverb

• Delay

• Modulation

• Harmonic

• Noise Reduction

• Dither

• Sound Field

• Hardware

• Instrument

• Other

• Wrapped Plug-ins

• Effects

Manufacturer Organizes plug-ins by their manu-
facturer (such as Digidesign, Eventide, Line 6, 
McDSP), with individual plug-ins listed in the 
manufacturer submenus. Plug-ins that do not 
have a Manufacturer defined will appear in the 
“Other” manufacturer folder. 

Most Digidesign Development Partner plug-ins 
will be sorted as Digidesign when view by man-
ufacturer is enabled.
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Category and Manufacturer Organizes plug-ins 
in two levels of menus. The top menus display 
plug-ins by process category (such as EQ, Dy-
namics, and Delay), with individual plug-ins 
listed in the category submenus. The bottom 
menus display plug-ins by their manufacturer 
(such as Digidesign, Eventide, Line 6, McDSP), 
with individual plug-ins listed in the manufac-
turer submenus.

To select how plug-ins are organized:

1  Open or create a session. 

2  Choose Setup > Preferences, and click the Dis-
play tab.

3  Click the “Organize Plug-in Menus By” pop-
up menu, and select one of the view options. 

4  Click Done.

The current Organize Plug-in Menus By setting 
is saved with Pro Tools preferences (it is not 
saved with the Pro Tools session file). 

Plug-in Favorites

To find a plug-in faster, a plug-in can be desig-
nated as a favorite. Favorite plug-ins are shown at 
the top of the plug-in menu. 

Choosing Category view for plug-in menus



When a plug-in becomes a favorite, it is still 
shown in plug-in category and/or manufacturer 
sub-menus (if enabled) and its name appears in 
bold. 

To designate a plug-in as a favorite:

� Control-click (Windows) or Command-click 
(Mac) on a plug-in Insert button, and select a 
plug-in from the menu (or sub-menus, if en-
abled) to designate it as a favorite.

To change the status of a plug-in favorite:

1  Control-click (Windows) or Command-click 
(Mac) on a plug-in Insert button, a nd select a 
plug-in favorite that you no longer want to des-
ignate as a favorite. 

2  When selecting the plug-in favorite to change, 
you can select the plug-in from the list of favor-
ites at the top of the plug-in menu, or in its plug-
in category/manufacturer sub-menu (where the 
plug-in appears in bold). 

Menu display of favorite plug-ins (Category view shown)

Favorite plug-ins

Plug-in categories
Default Plug-ins

You can set a default EQ plug-in and Dynamics 
plug-in, which places them at the top of the In-
sert selector pop-up menu on-screen, and first in 
the list of menu choices when assigning inserts 
on ICON worksurfaces.

To set a default plug-in:

1  Choose Setup > Preferences and click Mixing.

2  Under Setup, choose a plug-in from the De-
fault EQ or Default Dynamics pop-up menu.

3  Click OK to close the Preferences window.

Default plug-in display in Insert selector menu

Default EQ plug-in

Default Dynamics
plug-in
Chapter 2: Installation and Configuration 7
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chapter 3

Working with Real-Time Plug-ins
Real-time plug-ins process audio nondestruc-
tively in real time. They do not alter the original 
source audio, but only apply their effect during 
playback. 

There are two formats of real-time plug-ins:

TDM Plug-ins Rely on the processing power of 
Digidesign DSP cards. TDM plug-ins run only on 
Pro Tools|HD systems.

RTAS Plug-ins Rely on the processing power of 
your computer. RTAS plug-ins run on 
Pro Tools|HD and LE systems.

Processing Power 
Requirements of TDM and 
RTAS Plug-ins
TDM and RTAS plug-ins differ in their process-
ing power requirements.

TDM Plug-ins

Each real-time TDM plug-in that is inserted in a 
Pro Tools session uses a portion of your system’s 
total available DSP resources. 

Since these DSP resources reside on the cards 
that make up your particular Pro Tools hardware 
configuration, the amount of DSP available de-
pends entirely on the number and type of DSP 
cards in your system.
You can add more mixing and processing power 
to your system by installing additional DSP 
cards, provided you have unused PCI (or PCIe) 
expansion slots in your computer or use a 
Digidesign-approved Expansion Chassis.

The System Usage window (Window > System 
Usage) shows how much DSP is available on 
your system, and gives an approximation of 
how it is currently being used. 

For more information on the System Usage 
window, see the Pro Tools Reference Guide.

System Usage window

See Appendix A, “DSP Requirements for 
TDM Plug-ins” for relative numbers of in-
stances of each DigiRack TDM plug-in that 
can be powered by a single DSP chip. DSP 
capacity differs with card type.
Chapter 3: Working with Real-Time Plug-ins 9
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DSP Sharing Between TDM Plug-ins

With Digidesign’s MultiShell™ II technology, 
different types of TDM plug-ins can share the 
same DSP chip at the same time. This lets you si-
multaneously use a greater variety of plug-ins by 
efficiently managing the DSP available on each 
chip in your system.

To take advantage of this capability, plug-ins 
must be MultiShell II compatible. All 
DigiRack TDM plug-ins with the exception of 
Pitch are MultiShell II compatible.

Some third-party plug-ins may not be MultiShell 
II compatible. To check compatibility, contact 
the manufacturer.

RTAS Plug-ins

RTAS plug-ins rely on and are limited by the pro-
cessing power of your computer’s CPU. The 
more RTAS plug-ins you use concurrently in a 
session, the greater the impact it will have on 
other aspects of your system’s performance, 
such as maximum track count, the density of ed-
its possible, and latency in automation and re-
cording.

The CPU meter in the System Usage window 
(Window > System Usage) shows how much of 
your computer’s processing power is currently 
being used by Pro Tools, and how much is still 
available.

For more information on the System Usage 
window, see the Pro Tools Reference Guide.
DigiRack Plug-ins Guide
Improving RTAS Plug-in 
Performance

You can increase the number of RTAS plug-ins 
your system can use concurrently by increasing 
the Hardware Buffer Size and CPU Usage Limit.

Hardware Buffer Size

The Hardware Buffer Size (H/W Buffer Size) con-
trols the size of the hardware cache used to han-
dle host processing tasks such as monitoring la-
tency and using Real-Time AudioSuite (RTAS) 
plug-ins. 

� Lower Hardware Buffer Size settings reduce 
monitoring latency, and are useful when you are 
recording live input. 

� Higher Hardware Buffer Size settings provide 
more audio processing and effects, and are use-
ful when you are mixing and using more RTAS 
plug-ins.

To change the Hardware Buffer Size:

1  Choose Setup > Playback Engine. 

2  From the H/W Buffer Size pop-up menu, select 
the audio buffer size, in samples.

3  Click OK. 

In addition to causing slower screen re-
sponse and monitoring latency, higher 
Hardware Buffer Size settings can affect the 
accuracy of plug-in automation, mute data, 
and timing for Instrument or MIDI tracks.



RTAS Processors

The RTAS Processors setting determines the 
number of processors in your computer allo-
cated for RTAS plug-in processing. 

With computers that have multiple processors, 
or that feature multi-core processing or hyper-
threading, this setting lets you enable multi-pro-
cessor support for RTAS processes. Used in com-
bination with the CPU Usage Limit setting, the 
RTAS Processors setting lets you control the way 
RTAS processing and other Pro Tools tasks are 
carried out by the system.

� A higher number of processors reserves more 
CPU processing capacity for RTAS plug-in pro-
cessing. This is useful for sessions with large 
number of RTAS plug-ins.

� A lower number of processors leaves more 
CPU processing capacity for automation, screen 
redraws, and video playback in Pro Tools, or for 
other application running at the same time as 
Pro Tools.

To set the number of RTAS Processors:

1  Choose Setup > Playback Engine.

2  From the RTAS Processors pop-up menu, se-
lect the number of available processors you 
want to allocate for RTAS plug-in processing.

3  Click OK.
CPU Usage Limit

The CPU Usage Limit controls the percentage of 
CPU resources allocated to Pro Tools host pro-
cessing tasks such as RTAS plug-in performance 
and screen redraws. 

� Lower CPU Usage Limit settings limit the ef-
fect of Pro Tools processing on other CPU-inten-
sive tasks, such as screen redraws, and are useful 
when you are experiencing slow system re-
sponse, or when running other applications at 
the same time as Pro Tools.

� Higher CPU Usage Limit settings allocate 
more processing power to Pro Tools, and are 
useful for playing back large sessions or using 
more real-time plug-ins. 

To change the CPU Usage Limit:

1  Choose Setup > Playback Engine. 

2  From the CPU Usage Limit pop-up menu, se-
lect the percentage of CPU processing you want 
to allocate to Pro Tools. (On dual-processor Mac 
computers, this setting controls the allocation 
of a single processor.)

3  Click OK.

Increasing the CPU Usage Limit may slow 
down screen response on slower computers.

For more information on the Hardware 
Buffer Size and CPU Usage Limit, refer to 
the Pro Tools Reference Guide.
Chapter 3: Working with Real-Time Plug-ins 11
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RTAS Error Suppression

You should only enable RTAS error suppression 
if you are experiencing frequent RTAS errors 
that are interrupting your creative workflow. 
When RTAS error suppression is enabled, you 
can experience a degradation of audio quality. 
However, this may be acceptable in order to 
avoid interrupting playback and recording 
when working with instrument plug-ins. Be sure 
to disable RTAS error suppression when you 
need to ensure the highest possible audio qual-
ity, such as for the final mix or audio layback.

To enable RTAS error suppression:

1  Choose Setup > Playback Engine.

Enabling Ignore Errors During Play-
back/Record only suppresses error reporting. 
RTAS errors can result in pops and clicks in 
the audio during playback and recording. To 
avoid this, try increasing the CPU Usage 
Limit and the HW Buffer Size, and reduce 
the number of RTAS plug-ins in use in the 
session.

Playback Engine dialog, Mbox 2 (Mac OS)
DigiRack Plug-ins Guide
2  Select Ignore Errors During Playback/Record.

3  If available, you can also select Minimize Ad-
ditional I/O Latency.

4  Click OK.

RTAS Error Suppression Options

Ignore Errors During Playback/Record When en-
abled, Pro Tools continues to play and record 
even if the RTAS processing requirements ex-
ceed the selected CPU Usage Limit. This can re-
sult in pops and clicks in the audio during play-
back and recording, but does not stop the 
transport.

Minimize Additional I/O Latency When enabled, 
any additional latency due to suppressing RTAS 
errors during playback and record is minimized 
to 128 samples. Suppressing RTAS errors re-
quires at least 128 samples of additional buffer-
ing on some systems. If the Minimize Additional 
I/O Latency option is disabled, the buffer is half 
the H/W Buffer Size, or at least 128 samples 
(which ever is greater). If you are on an older, 
slower computer, you may not want to enable 
this option since doing so can adversely affect 
performance.



The Minimize Additional I/O Latency option is 
only available if the Ignore Errors During Play-
back/Record option is enabled. 

This option is only available on Pro Tools sys-
tems that require additional buffering for RTAS 
error suppression, as follows:

• Windows XP:

• Mbox® 2 Pro

• Digidesign-qualified M-Audio interfaces 
with Pro Tools M-Powered or Pro Tools Ac-
ademic

• Mac OS X:

• Mbox

• Mbox 2

• Mbox 2 Pro

• Mbox 2 Mini

• Digi 002® and Digi 002 Rack

• All Pro Tools M-Powered systems

• All Pro Tools Academic systems

RTAS Plug-ins on Auxiliary Inputs or 
Master Faders

With Pro Tools HD, RTAS plug-ins can be in-
serted on Auxiliary Input and Master Fader 
tracks, or after TDM plug-ins on any kind of 
track.

This can affect voice usage and total latency, 
and limitations on inserting or removing plug-
ins during playback. For more information, see 
“RTAS Plug-ins on Auxiliary Input and Master 
Fader Tracks” on page 27.
Delay in Signal Processing
DSP and host-based processing in digital audio 
systems incurs signal delay of varying amounts. 
Such delays can vary from as short as few sam-
ples to as long as several hundred samples, de-
pending on the type of processing applied.

If you have recorded an instrument on multiple 
tracks using multiple microphones (a drum kit 
for example) and process the different tracks 
with different plug-ins, the tracks may go out of 
phase. You will then need to compensate for 
these delays to avoid phase cancellation prob-
lems.

Compensating for Delay

Use the following methods, as available, to com-
pensate for processing delay. 

Delay Compensation

Use Delay Compensation to automatically cal-
culate and compensate for processing delay. For 
more information on Delay Compensation, see 
the Pro Tools Reference Guide.

See Appendix B, “DSP Delays Incurred by 
TDM Plug-ins” for information on delays 
inherent in specific DigiRack TDM plug-
ins. See the Pro Tools Reference Guide for a 
guide to calculating DSP-induced delays.

Delay Compensation is automatically en-
abled on Pro Tools LE systems and cannot 
be turned off.
Chapter 3: Working with Real-Time Plug-ins 13
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TimeAdjuster 

You can compensate for TDM or RTAS plug-in-
induced delays by using the TimeAdjuster plug-
in. This plug-in lets you apply a specific number 
of samples of delay to the signal path of a 
Pro Tools track. TimeAdjuster provides settings 
files that apply the correct compensation time 
in samples for delay introduced by one or more 
plug-ins. See “TimeAdjuster” on page 89 for 
more information about the TimeAdjuster plug-
in. 

Manual Delay Compensation

You can manually compensate for processing 
delay by first calculating the amount of delay on 
each track, and then nudging other track’s play-
lists later or earlier in time. This method is useful 
when Delay Compensation is unavailable, or 
when you want to conserve resources.

Low-Latency Recording with 
Instrument Plug-ins

When an Instrument track containing an instru-
ment plug-in (or a MIDI track routing MIDI data 
to an instrument plug-in) is record enabled, 
Pro Tools automatically suspends delay com-
pensation through the main outputs of the au-

For information about TimeAdjuster in 
Delay Compensation sessions, see the 
Pro Tools Reference Guide. 

You can also compensate for offsets in-
curred by processing delays by using the 
same plug-ins on all tracks.
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dio track, Instrument track, or Auxiliary Input 
on which the instrument plug-in is inserted. This 
allows for latency-free monitoring of the instru-
ment plug-in during recording.

MIDI and Audio Processing Plug-ins

Some plug-ins, such as Bruno and Reso, process 
audio while allowing MIDI data to control pro-
cessing parameters. When you record enable an 
Instrument or MIDI track that is controlling an 
Audio processing plug-in, the track the plug-in 
is inserted on will go into low-latency mode, ef-
fectively making the processed audio play early. 

To keep audio time-aligned when using a MIDI 
controlled plug-in on an audio track:

� Start-Control-click (Windows) or Command-
Control-click (Mac) the Track Compensation in-
dicator for the audio track to apply delay com-
pensation. 

To keep audio time-aligned when using a MIDI 
controlled plug-in on an Auxiliary Input:

1  Start-Control-click (Windows) or Command-
Control-click (Mac) the Track Compensation in-
dicator for the Auxiliary Input to bypass delay 
compensation.

2  Enter the total system delay into the User Off-
set field.

Delay Compensation for instrument plug-
ins works only when all MIDI and audio 
connections take place inside of Pro Tools. 
For example, Pro Tools does not suspend 
delay compensation when you are using Re-
Wire to connect software synthesizers and 
samplers. 



Plug-ins as Inserts
Real-time plug-ins are available as in-line inserts 
on audio tracks, Auxiliary Inputs, and Master 
Faders. A maximum of 5 real-time plug-ins can 
be used per track.

When more than one insert is used on a track, 
they process the audio in series, each effect be-
ing added to the previous one, from top to bot-
tom in the Mix window.

Inserts can be used in two ways:

On Single Tracks An insert can be applied to an 
individual audio track or Auxiliary Input using 
the Insert selector on that track.

With in-line inserts, you control the level of ef-
fect by adjusting the controls of the plug-in.

As Shared Resources An insert can be used as a 
shared resource in a send-and-return arrange-
ment by bussing signals from several tracks to 
an Auxiliary Input, and applying the insert to 
the Auxiliary Input track. With such an arrange-
ment, you can control the send level for each 
track and the overall level of the effect can be 
controlled from the Auxiliary Input track.

Shared arrangements let you make more effi-
cient use of your system’s processing power.

Pre-Fader Operation

Real-time plug-ins function as pre-fader inserts 
(except on Master Fader tracks, where inserts are 
post-fader), meaning that their input levels are 
not affected by a track’s volume fader.

Real-time plug-ins are pre-fader, but post-disk. 
This means that if you record to disk with a 
plug-in inserted on the record track, you will 
hear the effect of the plug-in, but the effect will 
not be recorded to disk. 
To record with a plug-in effect, create an Auxil-
iary Input, insert the desired effect on the Auxil-
iary Input track, then route the Auxiliary Input 
to the audio track to which you want to record. 
Alternatively, bounce the audio track with the 
plug-in after recording in order to write the ef-
fected audio to disk.

Mono, Multi-Mono, and 
Multichannel Plug-ins

Plug-ins can be used in mono, multi-mono, or 
multichannel formats, depending on the type of 
plug-in and whether the destination is a mono 
or multichannel track.

In general, when working with stereo and 
greater-than-stereo tracks, use multichannel 
plug-ins. If a multichannel version of a plug-in 
is not available, use a multi-mono version.

Mono Plug-ins Used on mono tracks. Some 
mono plug-ins (such as Mod Delay) can gener-
ate stereo or greater-than-stereo output from a 
mono channel. Plug-ins that occur on a track af-
ter a stereo plug-in are used in stereo as well.

Multi-Mono Plug-ins Used on stereo or greater-
than-stereo multichannel tracks when a multi-
channel version of the plug-in is not available. 
Multi-mono plug-ins can analyze and process 
each channel independently without regard to 
each other. Controls for all channels are linked 
by default so that you can adjust them in tan-

Plug-in formats
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dem. You can unlink controls for independent 
adjustment using the Master Link button. See 
“Linking and Unlinking Controls on Multi-
Mono Plug-ins” on page 21.

Multichannel Plug-ins Used on stereo and 
greater-than-stereo multichannel tracks. On 
greater-than-stereo multichannel tracks, the 
controls for all channels are always linked to-
gether. 

Inserting Plug-ins on Tracks
To use a real-time plug-in in a Pro Tools session, 
insert it on a track. Before doing so, make sure 
the Inserts View is shown in the Mix or Edit win-
dow.

To show inserts in the Mix window:

� Choose View > Mix Window > Inserts.

To show inserts in the Edit window: 

� Choose View > Edit Window > Inserts.

Multi-mono plug-ins, such as dynamics-
based or reverb plug-ins, may not function 
as you expect. Use the multichannel version 
of a multi-mono plug-in when available.
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To insert a plug-in on a track:

� Click the Insert selector on the track and se-
lect the plug-in that you want to use. 

Removing an Insert from a Track

To remove an insert from a track:

� Click the Insert selector and select No Insert.

Inserting a plug-in with Plug-ins by Category enabled

Inserting a plug-in (standard view)

You can also drag and drop plug-in settings 
files (.tfx) from DigiBase browsers, or Win-
dows Explorer or the Mac Finder, to Inserts 
to insert the corresponding plug-in with 
those settings.

Removing a plug-in

click here



Configuring Plug-ins During 
Playback

You can change, add, or remove real-time plug-
ins and hardware inserts during playback. On 
Pro Tools|HD systems, adding or removing 
RTAS plug-ins that change voicing assignments 
(for example, inserting an RTAS plug-in after a 
TDM plug-in) temporarily interrupts playback, 
but without stopping the transport.

Plug-in Changes During Record

Changing plug-ins during audio recording is dis-
allowed so that you don’t inadvertently inter-
rupt audio recording. However, you can make 
changes while recording MIDI only.

Moving and Duplicating Inserts

You can move or duplicate an insert by dragging 
it to a different position on the same track or a 
different track. Inserts that are moved or dupli-
cated retain their original settings and automa-
tion.

To move an insert:

� Drag the insert to a new insert location.

Moving a plug-in

Dragging an insert on top of an existing in-
sert replaces it.
To duplicate an insert:

� Alt-drag (Windows) or Option-drag (Mac) the 
insert to a new insert location. The duplicated 
plug-in retains its original settings and automa-
tion.

Making Plug-ins Inactive

You can set plug-ins as inactive in order to free 
up DSP resources for other plug-ins and process-
ing. When a plug-in is inactive it retains its as-
signment, position, and related automation 
playlists. However, it will not pass audio and 
does not consume any DSP or TDM resources. 

To toggle a plug-in active or inactive, do one of the 
following:

� Control-Start-click (Windows) or Command-
Control-click (Mac) the Insert button.

– or –

� Make the track inactive. 

To toggle plug-ins in the same insert position on all 
tracks active or inactive:

� Control-Start-Alt click (Windows) or Com-
mand-Control-Option click (Mac) an Insert but-
ton in the position you want to toggle.

To toggle plug-ins in the same insert position on all 
selected tracks active or inactive:

� Control-Start-Alt-Shift-click (Windows) or 
Command-Control-Option-Shift-click (Mac) an 
Insert button in the position you want to toggle.

For more information about making tracks 
inactive, refer to the Pro Tools Reference 
Guide.
Chapter 3: Working with Real-Time Plug-ins 17
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The Plug-in Window
The Plug-in window appears whenever you click 
a plug-in Insert button on a track. This floating 
window lets you set the controls of any real-time 
plug-in insert in use on a track.

Track Selector Accesses any non-MIDI track in a 
session.

Insert Position Selector Accesses any insert on 
the current track.

Plug-in Selector Lets you select any real-time 
plug-in installed in the Plug-ins folder (that is 
created when you install Pro Tools).

Effect Bypass Button Disables the currently dis-
played plug-in. This lets you compare the track 
with and without the effect.

Insert button and selector on track

Plug-in window (mono Trim shown)

Insert
selector

Insert button

Settings menu

Track selector

Librarian menu

Insert Position
selector

Plug-in selector Compare

Target
button

Previous Setting

Next Setting

Settings
Select

Effect
Bypass

Automation Safe

Auto button

Convert
plug-in
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Convert Plug-in Selector Lets you convert the in-
sert from a TDM plug-in to an RTAS plug-in of 
the same type (or vice-versa). This feature can 
only be used on plug-ins that are available in 
both TDM and RTAS formats.

Clip LED Lights red to indicate if any meter in a 
plug-in has clipped (not available on all plug-
ins). The Plug-in Clip LED follows Pro Tools set-
tings for clip indication (see the Pro Tools Refer-
ence Guide for more information). 

Settings Menu Lets you copy, paste, save, and 
import plug-in settings.

Librarian Menu Recalls settings files saved in the 
plug-in’s root settings folder or in the current 
session’s Settings folder. See “Using the Librar-
ian” on page 127.

Next (+) and Previous (–) Setting Buttons Let 
you select the next or previous plug-in setting 
from the Librarian menu.

Plug-ins Settings Select Button Accesses the 
Plug-in Settings dialog, which lists the settings 
files for the current plug-in. From this list, you 
can select a new setting, or audition a series of 
settings.

Compare Toggles between the original saved 
plug-in setting and any changes you have made 
to it so you can compare them.

Auto Lets you enable individual plug-in controls 
for automation recording. See “Automating 
Plug-ins” on page 24.

Safe When enabled, prevents existing plug-in 
automation from being overwritten.

You will lose the current settings if they are 
not saved before you use the Next and Pre-
vious Setting buttons. Always save your set-
tings to the Librarian menu.



Target Button When multiple Plug-in windows 
are open, clicking this button selects that plug-
in as the target for any computer keyboard com-
mands.

Key Input Selector Lets you select audio on a 
particular input or bus and route it to trigger the 
plug-in. This menu only appears on plug-ins 
that feature side-chain processing. Key inputs 
are monophonic.

MIDI Node Display Shows MIDI node informa-
tion for MIDI-enabled plug-ins. MIDI nodes are 
virtual connections from Pro Tools to software 
instruments and other MIDI-enabled plug-ins. 
MIDI nodes are useful for routing multiple MIDI 
tracks to different channels of a single virtual 
MIDI device. MIDI node numbers are also dis-
played in the plug-in header and in a track’s 
MIDI Output selector.

Master Link Button When enabled, links the 
controls on all channels of a multi-mono plug-
in so that they can be adjusted in tandem.

Midi Node display in a plug-in header (Bruno shown)

Plug-in window (multi-mono 1-Band EQ shown)

MIDI Node

Channel selector

Link Enable buttons

Master Link button

Phase Invert
Link Enable Buttons Let you selectively link or 
unlink the controls of specific channels of a 
multi-mono plug-in. Each square represents a 
speaker channel. The Master Link button must 
be disabled to use the Link Enable buttons. See 
“Linking and Unlinking Controls on Multi-
Mono Plug-ins” on page 21.

Channel Selector Accesses a specific channel 
within a multichannel track for plug-in control 
editing. This menu appears only on multi-mono 
plug-ins inserted on tracks with more than one 
channel. Shift-clicking this selector opens a sep-
arate Plug-in window for each channel of the 
multichannel track on which the plug-in is in-
serted.

Phase Invert Button Inverts the phase polarity of 
the input signal on some plug-ins.

LFE Enable Enables plug-in processing of the LFE 
(low frequency effects) channel on a multichan-
nel track formatted for 5.1, 6.1, or 7.1 surround 
formats on some plug-ins. To disable LFE pro-
cessing, deselect this button. For more informa-
tion on the LFE channel, refer to the Pro Tools 
Reference Guide.

Plug-in window (multichannel Compressor/Limiter 
shown)

LFE Enable
Phase Invert 

button
Cha
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Tempo Sync Enables compatible plug-ins to au-
tomatically synchronize to the session tempo, 
for rhythmic delay, echo, and similar effects. See 
“Tempo Sync” on page 23 for more informa-
tion.

Opening Plug-in Windows

To open a Plug-in window:

� Click the plug-in button in the Mix or Edit 
window channel strip.

By default, each plug-in you open will appear in 
the same location as a currently open plug-in, 
replacing it in the same window location. 

Opening Multiple Plug-in Windows

Pro Tools normally displays a single Plug-in 
window from which you can adjust the controls 
of any plug-in in a session. You can also open 
additional Plug-in windows for specific plug-ins.

Once you begin working with multiple Plug-in 
windows, you will need to click the Target but-
ton on the plug-in whose controls you want to 
adjust using keyboard commands. 

To open an additional Plug-in window:

� Shift-click the Insert button for the additional 
plug-in.

To open Plug-in windows for each channel of a 
multi-mono plug-in:

� Alt-click (Windows) or Option-click (Mac) the 
Channel selector in the Plug-in window of the 
multi-mono plug-in.

To close all currently open Plug-in windows:

� Alt-click (Windows) or Option-click (Mac) the 
close box of any currently open Plug-in window.
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Plug-in Window Controls

All plug-ins provide standard Pro Tools controls 
for track and insert selection, bypass, and other 
controls, in addition to plug-in-specific con-
trols.

To select a different plug-in on the same track:

� Click the Insert selector and select a plug-in 
from the pop-up menu (or Category sub-menu).

To choose a different track:

� Click the Track selector and choose a track 
from the pop-up menu.

Selecting a plug-in from the Plug-in window

Choosing a track from the Plug-in window



To choose a different insert:

� Click the Insert Position selector and choose 
an insert from the pop-up menu.

Bypassing Plug-ins

To bypass a plug-in, do one of the following:

� Click the Plug-in window’s Bypass button.

– or –

� Control-click (Windows) or Command-click 
(Mac) the plug-in’s Insert button in the Mix or 
Edit window. 

Choosing an Insert from the Plug-in window

When a plug-in insert is bypassed, the In-
sert selector in the Mix window changes its 
color to blue for easy visual reference. If 
some, but not all channels of an unlinked 
multi-mono plug-in are bypassed, the Insert 
selector appears purple.

Bypass states indicated by color

Bypassed (blue)

Some channels bypassed (purple)

Unbypassed (gray)
Linking and Unlinking Controls on 
Multi-Mono Plug-ins

When a multi-mono plug-in is used on a multi-
channel track, the controls are normally linked. 
Adjusting the Gain control on one channel, for 
example, will adjust it for all channels.

If necessary, you can unlink plug-in controls on 
specific channels of a track and edit them inde-
pendently. You can also selectively link the con-
trols of specific channels.

To unlink controls on a multi-mono plug-in:

� Deselect the Master Link button.

To access controls for a specific channel:

� Select the channel from the Channel selector.

To link the controls of specific channels:

1  Deselect the Master Link button if it is not al-
ready deselected.

2  Click the Link Enable buttons for the channels 
whose controls you want to link.

Plug-in window (multi-mono 1-Band EQ shown)

Channel selector

Link Enable buttons

Master Link button

Phase Invert
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Clip Indicators
Many plug-ins provide meters that let you see 
when the processed signal is clipping.

In addition to clipping displays that are a part of 
a plug-in’s individual interface, some plug-ins 
also report the clipping in the plug-in header. 
The insert button in the Mix and Edit window 
also turns red if a plug-in has clipped. 

To clear plug-in clipping:

� Click the clip LED in the plug-in header

To clear a clip indicator:

� Click the clip LED in the plug-in header

You can also clear plug-in, send, and, and track 
window clip indicators simultaneously.

To clear all clip indicators, do one of the following:

� Alt-click (Windows) or Option-click (Mac) 
any meter.

� Press Alt-C (Windows) or Option-C (Mac).

� Choose Track > Clear All Clip Indicators. 

Plug-in Clipping indicator in the plug-in header

Plug-in Clipping indication in the Mix window

Clip
LED

clipped
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Using the Side-Chain Input
The side-chain input is the split-off signal used 
by a plug-in's detector to trigger dynamics pro-
cessing, and is generally drawn internally from 
the input signal. However, some plug-ins let you 
switch between internal and external side-chain 
processing.

With external side-chain processing, a plug-in's 
detector is triggered by an external signal (such 
as a separate reference track or audio source) 
known as the key input.

A typical use for external side-chain processing 
is to control the dynamics of one audio signal 
using the dynamics of another signal (the key 
input). For example, a kick drum track could be 
used to trigger gating of a bass track to tighten it 
up, or a rhythm guitar track could be used to 
gate a keyboard pad.

Side-Chain Filters

Some plug-ins feature key high-pass and low-
pass filters. These controls let you define a spe-
cific frequency range in the side-chain signal 
with which to trigger the plug-in effect. A com-
mon production technique is to use these con-
trols to filter a drum track so that only specific 
high frequency sounds (such as a hi-hat) or low 
frequency ones (such as a tom or a kick) trigger 
the effect. 



Using a Key Input for External Side-
Chain Processing

To use a key input for external side-chain 
processing:

1  Click the plug-in’s Key Input selector and se-
lect the input or bus carrying the audio you 
want to use to trigger the plug-in.

2  Click External Key to activate external side-
chain processing.

3  Press the Spacebar to begin playback. The 
plug-in uses the input or bus that you chose as a 
key input to trigger its effect.

4  During playback, do any of the following to 
fine-tune side-chain triggering:

• To hear the audio source you have selected 
to control the side-chain, enable Side-
Chain Listen or Key Listen (depending on 
the plug-in). When finished, disable Side-
Chain Listen/Key Listen to resume normal 
plug-in monitoring.

• To filter the side-chain so that only specific 
frequencies trigger the plug-in, use the fil-
tering controls (if available) to select the 
desired frequency range.

5  Adjust the plug-in’s Threshold control (if 
available) and other controls as needed.

Selecting a key input
Tempo Sync
Pro Tools provides Tempo Sync to enhance MIDI 
Beat Clock support and overall tempo capabili-
ties of plug-ins that utilize MIDI Beat Clock 
(such as ReWire client applications). 

Tempo Sync provides a direct connection be-
tween session tempo and plug-in parameters 
that support MIDI Beat Clock. This direct con-
nection lets plug-in parameters such as delay, 
auto-pan, and other time-domain effects auto-
matically synchronize to and follow changes in 
session tempo. 

Tempo Sync simplifies MIDI Beat Clock config-
uration by making session tempo available to 
relevant plug-in parameters directly from within 
the plug-in window. For plug-ins that do not 
support Tempo Sync, the original MIDI Beat 
Clock window (Setup > MIDI > MIDI Beat Clock) 
remains available in Pro Tools.

Compatibility and Settings

When opening older sessions that included 
plug-ins that subscribe to MIDI Beat Clock, 
Tempo Sync will be automatically enabled. Any 
plug-ins that used automation for tempo change 
should have that automation suspended or de-
leted to avoid conflict with Tempo Sync. 

Tempo Sync is not available in plug-ins 
with which it would limit functionality. For 
example, for the Access Music Virus Indigo 
and IndigoV40 plug-in, use the Pro Tools 
MIDI Beat Clock window (Setup > MIDI > 
MIDI Beat Clock). See the Pro Tools Refer-
ence Guide for more information. 
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To utilize Tempo Sync:

1  Insert a plug-in that supports Tempo Sync, 
such as the DigiRack Mod Delay II. 

2  Click the Tempo Sync icon. The tempo shown 
will change to match the current session tempo. 

3  To set a rhythmic delay, click a note value 
(whole, half, quarter, eighth, or sixteenth), then 
do any of the following to further adjust the 
rhythm: 

• To enable triplet delay timing, click the 3 
button so that it is lit. 

• To set a dotted delay value, click to enable 
the dotted icon. 

• To apply some swing to the delay value, ad-
just the Groove slider. 

Tempo Sync icon (Mod Delay II shown)

Tempo Sync 
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Automating Plug-ins
You can automate changes to plug-in controls. 
Because Pro Tools creates a separate playlist for 
each plug-in control that you automate, you can 
later edit and modify each automated control 
individually. This lets you to build up complex 
automation in stages.

Preference Setting to Auto Enable All 
Plug-in Parameters

You can configure Pro Tools to enable all param-
eters for automation when you first assign a 
plug-in insert. 

To auto-enable all parameters on newly inserted 
plug-ins:

1  Choose Setup > Preferences, and click the Mix-
ing tab. 

2  In the Automation section, click to select the 
Plug-in Controls Default to Auto-Enabled set-
ting. 

• When selected, all applicable controls of 
newly added plug-ins are enabled for auto-
mation. 

• When not selected, the controls of newly 
added plug-in must be manually enabled 
for automation. 

To create automation for a stereo plug-in 
with separate controls for each channel, 
(such as Mod Delay), record the automation 
for one channel, then copy and paste it to 
the other channel.

For complete instructions on Pro Tools au-
tomation, refer to the Pro Tools Reference 
Guide.



Enabling Plug-in Parameters for 
Automation 

To enable plug-in controls for automation: 

1  Open the Plug-in window for the plug-in you 
want to automate.

2  Do one of the following:

• Click the Automation Enable button in the 
Plug-in window.

– or –

• Control-Alt-Start-click (Windows) or Com-
mand-Option-Control-click (Mac) the 
Track View selector in the Edit window.

Accessing the Plug-in Automation dialog

You can also Control-Alt-Start-click (Win-
dows) or Command-Option-Control-click 
(Mac) any plug-in control in the Plug-in 
window, then choose Open Automation Di-
alog from the pop-up menu.

Plug-in Automation button
3  Select the controls to automate and click Add. 
If there are multiple plug-ins on the same track, 
you can select from among these by clicking 
their buttons in the Inserts section of this dia-
log. 

4  Click OK to close the Plug-in Automation dia-
log.

Plug-in Automation dialog

As an alternative to using the Plug-in Auto-
mation dialog, you can enable individual 
plug-in controls directly from the Plug-in 
window by Control-Alt-Start-clicking (Win-
dows) or Command-Option-Control-click-
ing (Mac) the control. 

Shortcut for enabling plug-in automation
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To automate a plug-in:

1  In the Automation Enable window, make sure 
plug-in automation is enabled.

2  Select an Automation mode for each track 
containing plug-ins you want to automate. For 
the initial automation pass, choose Auto Write.

3  Click Play to begin writing automation, and 
move the controls you want to automate.

4  When you have finished, click Stop.

After the initial automation pass, you can write 
additional automation to the track without 
completely erasing the previous pass by choos-
ing Auto Touch mode or Auto Latch mode. 
These modes add new automation only when 
you actually move the control.

Automation Enable window

Plug--in Automation Enable button
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Record Safing Plug-in Automation

You can protect plug-in automation from being 
overwritten by using Automation Safe mode.

To enable plug-in safe mode:

1  Open a plug-in.

2  Click the Safe button so that it is highlighted.

To disable plug-in safe mode:

� In the Plug-in window, click the Safe button 
so that it is unhighlighted.

Automation Safe enabling a plug-in

Safe enabled



Instrument Plug-ins
Instrument plug-ins are unique from other plug-
ins in that they generate audio by synthesis or 
sample playback, and are controlled by MIDI. 
Typically, plug-in instruments are inserted on 
Instrument tracks.

You can also insert plug-in instruments on Aux-
iliary Input tracks and control them with an ad-
ditional MIDI track. In some cases you may 
want to insert and instrument plug-in on and 
instrument track, assign any additional audio 
outputs in may have to additional Auxiliary In-
put tracks, and control it from not only the In-
strument track on which it is inserted, but also 
from multiple MIDI tracks (for example, if you 
are using a multiple output–capable drum ma-
chine plug-in).

Multiple Outputs for Instrument 
Plug-ins

You can route the output of an instrument plug-
in to the main track outputs and to individual 
track inputs on other tracks. This lets you route 
multiple samples or synth sounds through sepa-
rate outputs for individual processing. 

For more information on Instrument tracks, 
see the Pro Tools Reference Guide.

For specific information about using multi-
ple plug-in outputs with third-party plug-
ins, consult the documentation from the 
plug-in manufacturer.
Main and Auxiliary Plug-in Outputs

When a plug-in that has both main and auxil-
iary outputs is inserted on a track, the plug-in’s 
main outputs are routed through the track that 
the plug-in is inserted on, and the plug-in’s aux-
iliary mono or stereo outputs are available in the 
track input pop-up menu on other tracks.

RTAS Plug-ins on Auxiliary 
Input and Master Fader Tracks
(Pro Tools HD Only)

In Pro Tools HD, RTAS plug-ins can be inserted 
on Auxiliary Input and Master Fader tracks, or 
after TDM plug-ins on any kind of track.

This also affects the following RTAS-related be-
havior in Pro Tools:

• Voice usage and total latency for RTAS 
plug-ins

• Limitations on inserting or removing plug-
ins during playback

If none of the inserted plug-ins has auxiliary 
outputs, the plug-in category in the track in-
put pop-up menu is grayed out.

While HTDM plug-ins have a fixed buffer 
size, latency caused by RTAS plug-ins is ad-
justable via the HW Buffer Size setting in 
the Playback Engine dialog. For more infor-
mation, see the Pro Tools Reference Guide.

When you use a previous version of 
Pro Tools to open a session originally cre-
ated in Pro Tools 7.0, any RTAS plug-ins 
inserted on Auxiliary Input or Master Fader 
tracks—or after TDM plug-ins on any kind 
of track—are made inactive.
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Voice Usage and Total Latency for 
RTAS Plug-ins

With Pro Tools HD, the initial insert of an RTAS 
plug-in may cause additional latency, and will 
take up two additional voices per channel 
(1 voice for input and 1 voice for output) in the 
following conditions:

• When inserted on an Auxiliary Input or 
Master Fader track 

• When inserted on an Instrument track that 
does not contain an instrument plug-in

• When inserted after a TDM plug-in on any 
kind of track

For example, the initial insert of an RTAS plug-
in on a mono Auxiliary Input track uses two 
voices (one channel with two voices), while the 
initial insert of that plug-in on a stereo Auxiliary 
Input track uses four voices (two channels with 
two voices each).

Subsequent RTAS plug-ins on the same track do 
not take up additional voices unless a TDM 
plug-in is inserted between other RTAS plug-ins. 

Furthermore, one additional voice is used for 
each occurrence of any of the following condi-
tions when using voices for RTAS plug-ins on a 
track:

• When you use an external side-chain for an 
RTAS plug-in on that track

• When you select multiple outputs for that 
track (one voice used for each output)

• When you select an AFL/PFL Path output in 
the Output tab of the I/O Setup dialog (one 
voice used for each channel)

Avoid inserting TDM plug-ins between 
RTAS plug-ins on any kind of track—this 
causes unnecessary voice usage and may 
cause additional latency.
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Ordering RTAS and TDM Plug-ins on an 
Audio Track

With Pro Tools HD, when RTAS and TDM plug-
ins are combined on an audio track, the order in 
which they are inserted has different results:

RTAS Plug-ins Grouped Before TDM Plug-ins No 
additional voices will be used, and no process-
ing latency will occur. RTAS plug-ins will be by-
passed when Record Enable or TrackInput mon-
itoring is enabled for that track. 

TDM Plug-ins Grouped Before RTAS Plug-ins Each 
initial insert of an RTAS plug-in after a TDM 
plug-in will cause processing latency, and will 
use voices as described in “Voice Usage and To-
tal Latency for RTAS Plug-ins” on page 28. RTAS 
plug-ins will stay active while Record Enable or 
TrackInput monitoring is enabled for that track. 

Ordering Recommendations

When combining RTAS and TDM plug-ins on an 
audio track, use one of the following two strate-
gies based on your recording needs:

• To ensure that RTAS plug-ins stay active when 
you record enable a track or use TrackInput 
monitoring, group all TDM plug-ins before 
RTAS plug-ins.

– or –

• To conserve voices and minimize processing 
latency, group all RTAS plug-ins before TDM 
plug-ins.

As a rule, always group plug-ins of the same 
type together, especially if inserting RTAS 
after TDM plug-ins. Otherwise, additional 
voices may be unnecessarily used, and un-
necessary latency may result.



Limitations for Inserting or 
Removing Plug-ins During 
Playback

When playing back tracks containing RTAS 
plug-ins, the following limitations on inserting 
or removing plug-ins apply:

• Inserting RTAS and TDM plug-ins on or re-
moving from Auxiliary Input, Master 
Fader, or Instrument tracks temporarily in-
terrupts playback, but without stopping 
the transport.

• Inserting an RTAS plug-in after a TDM 
plug-in on an audio track, or removing an 
RTAS plug-in from an audio track if it 
comes after a TDM plug-in, temporarily in-
terrupts playback, but without stopping 
the transport.

• Inserting a TDM plug-in before an RTAS 
plug-in on an audio track, or removing a 
TDM plug-in from an audio track if it 
comes before an RTAS plug-in, temporarily 
interrupts playback, but without stopping 
the transport.
HTDM Plug-in Conversion to 
RTAS
When you use Pro Tools 7.0 or higher to open a 
session that was last saved in a version of 
Pro Tools prior to 7.0, most HTDM plug-ins will 
be automatically converted to their RTAS coun-
terparts.

However, in rare cases, as with some third-party 
plug-ins, these plug-ins will not automatically 
convert to RTAS and display as inactive. This 
means that the plug-in either has not been con-
figured for automatic conversion or that no 
RTAS version is available.

In such cases, you must manually convert each 
individual HTDM plug-in to its RTAS counter-
part by selecting it’s RTAS version from the In-
sert selector or the Convert Plug-in pop-up 
menu. If an RTAS version is not available, the 
HTDM version will remain inactive.

When HTDM plug-ins are converted to 
RTAS, any RTAS plug-ins that precede 
TDM plug-ins on audio tracks will be by-
passed if you enable Record Enable or 
TrackInput monitoring on that track. See 
“Ordering RTAS and TDM Plug-ins on an 
Audio Track” on page 28 for details.
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chapter 4

Working with AudioSuite Plug-ins
AudioSuite plug-ins differ from TDM and RTAS 
plug-ins in that they are used to process and 
modify audio files on disk rather than nonde-
structively in real time. Depending on how you 
configure a non-real-time AudioSuite plug-in, it 
will either alter the original source audio file or 
create an entirely new audio source file. 

The AudioSuite Menu
AudioSuite plug-ins are accessed through the 
AudioSuite menu. 

Plug-ins can be organized in the AudioSuite 
menu in Pro Tools by Flat List (with plug-ins in 
alphabetical order), Category, Manufacturer, or 
Category and Manufacturer. 

AudioSuite Plug-ins 

1-Band EQ III Processes audio with selectable EQ 
filters in a 1-band module.

2–4 Band EQ III Processes audio with two, three, 
or four selectable EQ filters. 

7-Band EQ III Processes audio with up to seven 
selectable EQ filters. 

Click Creates an audio click as a tempo reference 
for performing and recording.

For more information, see “Organizing 
Plug-ins” on page 5.
Compressor/Limiter III Processes audio with 
compression, or limiting.

Chorus Processes audio with chorusing.

Flanger Processes audio with flanging.

Expander/Gate III Processes audio with ex-
pander-gating.

De-esser III Processes audio with de-essing to re-
move sibilance.

Duplicate Creates a new, continuous source au-
dio file (and region) from the selection.

Delay Adds up to 10.9 seconds of delay.

Multi-Tap Delay Adds up to four independently-
controllable delays to the original audio signal.

Normalize Uniformly adjusts all levels in a region 
or regions to a user-definable level, using the 
loudest peak in the audio file as the reference.

Ping-Pong Delay Adds a stereo, ping-pong delay 
to the audio signal by feeding back the original 
signal to its opposite channel.

Gain Adjusts gain (volume) change, in decibels 
or percentage before clip.

Invert Inverts phase (polarity).

Pitch Shift Changes an audio file’s pitch with or 
without changing its duration.
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Reverse Rewrites selected audio in reverse.

DC Offset Removal Recognizes and removes DC 
offset from audio files.

Signal Generator Generates audio tones for 
equipment calibration purposes.

Time Compression/Expansion Changes an audio 
file’s duration without changing its pitch.

Time Shift Changes an audio file’s duration and 
pitch independently or together (Varispeed).

The AudioSuite Window
When you choose a plug-in from the 
AudioSuite menu, the AudioSuite window ap-
pears. From this floating window you can access 
and edit the controls for any non-real-time Au-
dioSuite plug-in.

 AudioSuite window

Settings menu

Librarian menu

Plug-in
selector

Previous
Setting

File Mode selector

Selection
Reference

Preview
button

Use in Playlist button

Next
Setting Stereo Processing Mode button

Process
button

Bypass
button

Process
Mode

Settings
Select
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Plug-in Selector

From this menu you can select any AudioSuite 
plug-in installed in your Plug-ins folder. (The 
Plug-in selector follows the Pro Tools preference 
for Organize Plug-ins Menu By.) 

Selection Reference

This menu aims the selected process at either re-
gions selected in an audio track or playlist, or at 
regions selected in the Audio Regions List.

When you select a region on-screen (in either a 
track/playlist or the Region List) Pro Tools nor-
mally selects both occurrences of the region. 
Since you may not want to process both, this 
menu provides a convenient means of limiting 
the AudioSuite process to regions selected in one 
or the other.

Playlist Applies AudioSuite processing only to 
regions currently selected in tracks/playlists in 
the Edit window. Processing will not be applied 
to regions in the Audio Regions List.

Plug-in selector menu (flat list, non-category view)

Selection Reference pop-up menu (Invert plug-in shown)



Region List Applies AudioSuite processing only 
to regions currently selected in the Audio Re-
gions List. Processing will not be applied to re-
gions located in tracks and playlists in the Edit 
window.

Use In Playlist Button

This button determines whether the AudioSuite 
plug-in will replace all instances of the selected 
regions everywhere in the session, or only the oc-
currences of the regions that are currently se-
lected.

Use In Playlist Off When Use in Playlist is dis-
abled, a new, processed version of the selected 
region will be added to the Regions List. No orig-
inal regions will be replaced or overwritten any-
where in the session.

Use In Playlist On, Reference = Region 
List When Use in Playlist is enabled and the Se-
lection Reference pop-up menu is set to Regions 
List, all copies of the selected region will be re-
placed everywhere in the session.

If the Use In Playlist option is enabled in 
addition to Region List being selected in the 
Selection Reference pop-up menu, the pro-
cessing will be applied to the selected region 
in both the playlist and the Regions List.

Use in Playlist button
Use In Playlist On, Reference = Playlist When 
Use in Playlist is enabled and the Selection Ref-
erence menu is set to Playlist, only regions se-
lected in tracks in the Edit window will be re-
placed. If the session includes other copies of 
the region used in other playlists, those copies of 
the original, unprocessed region will not be re-
placed.

File Mode Selector

This menu lets you select whether or not the Au-
dioSuite plug-in will process the selected audio 
destructively or nondestructively, and how the 
original files will be modified.

There are three options:

Overwrite Files Processes the selected regions de-
structively, overwriting the original audio. Not 
all AudioSuite plug-ins can be used destruc-
tively. 

Create Individual Files Processes the selected re-
gions nondestructively, creating a new audio 
file for each region. The new audio files are 
added to the session, leaving the original source 
audio files in the Regions List unchanged. 
(Whether the processed audio is added to the 
current playlist or only to the Regions List, is de-
termined by the Selection Reference setting, as 
explained earlier.)

If the Selection Reference pop-up menu is set 
to Region List, the Use in Playlist button 
will automatically be disabled to ensure 
that you do not accidentally replace every 
occurrence of the region in a session.

File Mode pop-up menu (Invert plug-in shown)
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Create Continuous File Processes the selected re-
gions nondestructively and creates a new audio 
file consisting of the selected regions consoli-
dated into a single, unbroken region. This mode 
is particularly useful if you are assembling a 
composite track from multiple takes. This mode 
is not available when the Selection Reference is 
set to Region List.

Process Mode Selector

If you have made a selection that includes mul-
tiple regions, this pop-up menu lets you specify 
whether AudioSuite processing is performed on 
a region-by-region, or entire-selection basis.

Region by Region Analyzes each region in a se-
lection individually, rather than over the entire 
multi-region selection as a whole. 

Entire Selection Uses the entire selection for 
analysis. All regions will be analyzed and pro-
cessed relative to the entire selection.

The Create Continuous File option is not 
available with some time domain plug-ins. 
To achieve a similar result, use the Dupli-
cate plug-in to consolidate regions processed 
with these plug-ins.

Process Mode selector (Invert plug-in shown)
DigiRack Plug-ins Guide
Chan/Track Process Mode Selector

If you have made a selection that includes re-
gions from multiple tracks, the Normalize 
AudioSuite plug-in (as well as some third-party 
AudioSuite plug-ins) lets you choose whether 
you want to perform processing on a channel-
by-channel/track-by-track, or an all-channel/all-
tracks basis using the Chan/Track Process Mode 
selector.

Peak On Each Chan/Track Analyzes and pro-
cesses each selected track individually. If you ap-
ply the Normalize plug-in to multiple tracks or a 
multichannel track in Peak On Each Chan/Track 
mode, each channel or track will be normalized 
independently, without regard to the other se-
lected tracks.

Peak On All Chans/Tracks Uses all currently se-
lected channels and tracks for analysis. If you 
apply the Normalize plug-in to a multichannel 
track or multiple tracks in Peak On All 
Chans/Tracks mode, the tracks will be analyzed 
as a single entity and regions will be normalized 
relative to the averaged peak level within all se-
lected channels and tracks.

Chan/Track Process Mode selector pop-up menu 
(Normalize plug-in shown)



Preview

The Preview button lets you audition the effect 
of a plug-in before you process the audio. By ad-
justing the plug-in controls while you listen to 
this audio preview, you can fine-tune the effect. 
Not all AudioSuite plug-ins support this feature. 

The Preview function routes audio to the spe-
cific outputs you have chosen with the Audition 
pop-up menu in the Outputs page of the 
I/O Setup dialog. Make sure you have config-
ured this option correctly for your system or you 
may not be able to hear previewed audio.

Before you use Preview, be aware that: 

� The performance of the Preview function de-
pends on the speed of your CPU. Faster comput-
ers preview AudioSuite effects better than slower 
computers.

� Regardless of how many tracks and regions are 
currently selected, the Preview button will audi-
tion only the first selected stereo track or the 
first selected pair of mono tracks.

� If you are using Region-by-Region processing 
mode, the Preview function will preview only 
the first region within a multi-region selection. 
To hear all selected regions, temporarily select 
Create Continuous File from the File Mode 
menu before previewing.

� The Preview function is affected by the 
AudioSuite Buffer Size option (on the Processing 
page of the Pro Tools Preferences dialog). See 
“AudioSuite Processing Preferences” on page 37.

For more information on using the I/O 
Setup dialog to configure your system’s au-
dio outputs, refer to the Pro Tools Reference 
Guide.
Bypass

When Bypass is enabled, the selected audio is 
auditioned without AudioSuite processing. The 
Bypass button applies only to previewing. It 
does not affect actual AudioSuite processing. 

Process

Clicking this button begins AudioSuite process-
ing of the selected audio. Processing can occur 
during playback (though it may take slightly 
longer). Processed files are auto-named with the 
region or audio file’s name plus an acronym for 
the chosen AudioSuite process. 

New files are written to the hard disk specified 
for that track in the Disk Allocation dialog, or to 
the same drive as the original file if the region is 
not currently on a track. See “Auto-File Naming 
of AudioSuite-Processed Audio” on page 36.

Multichannel Processing

Most DigiRack AudioSuite plug-ins can process 
up to 48 channels of audio simultaneously.

When processing multiple regions of differ-
ent formats (mono and multichannel sur-
round, for example), all channels will be 
processed according to the channel format 
of the AudioSuite plug-in. Mono AudioSuite 
plug-ins can process stereo regions and ste-
reo AudioSuite plug-ins can process mono 
regions.
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Undoing AudioSuite Processing

If you have processed an audio selection nonde-
structively, the Undo and Redo commands let 
you undo the selected AudioSuite process. You 
can undo or redo an AudioSuite process during 
audio playback. 

Auto-File Naming of AudioSuite-
Processed Audio

When new audio files are created as a result of 
AudioSuite processing, Pro Tools will auto-name 
these files according to the type of plug-in used. 
The name of the region determines the prefix, 
while the type of AudioSuite plug-in determines 
the suffix.

Auto file-naming follows these rules:

� New regions are named beginning with the re-
gion name, followed by an abbreviation of the 
current AudioSuite process, followed by stan-
dard Pro Tools file and region numbering.

� If a plug-in’s File Mode pop-up is set to Over-
write, the original region’s name will not be 
changed. 

� If a plug-in’s File Mode pop-up is set to Create 
Individual Files, the resulting regions will have 
an abbreviated version of the plug-in name ap-
pended to them.

Undo is not available when a plug-in is con-
figured for destructive editing since the pro-
cess has already overwritten the source au-
dio file.
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Other AudioSuite Controls

In addition to the standard AudioSuite controls, 
there are a number of special-purpose controls 
found on certain plug-ins:

Plug-in Librarian and Settings Menus 

The Settings and Librarian pop-up menus that 
appear in some AudioSuite plug-ins provide a 
means of saving, loading, copying, pasting and 
organizing custom plug-in settings files. See 
“Using the Librarian” on page 127.

Analyze Button 

This button analyzes a selection without actu-
ally processing it. On the DigiRack Gain plug-in, 
you can use the Analyze feature to determine 
the maximum peak level on a track at a specific 
gain value before you process the audio.

Key Input Selector

Selects a track/bus to be used to trigger process-
ing. In order to use this feature, the key input 
source audio must occur at the same time as the 
target audio. Side-chain input is monophonic. 
See “Using the Side-Chain Input” on page 22.

Channel Mode Button

The Channel Mode button lets you process con-
tiguous channels within a selected region as 
though they were mono or stereo tracks (and in 
some cases greater-than-stereo tracks), regard-
less of the type of tracks they occupy.

Mono Mode Processes each contiguous channel 
within a selected region as a separate mono 
track. For example, a region comprised of six 
mono tracks would be processed as six mono 
tracks.

Side-chain inputs for plug-ins have no effect 
on AudioSuite processes when the Selection 
Reference is set to Region List.



Stereo Mode Processes each contiguous pair of 
channels within a selected region as a stereo 
track. When applied to an odd number of chan-
nels, the plug-in processes the last odd, unpaired 
channel as mono, using the left channel settings 
of the stereo plug-in. If you want the last track to 
be processed in stereo, you must select an addi-
tional track to pair it with—an empty one if nec-
essary.

For example, a region comprised of two mono 
tracks would be processed as a stereo track, with 
the first mono track processed as the left chan-
nel and the second mono track processed as the 
right channel.

Multi Mode Processes each set of three or more 
contiguous channels within a selected region as 
a multichannel greater-than-stereo track, with 
the number of selected channels determining 
the type of track. For example, five contigu-
ously-selected channels would be processed as a 
5.0 track, while seven contiguously-selected 
channels will be processed as a 7.1 track.

Multi mode is available only for certain 
plug-ins, such as Dynamics III.
AudioSuite Processing 
Preferences
Before you begin using AudioSuite plug-ins, use 
the Preferences dialog (Setup > Preferences > 
Processing) to configure default AudioSuite op-
tions according to your needs. These options in-
clude the default dither setting, a dither on/off 
checkbox and the AudioSuite buffer size option, 
as well as TC/E options.

AudioSuite 

Buffer Size Selects the size of Pro Tools memory 
buffer for processing and previewing AudioSuite 
plug-ins. Choices are Mini, Small, Medium, 
Large, or Jumbo. In general, choosing a smaller 
buffer speeds up AudioSuite previewing func-
tions. Choosing a larger buffer speeds up Audio-
Suite processing of audio files.

 Processing Preferences page
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To configure the AudioSuite Buffer Size:

1  Choose Setup > Preferences.

2  Click Processing.

3  Select an AudioSuite Buffer Size.

Though the default setting will work well for 
most situations, you may want to set the buffer 
according to your current task. Before you audi-
tion an AudioSuite plug-in, set this buffer to 
Mini or Small. Then, when you are ready to pro-
cess a file, reset it to Large or Jumbo.

4  Click Done.

Use AudioSuite Dither When selected, dither is 
applied during certain AudioSuite processes 
(such as Normalize and Gain), using the dither 
algorithm selected in the Dither Plug-in pop-up 
menu. Dither is most useful when working with 
low-level files or files that contain a fade in or 
fade out. 

Dither Plug-in Lets you choose the dither plug-in 
algorithm used during AudioSuite processing. 

Bit Depth Selects the default bit depth used by 
the dither function during AudioSuite process-
ing. Bit depth can be set to 16-, 18-, 20-, or 24-
bit.

For an explanation of dither, see the 
Pro Tools Reference Guide.
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TC/E

The TC/E section lets you choose the plug-in 
used for AudioSuite time compression and ex-
pansion processing, as well as its default set-
tings. 

TC/E Plug-in Selects the Time Compression/Ex-
pansion plug-in and default settings used when 
editing with the TCE Trim tool. If you own a 
compatible third-party time compression and 
expansion plug-in, you have the option of using 
it for Pro Tools time compression and expansion 
processes by selecting it here. 

Default Settings Selects the settings used by the 
selected AudioSuite TC/E plug-in. 

Refer to the Pro Tools Reference Guide for 
more information about the Time Compres-
sion/Expansion Trim tool.



Using AudioSuite Plug-ins
AudioSuite plug-ins can be applied to whole re-
gions, partial regions, or selections that are 
made up of whole and partial regions across one 
or more tracks.

When audio selected in the Edit window in-
cludes partial regions, the regions will automat-
ically be split into two or more regions when 
they are processed. Processing will occur only 
on the selection, leaving other regions un-
changed.

Only audio files on locally connected hard 
drives can be processed with AudioSuite plug-
ins. You cannot process audio files on remote 
hard drives over a network (unless it is a Unity 
network).

Selecting Tracks for AudioSuite 
Processing

Because AudioSuite processes are performed on 
the specific regions that you select, it is impor-
tant that you select only those regions, or parts 
of regions, you actually want to process. 

Selecting a region in the Audio Regions List will 
automatically select it in a track (if it currently 
resides on one). This is the default behavior for 
Pro Tools. However, you can change this using 
the Region Selection Follows Track Selection, or 

Processing a locked region will cause the re-
gion to become unlocked, and processing a 
muted region will cause it to become un-
muted. For more information on locked and 
muted regions, refer to the Pro Tools Refer-
ence Guide.
Track Selection Follows Regions List Selection 
options in the Editing page of the Preferences di-
alog. Refer to the Pro Tools Reference Guide for an 
explanation of these Preferences.

Selecting Tracks for Delay or Reverb 
Processing

Because some AudioSuite effects such as delay 
and reverb add additional material to the end of 
the selected audio, it is important that you make 
a selection that is longer than the original source 
material so that the plug-in can write it to the 
audio file. If you select only the original mate-
rial, without leaving additional space at the end, 
any reverb decay or delay that occurs after the 
end of the region will be cut off.

To compensate for this, place the region in a 
track and select the desired audio plus an 
amount of blank space at the end of the region 
equal to the amount of delay or reverb decay 
that you have added in the plug-in. The plug-in 
will then have space at the end of the region in 
which to write the final delay or decay. If you se-
lect more blank space than you need, you can 
remove it using the Trimmer tool after applying 
AudioSuite processing.

To process audio with an AudioSuite plug-in: 

1  Do one of the following:

• Make an Edit selection of the audio you 
want to process.

– or –

• Select audio regions in the Region List that 
you want to process.

2  Choose an AudioSuite plug-in from the 
AudioSuite menu. 

When processing a single audio channel 
with an AudioSuite plug-in, make sure that 
the plug-in is set to Mono mode, if available.
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3  Adjust the plug-in controls for the effect you 
want. These settings determine how the file is 
processed and what effect the processing has on 
the original regions. 

Follow these guidelines:

• To process the selected region only in the 
track in which it appears, select Playlist 
from the Selection Reference pop-up. Alter-
natively, if you want to process the selected 
region in the Audio Regions list only, 
choose Region List from this pop-up.

• If you want to process and update every oc-
currence of the selected region throughout 
your session, enable the Use In Playlist but-
ton (and also select Region List from the Se-
lection Reference pop-up). Alternatively, if 
you do not want to update every occur-
rence of the selected region, deselect the 
Use In Playlist button.

• To configure the plug-in for destructive 
processing, select Overwrite Files from the 
File Mode pop-up menu. This will over-
write and permanently modify the original 
source audio files. 

• Alternatively, to configure the plug-in for 
nondestructive processing, select Create In-
dividual Files from the File Mode pop-up 
menu. This will create new audio files that 
have been processed with the AudioSuite 
Plug-in and leave the original source audio 
files untouched.

• If you have selected multiple regions for 
processing and want to create a new file 
that connects and consolidates all of these 
regions together, select Create Continuous 
File from the File Mode pop-up menu.

4  Click the Preview button to begin audition 
processing of the selected material. 
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5  Make further adjustment to the plug-in pa-
rameters based if necessary.

6  When you are satisfied with the Preview re-
sults, click the Process button. 

The selected audio is processed according to the 
settings you have specified. Pro Tools appends 
an acronym to the region’s name indicating the 
AudioSuite process that has been applied. The 
new audio files then appear in your session.

Using AudioSuite Plug-ins in 
Stereo

Some AudioSuite plug-ins can be used in either 
mono or stereo. If you plan to use them in ste-
reo, be aware of the following:

� To process a mono track and obtain a stereo 
result, select the desired track or region plus an 
empty track or region. Then set the plug-in to 
Stereo mode and select the Sum Inputs button 
(if present) to center the dry signal. When you 
process the audio, the result will be two tracks or 
regions that represent the right and left chan-
nels of the processed audio. You should then 
pan these tracks hard right and hard left in your 
mix. 

� If you set a plug-in to Stereo mode, then select 
an odd number of Pro Tools tracks for process-
ing (as opposed to an even number), the plug-in 
will process the selected tracks in pairs, in stereo. 
However, the last odd, unpaired track will be 
processed as mono, using the left channel set-
tings of the stereo plug-in. If you want the last 
track to be processed in stereo, you must select 
an additional track to pair it with—an empty 
one if necessary. 

For more information, see “Channel Mode 
Button” on page 36.



chapter 5

Adjusting Plug-in Controls
Adjusting Plug-in Controls
You can adjust plug-in controls by dragging the 
control’s slider or knob, or by typing a value 
into the control’s text box. Additionally, some 
plug-ins have switches that can be enabled by 
clicking on them.

To adjust a plug-in control:

1  Begin audio playback so that you can hear the 
control changes in real time.

2  Adjust the controls of the plug-in for the effect 
you want. Refer to “Editing Parameters Using a 
Mouse” on page 41 and “Editing Parameters Us-
ing a Computer Keyboard” on page 41.

Closing the plug-in will save the most recent 
changes.

Plug-in controls of similar category (such as 
EQ or Dynamics plug-ins) can follow track 
groups. See the Pro Tools Reference Guide for 
more information. 
Editing Parameters Using a Mouse

You can adjust rotary controls by dragging hor-
izontally or vertically. Parameter values increase 
as you drag upward or to the right, and decrease 
as you drag downward or to the left.

Keyboard Shortcuts

� For finer adjustments, Control-drag (Win-
dows) or Command-drag (Mac) the control.

� To return a control to its default value, Alt-
click (Windows) or Option-click (Mac) the con-
trol. 

Editing Parameters Using a Computer 
Keyboard

Some controls have text boxes that display the 
current value of the parameter. You can edit the 
numeric value of a parameter with your com-
puter keyboard.

If multiple Plug-in windows are open, Tab and 
keyboard entry remain focused on the plug-in 
that is the target window.
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To change control values with a computer 
keyboard:

1  Click the text box corresponding to the con-
trol that you want to adjust.

2  Change the value by doing one of the follow-
ing:

• To increase a value, press the Up Arrow on 
your keyboard. To decrease a value, press 
the Down Arrow on your keyboard.

– or –

• Type the desired value.

3  Do one of the following:

• Press Enter on the numeric keyboard to in-
put the value and remain in keyboard edit-
ing mode.

– or –

• Press Enter on the alpha keyboard (Win-
dows) or Return (Mac) to enter the value 
and leave keyboard editing mode.

In fields that support values in kilohertz, 
typing “k” after a number value will multi-
ply the value by 1,000. For example, type 
“8k” to enter a value of 8,000.

To move forward through the different con-
trol fields, press the Tab key. To move back-
ward, press Shift+Tab.
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Editing Parameters Using a Scroll 
Wheel

Some controls have text boxes that display the 
current value of the parameter. You can edit the 
numeric value of a parameter using a scroll 
wheel.

To change control values using a scroll wheel:

1  Click the text box corresponding to the con-
trol that you want to adjust.

2  To increase a value, scroll up with the scroll 
wheel. To decrease a value, scroll down with the 
scroll wheel.

Toggling Switches

To toggle a switch:

� Click the switch.

Groups and Linked Plug-in Controls

(Pro Tools HD Only)

Plug-ins can follow Pro Tools Groups (Mix, Edit, 
or Mix/Edit) for linked control of multiple in-
serts. For more information, see the Pro Tools 
Reference Guide. 
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DigiRack Real-Time TDM and RTAS Plug-ins
EQ III
The EQ III Plug-in provides a high-quality 
7 Band, 2–4 Band, or 1 Band EQ for adjusting 
the frequency spectrum of audio material.

EQ III is available in the following formats:

• 7 Band: TDM, RTAS, AudioSuite

• 2–4 Band: TDM and RTAS only

• 1 Band: TDM, RTAS, AudioSuite

EQ III supports all Pro Tools session sample 
rates: 192 kHz, 176.4 kHz, 96 kHz, 88.2 kHz, 
48 kHz, and 44.1 kHz. EQ III operates as a mono 
or multi-mono plug-in only. Stereo and multi-
channel tracks are supported through multi-
mono operation. 

EQ III can be operated from the following con-
trol surfaces:

• Digidesign D-Control

• Digidesign ProControl

• Digidesign Control|24

• Digidesign 002

• Digidesign Command|8

• Mackie HUI-compatible controllers
EQ III has a Frequency Graph display that shows 
the response curve for the current EQ settings 
on a two-dimensional graph of frequency and 
gain. The frequency graph display also lets you 
modify frequency, gain and Q settings for indi-
vidual EQ bands by dragging their correspond-
ing points in the graph.

By choosing from the 7 Band, 2–4 Band, or 
1 Band versions of the EQ III plug-in, you can 
use only the number of EQ bands you need for 
each track, conserving DSP capacity on 
Pro Tools|HD systems.

EQ III Configurations

The EQ III Plug-in appears as three separate 
choices in the plug-in insert pop-up menu and 
in the AudioSuite menu: 

7 Band (“7-Band EQ 3”)

2–4 Band (“4-Band EQ 3”)

1 Band (“1-Band EQ 3”)
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7 Band EQ and 2–4 Band EQ 

The 7 Band EQ is available in TDM, RTAS, and 
AudioSuite formats. The 2–4 Band EQ is avail-
able in TDM and RTAS formats only.

The 7 Band EQ and the 2–4 Band EQ share the 
same window and identical controls, but with 
the 2–4 Band EQ, a limited number of the seven 
available bands can be active at the same time.

1 Band EQ

The 1 Band EQ is available in TDM, RTAS, and 
AudioSuite formats.

The 1 Band EQ has its own window, with six se-
lectable filter types.

7 Band EQ and 2–4 Band EQ window 

1 Band EQ window 
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EQ III Controls

Adjusting EQ III Controls

You can adjust the EQ III plug-in controls by 
any of the following methods:

Dragging Plug-in Controls

The rotary controls on the EQ III Plug-in can be 
adjusted by dragging over them horizontally or 
vertically. Dragging up or to the right incre-
ments the control. Dragging down or to the left 
decrements the control. 

Typing Control Values

You can enter control values directly by clicking 
in the corresponding text box, typing a value, 
and pressing Enter (Windows) or Return (Mac). 

Inverting Filter Gain

(Peak EQ Bands Only)

Gain values can be inverted on any Peak EQ 
band by Shift-clicking its control dot in the Fre-
quency Graph display, or its Gain knob in the 
plug-in window. This changes a gain boost to a 
cut (+9 to –9) or a gain cut to a boost (–9 to +9). 
Gain values cannot be inverted on Notch, High-
Pass, Low-Pass, or shelving bands.

Dragging a plug-in control

Typing a control value



Dragging in the Frequency Graph Display

You can adjust the following by dragging the 
control points directly in the Frequency Graph 
display:

Frequency Dragging a control point to the right 
increases the Frequency setting. Dragging a con-
trol point to the left decreases the Frequency set-
ting.

Gain Dragging a control point up increases the 
Gain setting. Dragging a control point down de-
creases the Gain setting.

Q Start-dragging (Windows) or Control-drag-
ging (Mac) a control point up increases the Q 
setting. Start-dragging (Windows) or Control-
dragging (Mac) a control point down decreases 
the Q setting.

Adjusting Controls with Fine Resolution

Controls and control points can be adjusted 
with fine resolution by holding the Control key 
(Windows) or the Command key (Mac) while 
adjusting the control.

Resetting Controls to Default Values

You can reset any on-screen control to its de-
fault value by Alt-clicking (Windows) or Option-
clicking (Mac OS) directly on the control or on 
its corresponding text box. 

Dragging a control point in the Frequency Graph display
Using Band-Pass Mode

You can temporarily set any EQ III control to 
Band-Pass monitoring mode. Band-Pass mode 
cuts monitoring frequencies above and below 
the Frequency setting, leaving a narrow band of 
mid-range frequencies. It is especially useful for 
adjusting limited bandwidth in order to solo 
and fine-tune each individual filter before re-
verting the control to notch filter or peaking fil-
ter type operations.

To switch an EQ III control to Band-Pass mode:

• Hold Start+Shift (Windows) or Control+Shift 
(Mac), and drag any rotary control or control 
point horizontally or vertically.

When monitoring in Band-Pass mode, the Fre-
quency and Q controls function differently.

Frequency Sets the frequency above and below 
which other frequencies are cut off, leaving a 
narrow band of mid-range frequencies. 

Q Sets the width of the narrow band of mid-
range frequencies centered around the Fre-
quency setting.

To switch an EQ III control out of Band-Pass mode:

• Release Start+Shift (Windows) or Con-
trol+Shift (Mac).

Band-Pass mode does not affect EQ III Gain 
controls.

EQ III interactive graph displaying Band-Pass mode
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Using a Control Surface

EQ III can be controlled from any supported 
control surface, including Digidesign’s 
D-Control, D-Command, ProControl, Con-
trol|24, Digi 002, or Command|8. Refer to the 
guide that came with the control surface for de-
tails.

I/O Controls

The following Input and Output controls are 
found on all EQ III configurations, except where 
noted otherwise.

Input Gain Control

The Input Gain control sets the input gain of the 
plug-in before EQ processing, letting you make 
up gain or prevent clipping at the plug-in input 
stage.

I/O controls and meters for 7 Band EQ and
2–4 Band EQ (top) and 1 Band EQ (bottom)

Input
Output Gain

Input and Output Meters

Gain

Input
Polarity

Clip
Indicators

Control

Control

Control
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Output Gain Control

(7 Band EQ and 2–4 Band EQ Only)

The Output Gain control sets the output gain af-
ter EQ processing, letting you make up gain or 
prevent clipping on the channel where the plug-
in is being used.

Input Polarity Control

The Input Polarity button inverts the polarity of 
the input signal, to help compensate for phase 
anomalies occurring in multi-microphone envi-
ronments, or because of mis-wired balanced 
connections.

Input and Output Meters

(7 Band EQ and 2–4 Band EQ Only)

The plasma-style Input and Output meters show 
peak signal levels before and after EQ process-
ing, and indicate them as follows:

Green Indicates nominal levels

Yellow Indicates pre-clipping levels, starting at 
–6 dB below full scale

Red Indicates full scale levels (clipping) 

The clip indicators at the far right of each meter 
indicate clipping at the input or output stage of 
the plug-in. Clip indicators can be cleared by 
clicking the indicator. 



EQ Band Controls

The individual EQ bands on each EQ III config-
uration have some combination of the follow-
ing controls, as noted below.

EQ Type Selector

On the 1 Band EQ, the EQ Type selector lets you 
choose any one of six available filter types: 
High-Pass, Notch, High-Shelf, Low-Shelf, Peak, 
and Low-Pass.

On the 7 Band EQ and the 2–4 Band EQ, the 
HPF, LPF, LF, and HF sections have EQ Type se-
lectors to toggle between the two available filter 
types in each section.

Band Enable Button

(7 Band EQ and 2–4 Band EQ Only)

The Band Enable button on each EQ band tog-
gles the corresponding band in and out of cir-
cuit. When a Band Enable button is highlighted, 
the band is in circuit. When a Band Enable but-
ton is dark gray, the band is bypassed and avail-
able for activation. On the 2–4 Band EQ, when a 
Band Enable button is light gray, the band is by-
passed and unavailable. 

EQ Band controls (7 Band EQ Low-Mid band shown)

Frequency
control

Band
Enable
button

Gain
control

Q
control

EQ type
selector
Band Gain Control

Each Peak and Shelf EQ band has a Gain control 
for boosting or cutting the corresponding fre-
quencies. Gain controls are not used on High-
Pass, Low-Pass, or Notch filters.

Frequency Control

Each EQ band has a Frequency control that sets 
the center frequency (Peak, Shelf and Notch 
EQs) or the cutoff frequency (High-Pass and 
Low-Pass filters) for that band. 

Q Control

Peak and Notch On Peak and Notch bands, the 
Q control changes the width of the EQ band. 
Higher Q values represent narrower band-
widths. Lower Q values represent wider band-
widths. 

Shelf On Shelf bands, the Q control changes the 
Q of the shelving filter. Higher Q values repre-
sent steeper shelving curves. Lower Q values rep-
resent broader shelving curves. 

Band Pass On High-Pass and Low-Pass bands, 
the Q control lets you select from any of the fol-
lowing Slope values: 6 dB, 12 dB, 18 dB, or 
24 dB per octave.
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Frequency Graph Display

(7 Band EQ and 2–4 Band EQ Only)

The Frequency Graph display in the 7 Band EQ and the 2–4 Band EQ shows a color-coded control dot 
that corresponds to the color of the Gain control for each band. The filter shape of each band is sim-
ilarly color-coded. The white frequency response curve shows the contribution of each of the enabled 
filters to the overall EQ curve.
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1 Band EQ

The Frequency Graph display in the 1 Band EQ shows a control dot that indicates the center fre-
quency (Peak, Shelf and Notch Filters) or the cutoff frequency (High-Pass and Low-Pass filters) for the 
currently selected filter type. 

Frequency Graph display for the 7 Band EQ

High-Pass
control dot

Low-Mid
control dot

High-Mid
control dot

Low-Pass
control dot

(gray) (brown) (green) (gray)

Low
control dot

(red)

Mid
control dot

(yellow)

High
control dot

(blue)

Frequency
response

curve
Frequency
response

curve

Control dot



7 Band EQ
The 7 Band EQ has the following available bands: High-Pass/Low Notch, Low-Pass/High Notch, Low 
Shelf/Low Peak, Low-Mid Peak, Mid Peak, High-Mid Peak, and High Shelf/High Peak.

All seven bands are available for simultaneous use. In the factory default setting, the High-Pass/Low 
Notch and Low-Pass/High Notch bands are out of circuit, the Low Shelf and High Shelf bands are se-
lected and in circuit, and the Low-Mid Peak, Mid Peak, High-Mid Peak bands are in circuit.

7 Band EQ and 2–4 Band EQ window

High-Pass/

Low-Pass/

Low
Shelf/Peak

Mid
Peak

High
Shelf/Peak

Low-Mid
Peak

High-Mid
Peak

Input/Output Level meters

Frequency Graph
Display

Input/Output Level
and

Polarity controls

Low Notch

High Notch
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High-Pass/Low Notch

The High-Pass/Notch band is switchable be-
tween High-Pass Filter and Notch EQ functions. 
By default, this band is set to High-Pass Filter. 

High-Pass Filter Attenuates all frequencies below 
the Frequency setting at the selected slope while 
letting all frequencies above pass through.

Low-Notch EQ Attenuates a narrow band of fre-
quencies centered around the Frequency set-
ting. The width of the attenuated band is deter-
mined by the Q setting. 

The High Pass and Low Notch controls and their 
corresponding graph elements are displayed on-
screen in gray. 

High-Pass filter (left) and Low Notch EQ (right)

High-Pass Filter and Low Notch EQ control values

Control Value

Frequency Range 20 Hz to 8 kHz

Frequency Default 20 Hz

HPF Slope Values 6, 12, 18, or 24 dB/oct

Low Notch Q Range 0.1 to 10.0

Low Notch Q Default 1.0

High-Pass Filter
button

Frequency
control

Slope
control

Frequency
control

Q
control

Band
Enable
button

Low Notch EQ
button

Band
Enable
button
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Low-Pass/High Notch

The Low-Pass/Notch band is switchable between 
Low-Pass Filter and Notch EQ functions. By de-
fault, this band is set to Low-Pass Filter.

Low-Pass Filter Attenuates all frequencies above 
the Frequency setting at the selected slope while 
letting all frequencies below pass through.

High-Notch EQ Attenuates a narrow band of fre-
quencies centered around the Frequency set-
ting. The width of the attenuated band is deter-
mined by the Q setting. 

The Low Pass and High Notch controls and their 
corresponding graph elements are displayed on-
screen in gray. 

Low-Pass filter (left) and High Notch EQ (right)

Low-Pass Filter and High Notch EQ control values

Control Value

Frequency Range 120 Hz to 20 kHz

Frequency Default 20 kHz

LPF Slope Values 6, 12, 18, or 24 dB/oct

High Notch Q Range 0.1 to 10.0

High Notch Q Default 1.0

Low-Pass Filter
button

Frequency
control

Slope
control

Frequency
control

Q
control

Band
Enable
button

High Notch EQ
button

Band
Enable
button



Low Shelf/Low Peak

The Low Shelf/Peak band is switchable between 
Low Shelf EQ and Low Peak EQ functions. By de-
fault, this band is set to Low Shelf. 

Low-Shelf EQ Boosts or cuts frequencies at and 
below the Frequency setting. The amount of 
boost or cut is determined by the Gain setting. 
The Q setting determines the shape of the shelv-
ing curve.

Low Peak EQ Boosts or cuts a band of frequen-
cies centered around the Frequency setting. The 
width of the affected band is determined by the 
Q setting.

Low Shelf EQ (left) and Low Peak EQ (right)

Low Shelf EQ
button

Frequency
control

Band
Enable
button

Gain
control

Q
control

Low Peak EQ
button

Frequency
control

Band
Enable
button

Gain
control

Q
control
The Low Shelf and Low Peak Gain controls and 
their corresponding graph elements are dis-
played on-screen in red. 

Low Shelf EQ and Low Peak EQ control values

Control Value

Frequency Range 20 Hz to 500 Hz

Frequency Default 100 Hz

Low Shelf Q Range 0.1 to 2.0

Low Peak Q Range 0.1 to 10.0

Q Default 1.0

Low Shelf Gain Range –12 dB to +12 dB

Low Peak Gain Range –18 dB to +18 dB
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Low-Mid Peak

The Low-Mid Peak band boosts or cuts frequen-
cies centered around the Frequency setting. The 
width of the band is determined by the Q set-
ting. 

The Low-Mid Gain control and its correspond-
ing graph elements are displayed on-screen in 
brown.

Low-Mid Peak EQ

Low-Mid Peak EQ control values

Control Value

Frequency Range 40 Hz to 1 kHz

Frequency Default 200 Hz

Low-Mid Peak Q Range 0.1 to 10.0

Low-Mid Peak Q Default 1.0

Low-Mid Peak Gain Range –18 dB to +18 dB

Frequency
control

Band
Enable
button

Gain
control

Q
control
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Mid Peak

The Mid Peak band boosts or cuts frequencies 
centered around the Frequency setting. The 
width of the band is determined by the Q set-
ting.

The Mid Gain control and its corresponding 
graph elements are displayed on-screen in yel-
low.

Mid Peak EQ

Mid Peak EQ control values

Control Value

Frequency Range 125 Hz to 8 kHz

Frequency Default 1 kHz

Mid Peak Q Range 0.1 to 10.0

Mid Peak Q Default 1.0

Mid Peak Gain Range –18 dB to +18 dB

Frequency
control

Band
Enable
button

Gain
control

Q
control



High-Mid Peak

The High-Mid Peak band boosts or cuts frequen-
cies centered around the Frequency setting. The 
width of the band is determined by the Q set-
ting.

The High-Mid Gain control and its correspond-
ing graph elements are displayed on-screen in 
green.

High Shelf/High Peak

The High Shelf/Peak band is switchable between 
High Shelf EQ and High Peak EQ functions. By 
default, this band is set to High Shelf.

High-Shelf EQ Boosts or cuts frequencies at and 
above the Frequency setting. The amount of 
boost or cut is determined by the Gain setting. 
The Q setting determines the shape of the shelv-
ing curve.

High-Mid Peak EQ

High-Mid Peak EQ control values

Control Value

Frequency Range 200 Hz to 18 kHz

Frequency Default 2 kHz

Mid Peak Q Range 0.1 to 10.0

Mid Peak Q Default 1.0

Mid Peak Gain Range –18 dB to +18 dB

Frequency
control

Band
Enable
button

Gain
control

Q
control
High Peak EQ Boosts or cuts a band of frequen-
cies centered around the Frequency setting. The 
width of the affected band is determined by the 
Q setting.

The High Shelf and High Peak Gain controls and 
their corresponding graph elements are dis-
played on-screen in blue. 

High Shelf EQ (left) and High Peak EQ (right)

High Shelf EQ and High Peak EQ control values

Control Value

Frequency Range 1.8 kHz to 20 kHz

Frequency Default 6 kHz

High Shelf Q Range 0.1 to 2.0

High Peak Q Range 0.1 to 10.0

Q Default 1.0

High Shelf Gain Range –12 dB to +12 dB

High Peak Gain Range –18 dB to +18 dB

High Shelf EQ
button

Frequency
control

Band
Enable
button

Gain
control

Q
control

High Peak EQ
button

Frequency
control

Band
Enable
button

Gain
control

Q
control
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2–4 Band EQ

The 2–4 Band EQ uses the same plug-in window 
as the 7 Band EQ, but on the 2–4 Band EQ, but a 
limited number of the seven available bands can 
be active at the same time.

In the factory default setting, the High-Pass/Low 
Notch, Low-Pass/High Notch and Mid Peak 
bands are out of circuit, the Low Shelf and High 
Shelf bands are selected and in circuit, and the 
Low-Mid Peak and High-Mid Peak bands are in 
circuit.

Changing from 2–4 Band to 7 Band

After switching from a 2–4 band EQ to a 7 Band 
EQ, or importing settings from a 2–4 Band EQ, 
all control settings from the 2–4 Band EQ are 
preserved, and the bands in the 7 Band EQ in-
herit their enabled or bypassed state from the 
2–4 Band plug-in. 

Additional EQ bands can then be enabled to add 
them to the settings inherited from the 
2–4 Band plug-in.

Filter Usage with 2–4 Band EQs

With a 2–4 Band EQ, a maximum of four filters 
may be active simultaneously, with each of the 
five Peak bands (Low Shelf/Peak, Low-Mid Peak, 
Mid-Peak, High-Mid Peak and High Shelf/Peak) 
counting as one filter. Each of the Band-pass and 
Notch filters (High-Pass, Low Notch, Low-Pass 
and High-Notch) counts as two filters. 

For Pro Tools HD, using a 2–4 Band EQ in-
stead of a 7 Band EQ saves DSP resources.
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When any combination of these filter types uses 
the four-filter maximum on the 2–4 Band EQ, 
the remaining bands become unavailable. This 
is indicated by the Band Enable buttons turning 
light gray. When filters become available again, 
the Band Enable button on inactive bands turns 
dark gray. 

Switching Between the 2–4 Band EQ 
and 7 Band EQ

When you switch an existing EQ III plug-in be-
tween the 2–4 Band and 7 Band versions, or 
when you import settings between versions, the 
change is subject to the following conditions:

Changing from 7 Band to 2–4 Band

After switching from a 7 band EQ to a 2–4 Band 
EQ, or importing settings from a 7 Band EQ, all 
control settings from the 7 Band EQ are pre-
served in the 2–4 Band EQ, but all bands are 
placed in a bypassed state.

Bands can then be enabled manually, up to the 
2–4 Band EQ four-filter limit.



1 Band EQ

The 1 Band EQ may be set to any one of six EQ 
types: High-Pass, Notch, High-Shelf, Low-Shelf, 
Peak, and Low-Pass, by clicking the correspond-
ing icon in the EQ Type selector.

Band Controls

The individual EQ types have some combina-
tion of the following controls, as noted below.

1 Band EQ window

1 Band EQ control values

Control Value

Frequency Range (All) 20 Hz to 20 kHz

Frequency Default (All) 1 kHz

Q Range (Low/High Shelf) 0.1 to 2.0

Q Range (Peak/Notch) 0.1 to 10.0

Q Default (All) 1.0

Gain Range (Low/High Shelf) –12 dB to +12 dB

High Peak Gain Range –18 dB to +18 dB

Frequency Graph
display

EQ Type
selector

Gain, Freq and

Input Level and
Polarity controls

Q controls
EQ Types

High-Pass Filter

The High-Pass filter attenuates all frequencies 
below the Frequency setting at the selected rate 
(6 dB, 12 dB, 18 dB, or 24 dB per octave) while 
letting all frequencies above pass through. No 
gain control is available for this filter type.

Notch Filter

The Notch Filter attenuates a narrow band of 
frequencies centered around the Frequency set-
ting. No gain control is available for this EQ 
type. The width of the attenuated band is deter-
mined by the Q setting.

1 Band EQ set to High-Pass Filter

1 Band EQ set to Notch Filter
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High-Shelf EQ

The High-Shelf EQ boosts or cuts frequencies at 
and above the Frequency setting. The amount of 
boost or cut is determined by the Gain setting. 
The Q setting determines the shape of the shelv-
ing curve.

Low-Shelf EQ

The Low-Shelf EQ boosts or cuts frequencies at 
and below the Frequency setting. The amount of 
boost or cut is determined by the Gain setting. 
The Q setting determines the shape of the shelv-
ing curve.

1 Band EQ set to High-Shelf EQ

1 Band EQ set to Low-Shelf EQ
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Peak EQ

The Peak EQ boosts or cuts a band of frequencies 
centered around the Frequency setting. The 
width of the affected band is determined by the 
Q setting.

Low-Pass Filter

The Low-Pass filter attenuates all frequencies 
above the cutoff frequency setting at the se-
lected rate (6 dB, 12 dB, 18 dB, or 24 dB per oc-
tave) while letting all frequencies below pass 
through. No gain control is available for this fil-
ter type.

1 Band EQ set to Peak EQ

1 Band EQ set to Low-Pass Filter



Automating EQ III Controls

All EQ III plug-in controls can be automated in 
Pro Tools. 

To automate a control directly from the plug-in 
window:

� Control-Alt-Start-click (Windows) or Com-
mand-Option-Control-click (Mac) the control, 
and choose Enable Automation.

To automate multiple controls:

� Control-Alt-Start-click (Windows) or Com-
mand-Option-Control-click (Mac) the control, 
choose Open Plug-in Automation Dialog, and 
choose the controls you want to automate.

The automation-enabled status of EQ III plug-in 
controls is indicated by the colored LED beneath 
each on-screen knob and colored outlines 
around each on-screen button.

Enabling automation for a control

Automation-enabled controls

Automation-enabled knobs

Automation-enabled buttons
Even if an EQ III band is bypassed, for example, 
when the filter capacity of a 2–4 Band EQ is sur-
passed, its controls are still available for automa-
tion. This lets you continue to update settings in 
a session in preparation for the next time the by-
passed band is enabled.

EQ II

For complete instructions on automating 
plug-ins in Pro Tools, see the Pro Tools Ref-
erence Guide.

For information, see the Digidesign Legacy 
Plug-ins Guide.
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Click
The Click plug-in creates an audio click during 
session playback that you can use as a tempo ref-
erence when performing and recording. The 
Click plug-in receives its tempo and meter data 
from the Pro Tools application, enabling it to 
follow any changes in tempo and meter in a ses-
sion. The Click plug-in is a mono-only plug-in. 
Several click sound presets are included.

Click Controls

MIDI In LED Illuminates each time the Click 
plug-in receives a click message from the 
Pro Tools application, indicating the click 
tempo.

Accented Controls the output level of the accent 
beat (beat 1 of each bar) of the audio click.

Unaccented Controls the output level of the un-
accented beats of the audio click.

Creating a Click Track

To use the Click plug-in:

1  Choose Options > Click to enable the Click 
option (or enable the Click button in the Trans-
port window).

Click plug-in
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2  Do one of the following:

• Choose Track > Create Click Track. 
Pro Tools creates a new Instrument track 
named “Click” with the Click plug-in al-
ready inserted. In the Edit window, the 
click track’s Track Height is set to Mini.

– or –

• Create new a mono Auxiliary Input track 
and insert the Click plug-in.

3  Select a click sound preset.

4  Choose Setup > Click and set the Click and 
Countoff options as desired. 

5  Begin playback. A click is generated according 
to the tempo and meter of the current session 
and the settings in the Click/Countoff Options 
dialog.

The Note, Velocity, Duration, and Output 
options in this dialog are for use with MIDI 
instrument-based clicks and do not affect 
the Click plug-in.

Click Options dialog

Refer to the Pro Tools Reference Guide for 
more information on configuring Click op-
tions.



Automatically Create Click Track In 
New Sessions

To have Pro Tools automatically create a click 
track when you create a new session, enable the 
Automatically Create Click Track In New Ses-
sions option in the MIDI Preferences page 
(Setup > Preferences).

Dither
The Dither plug-in minimizes quantization arti-
facts when reducing the bit depth of an audio 
signal to 16-, 18-, or 20-bit resolution.

Selecting the Automatically Create Click Track In New 
Sessions option in the MIDI Preferences page

For more advanced dithering, use the Digi-
Rack POW-r Dither plug-in. See “POW-r 
Dither” on page 60.

 Dither plug-in
Whenever you are mixing down or bouncing to 
disk and your destination bit depth is lower 
than 24-bit, insert a dither plug-in on a Master 
Fader that controls the output mix. 

Using a dither plug-in on a Master Fader is pref-
erable to an Auxiliary Input because Master 
Fader inserts are post-fader. As a post-fader in-
sert, the dither plug-in can process changes in 
Master Fader level. 

The Dither plug-in has user-selectable bit resolu-
tion and a noise shaping on/off option.

Dither Controls

Bit Resolution

Use this pop-up menu to choose one of three 
possible resolutions for the Dither processing. 
Set this control to the maximum bit resolution 
of your destination.

16-bit Recommended for output to digital de-
vices with a maximum resolution of 16 bits, 
such as DAT and CD recorders.

18-bit Recommended for output to analog de-
vices if you are using an 18-bit audio interface, 
such as the 888 I/O or 882 I/O audio interface; 
this is the maximum resolution available from 
the 18-bit digital-to-analog convertors of these 
devices.

For more information on using Dither, see 
the Pro Tools Reference Guide.

If you are mixing down to an analog desti-
nation with any 24-bit capable interface, 
you do not need to use Dither. This allows 
maximum output fidelity from the 24-bit 
digital-to-analog convertors of the interface. 
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20-bit Recommended for output to digital de-
vices that support a full 20-bit recording data 
path, such the Sony PCM-9000 optical master-
ing recorder, or the Alesis ADAT XT 20. Use this 
setting for output to analog devices if you are us-
ing a 20-bit audio interface, such as the 
882|20 I/O audio interface. The 20-bit setting 
can also be used for output to digital effects de-
vices that support 20-bit input and output, since 
it provides for a lower noise floor and greater dy-
namic range when mixing 20-bit signals directly 
into the TDM environment.

Noise Shaping

Noise shaping can further improve audio perfor-
mance and reduce perceived noise inherent in 
dithered audio. Noise shaping uses filtering to 
shift noise away from frequencies in the middle 
of the audio spectrum (around 4 kHz), where 
the human ear is most sensitive.

The Noise Shaping button engages or disengages 
Noise shaping. Noise shaping is on when the 
button is highlighted in blue. 

The DigiRack Dither plug-in only provides 
eight channels of uncorrelated dithering 
noise. If DigiRack Dither is used on more 
than eight tracks, the dithering noise begins 
to repeat and dither performance is im-
paired. For example, if two Quad DigiRack 
Dithers are used, both Quad instances of 
Dither will have all of their dither noise un-
correlated. However, any additional in-
stances of the Dither plug-in will begin to 
repeat the dithering noise.
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POW-r Dither
(Pro Tools HD and Pro Tools LE Only)

The POW-r Dither plug-in is an advanced type 
of dither that provides optimized bit depth re-
duction. It is designed for final-stage critical 
mixdown and mastering tasks where the highest 
possible fidelity is desired when reducing bit 
depth. For more information on dithering, see 
“Dither” on page 59.

POW-r Dither Controls

Bit Resolution

Use this pop-up menu to choose either 16- or 
20-bit resolutions for POW-r Dither processing. 
Set this control to the maximum bit resolution 
of your destination.

16-bit Recommended for output to digital de-
vices with a maximum resolution of 16 bits, 
such as DAT and CD recorders.

20-bit Recommended for output to devices that 
support a full 20-bit recording data path.

POW-r Dither plug-in

The POW-r Dither plug-in does not run on 
third party applications that use DAE.

The multichannel TDM version of the 
POW-r Dither plug-in is not supported at 
192 kHz. Use the multi-mono TDM or 
RTAS version instead.



Noise Shaping

Noise shaping can further improve audio perfor-
mance and reduce perceived noise inherent in 
dithered audio. Noise shaping uses filtering to 
shift noise away from frequencies in the middle 
of the audio spectrum (around 4 kHz), where 
the human ear is most sensitive.

The POW-r Dither plug-in provides three types 
of noise shaping, each with its own characteris-
tics. Try each noise shaping type and choose the 
one that adds the least amount of coloration to 
the audio being processed. 

Type 1 Has the flattest frequency spectrum in 
the audible range of frequencies, modulating 
and accumulating the dither noise just below 
the Nyquist frequency. Recommended for less 
stereophonically complex material such as solo 
instrument recordings.

Type 2 Has a psychoacoustically optimized low 
order noise shaping curve. Recommended for 
material of greater stereophonic complexity.

Type 3 Has a psychoacoustically optimized high 
order noise shaping curve. Recommended for 
full-spectrum, wide-stereo field material.

The POW-r Dither plug-in is not appropri-
ate for truncation stages that are likely to be 
further processed. It is recommended that 
POW-r Dither be used only as the last insert 
in the signal chain (especially when using 
Type 1 Noise Shaping).

For more information on using Dither, see 
the Pro Tools Reference Guide.
D-Verb
D-Verb is a studio-quality reverb provided in 
TDM, RTAS, and AudioSuite formats. 

D-Verb Controls

Output Meter

The Output Meter indicates the output level of 
the processed signal. With the stereo version of 
D-verb, it represents the summed stereo output. 
It is important to note that this meter indicates 
the output level of the signal—not the input 
level. If this meter clips, it is possible that the 
signal clipped on input before it reached 
D-Verb. Monitor your send or insert signal levels 
closely to help prevent this from happening.

The TDM version of the D-Verb plug-in is 
not supported at 192 kHz; use the RTAS 
version instead.

D-Verb plug-in
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Clip Indicator

The Clip Indicator shows if clipping has oc-
curred. It is a clip-hold indicator. If clipping oc-
curs at any time during audio playback, the clip 
lights remain on. To clear the clip indicator, 
click it. With longer reverb times there is a 
greater likelihood of clipping occurring as the 
feedback element of the reverb builds up and ap-
proaches a high output level. See also “Clip In-
dicators” on page 22. 

Input Level

The Input Level slider adjusts the input volume 
of the reverb to prevent the possibility of clip-
ping and/or increase the level of the processed 
signal. 

Mix

The Mix slider adjusts the balance between the 
dry signal and the effected signal, giving you 
control over the depth of the effect. This control 
is adjustable from 100% to 0%. 

Algorithm

This control selects one of seven reverb algo-
rithms: Hall, Church, Plate, Room 1, Room 2, 
Ambience, or Nonlinear. Selecting an algorithm 
changes the preset provided for it. Switching the 
Size setting changes characteristics of the algo-
rithm that are not altered by adjusting the decay 
time and other user-adjustable controls. Each of 
the seven algorithms has a distinctly different 
character:

Hall A good general purpose concert hall with a 
natural character. It is useful over a large range 
of size and decay times and with a wide range of 
program material. Setting Decay to its maxi-
mum value will produce infinite reverberation.
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Church A dense, diffuse space simulating a 
church or cathedral with a long decay time, 
high diffusion, and some pre-delay.

Plate  Simulates the acoustic character of a 
metal plate-based reverb. This type of reverb 
typically has high initial diffusion and a rela-
tively bright sound, making it particularly good 
for certain percussive signals and vocal process-
ing. Plate reverb has the general effect of thick-
ening the initial sound itself.

Room 1 A medium-sized, natural, rich-sounding 
room that can be effectively varied in size be-
tween very small and large, with good results.

Room 2 A smaller, brighter reverberant charac-
teristic than Room 1, with a useful adjustment 
range that extends to “very small.”

Ambient A transparent response that is useful for 
adding a sense of space without adding a lot of 
depth or density. Extreme settings can create in-
teresting results.

Nonlinear Produces a reverberation with a natu-
ral buildup and an abrupt cutoff similar to a 
gate. This unnatural decay characteristic is par-
ticularly useful on percussion, since it can add 
an aggressive characteristic to sounds with 
strong attacks.

Size

The Size control, in conjunction with the Algo-
rithm control, adjusts the overall size of the re-
verberant space. There are three sizes: Small, Me-
dium, and Large. The character of the 
reverberation changes with each of these set-
tings (as does the relative value of the Decay set-
ting). The Size buttons can be used to vary the 
range of a reverb from large to small. Generally, 
you should select an algorithm first, and then 
choose the size that approximates the size of the 
acoustic space that you are trying to create.



Diffusion

Diffusion sets the degree to which initial echo 
density increases over time. High settings result 
in high initial build-up of echo density. Low set-
tings cause low initial buildup. This control in-
teracts with the Size and Decay controls to affect 
the overall reverb density. High settings of diffu-
sion can be used to enhance percussion. Use low 
or moderate settings for clearer and more natu-
ral-sounding vocals and mixes.

Decay

Decay controls the rate at which the reverb de-
cays after the original direct signal stops. The 
value of the Decay setting is affected by the Size 
and Algorithm controls. This control can be set 
to infinity on most algorithms for infinite re-
verb times.

Pre-Delay

Determines the amount of time that elapses be-
tween the original audio event and the onset of 
reverberation. Under natural conditions, the 
amount of Pre-Delay depends on the size and 
construction of the acoustic space, and the rela-
tive position of the sound source and the lis-
tener. Pre-Delay attempts to duplicate this phe-
nomenon and is used to create a sense of 
distance and volume within an acoustic space. 
Long Pre-Delay settings place the reverberant 
field behind rather than on top of the original 
audio signal.

Hi Frequency Cut

Hi Frequency Cut controls the decay character-
istic of the high frequency components of the 
reverb. It acts in conjunction with the Low-Pass 
Filter control to create the overall high fre-
quency contour of the reverb. When set rela-
tively low, high frequencies decay more quickly 
than low frequencies, simulating the effect of air 
absorption in a hall. The maximum value of this 
control is Off (which effectively means bypass).

Low-Pass Filter

Low-Pass Filter controls the overall high fre-
quency content of the reverb by setting the fre-
quency above which a 6 dB per octave filter at-
tenuates the processed signal. The maximum 
value of this control is Off (which effectively 
means bypass).

Dynamics III
Dynamics III provides three modules: 

• Compressor/Limiter

• Expander/Gate

• De-Esser

All Dynamics III modules are available in TDM, 
RTAS, and AudioSuite formats. 

Dynamics III supports 44.1 kHz, 48 kHz, 
88.2 kHz, 96 kHz, 176.4 kHz and 192 kHz sam-
ple rates. Compressor/Limiter and Ex-
pander/Gate modules work with mono, stereo, 
and greater-than-stereo multichannel formats 
up to 7.1. The De-Esser module works with 
mono and stereo formats only.

In addition to standard controls in each mod-
ule, Dynamics III also provides a graph to track 
the gain transfer curve in the Compressor/Lim-
iter and Expander/Gate plug-ins, and a fre-
quency graph to display which frequencies trig-
ger the De-Esser and which frequencies will be 
gain reduced.
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Adjusting Dynamics III Controls

You can adjust Dynamics III plug-in controls by 
clicking and dragging the control’s slider or 
knob, or by typing a value into the control’s text 
box. 

Editing Parameters Using a Mouse

You can adjust rotary controls by clicking and 
dragging horizontally or vertically. Parameter 
values increase as you drag upward or to the 
right, and decrease as you drag downward or to 
the left.

Keyboard Shortcuts

� For finer adjustments, Control-drag (Win-
dows) or Command-drag (Mac) the control.

� To return a control to its default value, Alt-
click (Windows) or Option-click (Mac) the con-
trol. 

Typing Control Values

You can enter control values directly by clicking 
in the corresponding text box, typing a value, 
and pressing Enter (Windows) or Return (Mac). 

Dragging a plug-in control

Typing a control value
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Editing Parameters Using a Computer 
Keyboard

Some controls have text boxes that display the 
current value of the parameter. You can edit the 
numeric value of a parameter with your com-
puter keyboard.

If multiple Plug-in windows are open, Tab and 
keyboard entry remain focused on the plug-in 
that is the target window.

To change control values with a computer 
keyboard:

1  Click on the text box corresponding to the 
control that you want to adjust.

2  Change the value by doing one of the follow-
ing:

• To increase a value, press the Up Arrow on 
your keyboard. To decrease a value, press 
the Down Arrow on your keyboard.

– or –

• Type the desired value.

3  Do one of the following:

• Press Enter on the numeric keyboard to in-
put the value and remain in keyboard edit-
ing mode.

– or –

• Press Enter on the alpha keyboard (Win-
dows) or Return (Mac) to enter the value 
and leave keyboard editing mode.

In fields that support values in kilohertz, 
typing “k” after a number value will multi-
ply the value by 1,000. For example, type 
“8k” to enter a value of 8,000.

To move forward through the different con-
trol fields, press the Tab key. To move back-
ward, press Shift+Tab.



Enabling Buttons

To enable a button, click it.

Using a Control Surface

Dynamics III can be controlled from any sup-
ported control surface, interface, and worksur-
face. Refer to the appropriate controller product 
guide for more information.

Shared Compressor/Limiter and 
Expander/Gate Features

The following parts of the user interface are 
shared between the Compressor/Limiter and Ex-
pander/Gate Dynamics III plug-ins.

Levels Section

This indicator let you track input, output, and 
gain reduction levels, as well as work with phase 
invert and the threshold setting.

See “De-Esser Levels Section” on page 74 
for more information on De-Esser III In-
put/Output Level controls.

I/O Meter display (stereo instance shown)

Gain
Reduction 
meter

Threshold
arrow

Phase 
Invert

Input
meter

Output 
meter

Peak hold
indicators

Peak hold 
indicators
Input and Output Meters

The Input and Output meters show peak signal 
levels before and after dynamics processing:

Green Indicates nominal levels.

Yellow Indicates pre-clipping levels, starting at 
–6 dB below full scale.

Red Indicates full scale levels (clipping).

The clip indicators at the top of the Output 
meters indicate clipping at the input or output 
stage of the plug-in. Clip indicators can be 
cleared by clicking the indicator.

Toggling Multichannel Input and Output Meters

With multichannel track types LCRS and 
higher, both Input Level and Output Level 
meters cannot be shown at the same time. Click 
either the Input or Output Meter button to dis-
play the appropriate level meter. The Input/Out-
put level meters display is toggled to Output by 
default.

The Input and Output meters display differ-
ently depending on the type of track (mono, 
stereo, or multichannel) on which the plug-
in has been inserted.

When Side-Chain Listen is enabled, the 
Output meter only displays the levels of the 
side-chain signal. See “Side-Chain Listen” 
on page 77.

Input and Output meter buttons

Input and
Output Meter

buttons
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Gain Reduction Meter

The Gain Reduction meter indicates the amount 
the input signal is attenuated (in dB) and shows 
different colors during dynamics processing:

Light Orange Indicates that gain reduction is 
within the “knee” and has not reached the full 
ratio of compression.

Dark Orange Indicates that gain reduction is be-
ing applied at the full ratio (for example, 2:1).

Threshold Arrow

The orange Threshold arrow next to the Input 
meter indicates the current threshold, and can 
be dragged up or down to adjust the threshold. 
When a multichannel instance of the plug-in 
has been configured to show only the Output 
meter, the Threshold arrow is not displayed.

Phase Invert

The Phase Invert button inverts the phase (po-
larity) of the input signal, to help compensate 
for phase anomalies that can occur either in 
multi-microphone environments or because of 
mis-wired balanced connections.
DigiRack Plug-ins Guide
LFE Enable

(Pro Tools HD Systems Only)

The LFE Enable button (located in the Options 
section) is on by default, and enables plug-in 
processing of the LFE (low frequency effects) 
channel on a multichannel track formatted for 
5.1, 6.1, or 7.1 surround formats. 

To disable LFE processing, deselect this button.

Dynamics Graph Display

The Dynamics Graph display—used with the 
Compressor/Limiter and Expander/Gate plug-
ins—shows a curve that represents the level of 
the input signal (on the x–axis) and the level of 
the output signal (on the y–axis). The orange 
vertical line represents the threshold. 

LFE Enable button (Compressor/Limiter III shown)

The LFE Enable button is not available if 
the plug-in is not inserted on an applicable 
track.



Use this graph as a visual guideline to see how 
much dynamics processing you are applying.

The Compressor/Limiter and Expander/Gate 
plug-ins also feature an animated, multi-color 
cursor in their gain transfer curve displays.

The gain transfer curve of the Compressor/Lim-
iter and Expander/Gate plug-ins shows a mov-
ing ball cursor that shows the amount of input 
gain (x-axis) and gain reduction (y-axis) being 
applied to the incoming signal. 

Dynamics graph display

Gain transfer curve and cursor showing amount of 
compression

Input signal 
level (x-axis)

Output signal 
level (y-axis)

Threshold
To indicate overshoots (when an incoming sig-
nal peak is too fast for the current compression 
setting) the cursor temporarily leaves the gain 
transfer curve. 

The cursor changes color to indicate the amount 
of compression applied, as follows:

Side-Chain Section

For information on using the Side-Chain section 
of the Compressor/Limiter or Expander/Gate, 
see “Using the Side-Chain Input in Dynamics 
III” on page 76.

Dynamics III Plug-in Compression Amount

Cursor Color Compression Amount

white no compression

light orange below full ratio

dark orange full ratio amount

See “De-Esser Frequency Graph Display” on 
page 75 for information on using the De-
Esser’s graph display.
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Compressor/Limiter III

The Compressor/Limiter plug-in applies either 
compression or limiting to audio material, de-
pending on the ratio of compression used.

About Compression

Compression reduces the dynamic range of sig-
nals that exceed a chosen threshold by a specific 
amount. The Threshold control sets the level 
that the signal must exceed to trigger compres-
sion. The Attack control sets how quickly the 
compressor responds to the “front” of an audio 
signal once it crosses the selected threshold. The 
Release control sets the amount of time that it 
takes for the compressor’s gain to return to its 
original level after the input signal drops below 
the selected threshold.

To use compression most effectively, the attack 
time should be set so that signals exceed the 
threshold level long enough to cause an increase 
in the average level. This helps ensure that gain 
reduction does not decrease the overall volume 
too drastically, or eliminate desired attack tran-
sients in the program material.

Of course, compression has many creative uses 
that break these rules.

Compressor/Limiter III
DigiRack Plug-ins Guide
About Limiting

Limiting prevents signal peaks from ever ex-
ceeding a chosen threshold, and is generally 
used to prevent short-term peaks from reaching 
their full amplitude. Used judiciously, limiting 
produces higher average levels, while avoiding 
overload (clipping or distortion), by limiting 
only some short-term transients in the source 
audio. To prevent the ear from hearing the gain 
changes, extremely short attack and release 
times are used. 

Limiting is used to remove only occasional 
peaks because gain reduction on successive 
peaks would be noticeable. If audio material 
contains many peaks, the threshold should be 
raised and the gain manually reduced so that 
only occasional, extreme peaks are limited.

Limiting generally begins with the ratio set at 
10:1 and higher. Large ratios effectively limit the 
dynamic range of the signal to a specific value 
by setting an absolute ceiling for the dynamic 
range.



Compressor/Limiter III Controls

This section describes controls for the Compres-
sor/Limiter plug-in.

Input/Output Level Meters

The Input and Output meters show peak signal 
levels before and after dynamics processing. See 
“Levels Section” on page 65 for more informa-
tion.

Unlike scales on analog compressors, metering 
scales on a digital device reflect a 0 dB value that 
indicates full scale (fs)—the full-code signal 
level. There is no headroom above 0 dB.

Compressor/Limiter Graph Display

The Dynamics Graph display lets you visually 
see how much expansion or gating you are ap-
plying to your audio material. See “Dynamics 
Graph Display” on page 66.

Threshold

The Threshold control sets the level that an in-
put signal must exceed to trigger compression or 
limiting. Signals that exceed this level will be 
compressed. Signals that are below it will be un-
affected. 

This control has an approximate range of –60 dB 
to 0 dB, with a setting of 0 dB equivalent to no 
compression or limiting. The default value for 
the Threshold control is –24 dB.
An orange arrow on the Input meter indicates 
the current threshold, and can also be dragged 
up or down to adjust the threshold setting. 

The Dynamics Graph display also shows the 
threshold as an orange vertical line.

This control ranges from –60 dB (lowest gain) to 
0 dB (highest gain). 

Ratio

The Ratio control sets the compression ratio, or 
the amount of compression applied as the input 
signal exceeds the threshold. For example, a 2:1 
compression ratio means that a 2 dB increase of 
level above the threshold produces a 1 db in-
crease in output.

This control ranges from 1:1 (no compression) 
to 100:1 (hard limiting).

Threshold arrow on input meter

Threshold indicator on Dynamics Graph display

Threshold
arrow

Threshold
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Attack

The Attack control sets the attack time, or the 
rate at which gain is reduced after the input sig-
nal crosses the threshold.

The smaller the value, the faster the attack. The 
faster the attack, the more rapidly the Compres-
sor/Limiter applies attenuation to the signal. If 
you use fast attack times, you should generally 
use a proportionally longer release time, partic-
ularly with material that contains many peaks 
in close proximity.

This control ranges from 10 μs (fastest attack 
time) to 300 ms (slowest attack time).

Release

The Release control sets the length of time it 
takes for the Compressor/Limiter to be fully de-
activated after the input signal drops below the 
threshold. 

Release times should be set long enough that if 
signal levels repeatedly rise above the threshold, 
the gain reduction “recovers” smoothly. If the 
release time is too short, the gain can rapidly 
fluctuate as the compressor repeatedly tries to 
recover from the gain reduction. If the release 
time is too long, a loud section of the audio ma-
terial could cause gain reduction that continues 
through soft sections of program material with-
out recovering. 

This control ranges from 5 ms (fastest release 
time) to 4 seconds (slowest release time).
DigiRack Plug-ins Guide
Knee

The Knee control sets the rate at which the com-
pressor reaches full compression once the 
threshold has been exceeded.

As you increase this control, it goes from apply-
ing “hard-knee” compression to “soft-knee” 
compression:

• With hard-knee compression, compression 
begins when the input signal exceeds the 
threshold. This can sound abrupt and is ideal 
for limiting.

• With soft-knee compression, gentle compres-
sion begins and increases gradually as the in-
put signal approaches the threshold, and 
reaches full compression after exceeding the 
threshold. This creates smoother compres-
sion.

For example, a Knee setting of 10 dB would be 
the gain range over which the ratio gradually in-
creased to the set ratio amount. 

The Gain Reduction meter displays light orange 
while gain reduction has not exceeded the knee 
setting, and switches to dark orange when gain 
reduction reaches the full ratio.

This control ranges from 0 db (hardest response) 
to 30 db (softest response). 

Graph examples of hard and soft knee compression

Hard knee Soft knee



Gain

The Gain control lets you boost overall output 
gain to compensate for heavily compressed or 
limited signals. 

This control ranges from 0 dB (no gain boost) to 
+40 dB (loudest gain boost), with the default 
value at 0 dB.

Side-Chain Section

The side-chain is the split-off signal used by the 
plug-in’s detector to trigger dynamics process-
ing. The Side-Chain section lets you toggle the 
side-chain between the internal input signal or 
an external key input, and tailor the equaliza-
tion of the side-chain signal so that the trigger-
ing of dynamics processing becomes frequency-
sensitive. See “Using the Side-Chain Input in 
Dynamics III” on page 76.

For more information on the LFE channel, 
refer to the Pro Tools Reference Guide.
Expander/Gate III

The Expander/Gate plug-in applies expansion or 
gating to audio material, depending on the ratio 
setting. 

About Expansion

Expansion decreases the gain of signals that fall 
below a chosen threshold. They are particularly 
useful for reducing noise or signal leakage that 
creeps into recorded material as its level falls, as 
often occurs in the case of headphone leakage.

About Gating

Gating silences signals that fall below a chosen 
threshold. To enable gating, simply set the Ratio 
and Range controls to their maximum values.

Expanders can be thought of as soft noise gates 
since they provide a gentler way of reducing 
noisy low-level signals than the typically abrupt 
cutoff of a gate.

Expander/Gate III
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Expander/Gate III Controls

This section describes controls for the Ex-
pander/Gate plug-in.

Input/Output Level Meters

The Input and Output meters show peak signal 
levels before and after dynamics processing. See 
“Levels Section” on page 65 for more informa-
tion.

Expander/Gate Dynamics Graph Display

The Dynamics Graph display lets you visually 
see how much expansion or gating you are ap-
plying to your audio material. See “Dynamics 
Graph Display” on page 66.

Look Ahead Button

Normally, dynamics processing begins when 
the level of the input signal crosses the thresh-
old. When the Look Ahead button is enabled, 
dynamics processing begins 2 milliseconds be-
fore the level of the input signal crosses the 
threshold. 

The Look Ahead control is useful for avoiding 
the loss of transients that may have been other-
wise cut off or trimmed in a signal.

Look Ahead control
DigiRack Plug-ins Guide
Threshold

The Threshold control sets the level below 
which an input signal must fall to trigger expan-
sion or gating. Signals that fall below the thresh-
old will be reduced in gain. Signals that are 
above it will be unaffected.

An orange arrow on the Input meter indicates 
the current threshold, and can also be dragged 
up or down to adjust the threshold setting. 

The Dynamics Graph display also shows the 
threshold as an orange vertical line.

This control has an approximate range of –60 dB 
to 0 dB, with a setting of 0 dB equivalent to no 
compression or limiting. The default value for 
the Threshold control is –24 dB.

Threshold arrow on Input meter

Threshold indicator on Dynamics Graph display

Threshold
arrow

Threshold



Ratio

The Ratio control sets the amount of expansion. 
For example, if this is set to 2:1, it will lower sig-
nals below the threshold by one half. At higher 
ratio levels (such as 30:1 or 40:1) the Ex-
pander/Gate functions like a gate by cutting off 
signals that fall below the threshold. As you ad-
just the ratio control, refer to the built-in graph 
to see how the shape of the expansion curve 
changes.

This control ranges from 1:1 (no expansion) to 
100:1 (gating).

Attack

The Attack control sets the attack time, or the 
rate at which gain is reduced after the input sig-
nal crosses the threshold. Use this along with 
the Ratio setting to control how soft the Ex-
pander’s gain reduction curve is.

This control ranges from 10 μs (fastest attack 
time) to 300 ms (slowest attack time).

Hold

The Hold control specifies the duration (in sec-
onds or milliseconds) during which the Ex-
pander/Gate will stay in effect after the initial at-
tack occurs. This can be used as a function to 
keep the Expander/Gate in effect for longer peri-
ods of time with a single crossing of the thresh-
old. It can also be used to prevent gate chatter 
that may occur if varying input levels near the 
threshold cause the gate to close and open very 
rapidly.

This control ranges from 5 ms (shortest hold) to 
4 seconds (longest hold).
Release

The Release control sets how long it takes for the 
gate to close after the input signal falls below the 
threshold level and the hold time has passed. 

This control ranges from 5 ms (fastest release 
time) to 4 seconds (slowest release time).

Range

The Range control sets the depth of the Ex-
pander/Gate when closed. Setting the gate to 
higher range levels allows more and more of the 
gated audio that falls below the threshold to 
peek through the gate at all times.

This control ranges from –80 dB (lowest depth) 
to 0 dB (highest depth).

Side-Chain Section

The side-chain is the split-off signal used by the 
plug-in’s detector to trigger dynamics process-
ing. The Side-Chain section lets you toggle the 
side-chain between the internal input signal or 
an external key input, and tailor the equaliza-
tion of the side-chain signal so that the trigger-
ing of dynamics processing becomes frequency-
sensitive.

See “Using the Side-Chain Input in Dynamics 
III” on page 76.
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De-Esser III

The De-Esser reduces sibilants and other high 
frequency noises that can occur in vocals, voice-
overs, and wind instruments such as flutes. 
These sounds can cause peaks in an audio signal 
and lead to distortion.

The De-Esser reduces these unwanted sounds us-
ing fast-acting compression. A Threshold con-
trol sets the level above which compression 
starts, and a Frequency control sets the fre-
quency band in which the De-Esser operates.

Using De-essing Effectively

To use de-essing most effectively, insert the De-
Esser after compressor or limiter plug-ins.

The Frequency control should be set to remove 
sibilants (typically the 4–10 kHz range) and not 
other parts of the signal. This helps prevent de-
essing from changing the original character of 
the audio material in an undesired manner.

Similarly, the Range control should be set to a 
dB level low enough so that de-essing is trig-
gered only by sibilants. If the Range is set too 
high, a loud, non-sibilant section of audio mate-
rial could cause unwanted gain reduction or 
cause sibilants to be over-attenuated.

De-Esser III
DigiRack Plug-ins Guide
To improve de-essing of material that has both 
very loud and very soft passages, automate the 
Range control so that it is lower on soft sections.

De-Esser III Controls

This section describes controls for the De-Esser 
plug-in.

De-Esser Levels Section

These controls let you track input, output, and 
gain reduction levels.

Input and Output Meters

The Input and Output meters show peak signal 
levels before and after dynamics processing:

Green Indicates nominal levels.

Yellow Indicates pre-clipping levels, starting at 
–6 dB below full scale.

Red Indicates full scale levels (clipping).

The De-Esser has no control to directly ad-
just the threshold level (the level that an in-
put signal must exceed to trigger de-essing). 
The amount of de-essing will vary with the 
input signal. 

De-Esser III I/O Meter display

Gain
Reduction 
meter

Input
meter

Output 
meter



The clip indicators at the top of each meter indi-
cate clipping at the input or output stage of the 
plug-in. Clip indicators can be cleared by click-
ing the indicator.

Gain Reduction Meter

The Gain Reduction meter indicates the amount 
the input signal is attenuated, in dB. This meter 
shows different colors during de-essing:

Light Orange Indicates that gain reduction is be-
ing applied, but has not reached the maximum 
level set by the Range control.

Dark Orange Indicates that gain reduction has 
reached the maximum level set by the Range 
control.

Frequency

The Frequency control sets the frequency band 
in which the De-Esser operates. When HF Only 
is disabled, gain is reduced in frequencies within 
the specified range. When HF Only is enabled, 
the gain of frequencies above the specified value 
will be reduced.

This control ranges from 500 Hz (lowest fre-
quency) to 16 kHz (highest frequency).

Range

The Range control defines the maximum 
amount of gain reduction possible when a signal 
is detected at the frequency set by the Frequency 
control.

This control ranges from –40 dB (maximum de-
essing) to 0 dB (no de-essing).
HF Only

When the HF Only button is enabled, gain re-
duction is applied only to the active frequency 
band set by the Frequency control. When the HF 
Only button is disabled, the De-Esser applies 
gain reduction to the entire signal. 

Listen

When enabled, the Listen button lets you mon-
itor the sibilant peaks used by the De-Esser as a 
side-chain to trigger compression. This is useful 
for listening only to the sibilance for fine-tuning 
De-Esser controls. To monitor the whole output 
signal without this filtering, deselect the Listen 
button.

De-Esser Frequency Graph Display

The De-Esser Frequency Graph display shows a 
curve that represents the level of gain reduction 
(on the y-axis) for the range of the output sig-
nal's frequency (on the x-axis). The white line 
represents the current Frequency setting, and 
the animated orange line represents the level of 
gain reduction being applied to the signal.
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Use this graph as a visual guideline to see how 
much dynamics processing you are applying at 
different points in the frequency spectrum.

Using the Side-Chain Input in 
Dynamics III
(Compressor/Limiter and Expander/Gate 
Only)

Dynamics processors typically use the detected 
amplitude of their input signal to trigger gain re-
duction. This split-off signal is known as the 
side-chain. The Compressor/Limiter and Ex-
pander/Gate plug-ins feature external key capa-
bilities and filters for the side-chain.

With external key side-chain processing, you 
trigger dynamics processing using an external 
signal (such as a separate reference track or au-
dio source) instead of the input signal. This ex-
ternal source is known as the key input.

De-Esser graph display

In Pro Tools TDM 6.9.x and lower, RTAS 
plug-ins do not provide external key side-
chain processing. If you want to use side-
chain processing, use the TDM versions of 
plug-ins on Pro Tools|HD systems.

Frequency
(x-axis)

Gain
(y-axis)

Frequency

Range

Current gain 
reduction
DigiRack Plug-ins Guide
With side-chain filters, you can make dynamics 
processing more or less sensitive to certain fre-
quencies. For example, you might configure the 
side-chain so that certain lower frequencies on a 
drum track trigger dynamics processing.

Side-Chain Section

The Side-Chain section lets you toggle the side-
chain between the internal input signal or an 
external key input, listen to the side-chain, and 
tailor the equalization of the side-chain signal so 
that the triggering of dynamics processing be-
comes frequency-sensitive.

External Key

The External Key toggles external side-chain 
processing on or off. When this button is high-
lighted, the plug-in uses the amplitude of a sep-
arate reference track or external audio source to 
trigger dynamics processing. When this button 
is dark gray, the External Key is disabled and the 
plug-in uses the amplitude of the input signal to 
trigger dynamics processing.

Compressor/Limiter and Expander/Gate Side-Chain

External Key Side-Chain Listen

HF Filter
Enable

LF Filter
Enable



Side-Chain Listen

When enabled, this control lets you listen to the 
internal or external side-chain input by itself, as 
well as monitor its levels with the Output meter. 
This is especially useful for fine-tuning the plug-
in’s filter settings or external key input.

HF and LF Filter Enable Buttons

The HF Filter Enable and LF Filter Enable but-
tons toggle the corresponding filter in or out of 
the side-chain. When this button is highlighted, 
the filter is applied to the side-chain signal. 
When this button is dark gray, the filter is by-
passed and available for activation.

High-Frequency (HF) Filter Type

The HF filter section lets you filter higher fre-
quencies out of the side-chain signal so that 
only certain bands of high frequencies or lower 
frequencies pass through to trigger dynamics 
processing. The HF side-chain filter is switchable 
between Band-Pass and Low-Pass filters. 

Side-Chain Listen is not saved with other 
plug-in settings.

HF and LF Filter Side-Chain

HF Filter
Enable

HF
Frequency 

Control

Low-
Pass

HF
Band-
Pass

LF Filter
Enable

LF
Frequency 

High-
Pass

LF
Band-
Pass
Band-Pass Filter Makes triggering of dynamics 
processing more sensitive to frequencies within 
the narrow band centered around the Frequency 
setting, and rolling off at a slope of 12 dB per oc-
tave.

Low-Pass Filter Makes triggering of dynamics 
processing more sensitive to frequencies below 
the Frequency setting rolling off at a slope of 
12 dB per octave.

HF Frequency Control

The Frequency control sets the frequency posi-
tion for the Band-Pass or Low-Pass filter, and 
ranges from 80 Hz to 20 kHz.

Low-Frequency (LF) Filter Type

The LF filter section lets you filter lower frequen-
cies out of the side-chain signal so that only cer-
tain bands of low frequencies or higher frequen-
cies are allowed to pass through to trigger 
dynamics processing. The LF side-chain is swit-
chable between Band-Pass and High-Pass filters.

Band-Pass Filter Makes triggering of dynamics 
processing more sensitive to frequencies within 
the narrow band centered around the Frequency 
setting, and rolling off at a slope of 12 dB per oc-
tave.

High-Pass Filter Makes triggering of dynamics 
processing more sensitive to frequencies above 
the Frequency setting rolling off at a slope of 
12 dB per octave.

LF Frequency Control

The Frequency control sets the frequency posi-
tion for the Band-Pass or High-Pass filter, and 
ranges from 25 Hz to 4 kHz.
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Using an External Key Input for Side-
Chain Processing

To use a filtered or unfiltered external key input to 
trigger dynamics processing:

1  Click the Key Input selector and select the in-
put or bus carrying the audio from the reference 
track or external audio source.

2  Click External Key to activate external side-
chain processing.

3  To listen to the signal that will be used to con-
trol side-chain input, click Side-Chain Listen to 
enable it (highlighted).

4  To filter the key input so that only specific fre-
quencies trigger the plug-in, use the HF and LF 
controls to select the desired frequency range.

5  Begin playback. The plug-in uses the input or 
bus that you chose as an external key input to 
trigger its effect.

6  Adjust the plug-in’s Threshold control to fine-
tune external key input triggering.

7  Adjust other controls to achieve the desired ef-
fect.

Selecting a Key Input

Side-Chain section

External Key Side-Chain Listen
DigiRack Plug-ins Guide
Using a Filtered Input Signal for Side-
Chain Processing

To use the filtered input signal to trigger dynamics 
processing:

1  Ensure the Key Input selector is set to No Key 
Input.

2  Ensure that the External Key button is dis-
abled (dark gray).

3  To listen to the signal that will be used to con-
trol side-chain input, click Side-Chain Listen to 
enable it (highlighted).

4  To filter the side-chain input so that only spe-
cific frequencies within the input signal trigger 
the plug-in, use the HF and LF controls to select 
the desired frequency range.

5  Begin playback. The plug-in uses the filtered 
input signal to trigger dynamics processing.

6  To fine-tune side-chain triggering, adjust the 
plug-in controls.

Dynamics II

Key Input selector

Side-Chain section

For information, see the Digidesign Legacy 
Plug-ins Guide.

External Key Side-Chain Listen



Mod Delay II

There are five different Mod Delay II plug-ins, 
capable of different maximum delay times:

• The Short Delay provides 43 ms of delay at all 
sample rates.

• The Slap Delay provides 171 ms of delay at all 
sample rates.

• The Medium Delay provides 341 ms of delay 
at all sample rates.

• The Long Delay provides 683 ms of delay at 
all sample rates.

• The Extra Long Delay provides 2.73 seconds 
of delay at all sample rates.

Mod Delay II plug-in (Long Delay shown)

Short Delay and Slap Delay do not have 
Tempo, Meter, Duration, and Groove con-
trols.
Mod Delay II Controls

Input Controls the input volume of the delay to 
prevent clipping.

Mix Controls the balance between the delayed 
signal (wet) and the original signal (dry). If you 
are using a delay for flanging or chorusing, you 
can control the depth of the effect somewhat 
with the Mix setting.

LPF (Low-Pass Filter) Controls the cutoff fre-
quency of the Low-Pass Filter. Use the LPF set-
ting to attenuate the high frequency content of 
the feedback signal. The lower the setting, the 
more high frequencies are attenuated. The max-
imum value for LPF is Off. This lets the signal 
pass through without limiting the bandwidth of 
the plug-in.

Delay Sets the delay time between the original 
signal and the delayed signal.

Depth Controls the depth of the modulation ap-
plied to the delayed signal.

Rate Controls the rate of modulation of the de-
layed signal.

Feedback Controls the amount of feedback ap-
plied from the output of the delay back into its 
input. It also controls the number of repetitions 
of the delayed signal. Negative feedback settings 
give a more intense “tunnel-like” sound to 
flanging effects. 

The TDM versions of the Extra Long Delay 
mono-to-stereo and stereo plug-in are not 
supported at 96 kHz. All TDM versions of 
the Extra Long Delay plug-in are not sup-
ported at 192 kHz. RTAS versions of the Ex-
tra Long Delay plug-in are fully supported 
at all sample rates.
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Tempo Sync Tempo Sync provides a direct con-
nection between session tempo and plug-in pa-
rameters that support MIDI Beat Clock. This di-
rect connection lets plug-in parameters such as 
delay, auto-pan, and other time-domain effects 
automatically synchronize to, and follow 
changes in, session tempo. For plug-ins that do 
not support Tempo Sync, the original MIDI Beat 
Clock window (Setup > MIDI > MIDI Beat Clock) 
remains available in Pro Tools.

For more information, see “Tempo Sync” on 
page 23. 

Tempo Available in some plug-ins that do not 
support Tempo Sync, Tempo selects the desired 
tempo in beats per minute (bpm). This setting is 
independent of Pro Tools’ tempo. When a spe-
cific Duration is selected (see “Duration” below), 
moving this control will affect the Delay setting. 
Likewise, the range of both controls will be lim-
ited to the maximum available delay with the 
currently selected Duration. To enter very short 
or long delays it may be necessary to deselect all 
Duration buttons.

Meter Use this to enter either simple or com-
pound time signatures. The Meter control de-
faults to a 4/4 time signature.

Tempo Sync is not available in plug-ins 
with which it would limit functionality. For 
example, for the Virus Indigo and 
IndigoV40 plug-in, use the Pro Tools MIDI 
Beat Clock window (Setup > MIDI > MIDI 
Beat Clock). See the Pro Tools Reference 
Guide for more information. 

Use Event > Identify Beat or Event > Beat 
Detective to determine the tempo. For more 
information about Identify Beat and Beat 
Detective refer to the Pro Tools Reference 
Guide.
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Duration Specifies a desired delay from a musical 
perspective. Enter the desired delay by selecting 
appropriate note value (whole note, half note, 
quarter note, eight note, or sixteenth note). Se-
lect the Dot or Triplet modifier buttons to dot 
the selected note value or make it a triplet. For 
example, selecting a quarter note and then se-
lecting the dot indicates a dotted quarter note, 
and selecting an eighth note and then selecting 
the triplet indicates a triplet eight note.

Groove Provides fine adjustment of the delay in 
percentages of a 1:4 subdivision of the beat. It 
can be used to add “swing” by slightly offsetting 
the delay from the precise beat of the track.

Tempo, Meter, Duration, and Groove controls

It is not possible to exceed the maximum 
delay length for a particular version of Mod 
Delay II. Consequently, when adjusting any 
of the tempo controls (Tempo, Meter, Dura-
tion, and Groove) you may not be able to 
adjust the control across its full range. If 
you encounter this behavior, switch to a ver-
sion of Mod Delay II that has a longer delay 
time (for example, switch from Medium De-
lay to Long Delay).

Dot modifierTriplet modifierDuration



Multichannel Mod Delay II

The Tempo and Meter controls are linked on 
multichannel versions of Mod Delay II. Each 
channel has its own Duration and Groove con-
trols, but the Tempo and Meter controls are glo-
bal.

Signal Generator
The Signal Generator plug-in produces audio 
test tones in a variety of frequencies, waveforms, 
and amplitudes. It is particularly useful for gen-
erating reference signals with which to calibrate 
Pro Tools|HD interfaces (such as the 96 I/O or 
192 I/O) and other elements of your studio. 

Tempo, Meter, Duration, and Groove controls for a 
stereo instance of Mod Delay II

Refer to the Pro Tools|HD Getting Started 
Guide for instructions on using Signal Gen-
erator to calibrate the 96 I/O, or 192 I/O 
audio interfaces, as well as older audio in-
terfaces.

Signal Generator plug-in

The TDM Signal Generator produces a tone 
as soon as it is inserted on a track. To mute 
the Signal Generator, use the Bypass button. 
When using the RTAS version of Signal 
Generator, start playback to generate. 
Signal Generator Controls

Frequency Sets the frequency of the signal in 
hertz. Values range from a low of 20 Hz to a high 
of 20 kHz in a 44.1 kHz session. The upper limit 
of the frequency range for this setting will in-
crease to match the Nyquist frequency (half the 
sample rate) in 96 kHz and 192 kHz sessions 
(HD-series systems only).

Level Sets the amplitude of the signal in deci-
bels. Values range from a low of –95 dB to a high 
of 0.0 dB.

Signal These buttons select the waveform. 
Choices are sine, square, sawtooth, triangle, 
white noise, and pink noise.

Peak Generates signal at the maximum possible 
level without clipping.

RMS Generates signal at levels consistent with 
the RMS (Root-Mean-Square) value, or the effec-
tive average level of the signal.

SignalTools
DigiRack SignalTools metering plug-ins provide 
two metering modules: SurroundScope and 
PhaseScope. 

The SignalTools plug-ins support TDM and 
RTAS plug-in formats at all sample rates.

The Signal Generator plug-in is not in-
tended for rigorous test purposes; it is a sim-
ple level calibration tool.
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SurroundScope
(Pro Tools HD Only)

SurroundScope is a plug-in that provides sur-
round metering for multichannel track types 
from 3 channels (LCR) to 8 channels (7.1 sur-
round). Stereo and mono tracks are not sup-
ported. 

This version of SurroundScope is compatible 
with sessions that used the previous versions 
of SurroundScope. 

SurroundScope

Surround DisplayMeters

Display Options Phase/Leq(A) Display
DigiRack Plug-ins Guide
Surround Display

SurroundScope detects the multi-channel for-
mat of the track and displays each channel in 
the signal in a circle around the Surround Dis-
play.

The Surround Display generates a composite im-
age that indicates relative signal strength in the 
displayed channels.

� A circle in the center of the display indicates a 
surround signal that is panned equally to all 
channels.

� An irregular shape that is closer to one side of 
the display indicates that the channels on that 
side have a stronger signal.

� A teardrop shape that points toward a single 
channel indicates that the signal is panned to 
that channel.

SurroundScope Surround Display (5.0 shown)



PhaseScope

PhaseScope is a multichannel metering plug-in 
that provides signal level and phase information 
for stereo tracks only. (Mono and LCR or greater 
multichannel tracks are not supported.) 

PhaseScope

Lissajous Meter DisplayMeters

Display Options Phase/Leq(A) Display
Lissajous Meter Display

The PhaseScope Lissajous Meter displays the re-
lationship between the amplitude and phase of 
a stereo signal, enabling you to monitor stereo 
imaging graphically. 

The Lissajous Meter display is divided into four 
quadrants, with left and right channels arranged 
diagonally. When audio is panned predomi-
nantly to a particular speaker channel, a diago-
nal line appears, indicating the channel.

The Lissajous Meter displays in-phase material 
as a vertical line and out-of-phase material as a 
horizontal line.

A “Lissajous curve” (also known as a Lissa-
jous figure or Bowditch curve) is a type of 
graph that is able to describe complex har-
monic motion. To learn more, search the 
Web or your local library for information on 
its origins and its two principal developers, 
Jules Antoine Lissajous, and Nathaniel 
Bowditch.

PhaseScope Lissajous Meter Display
Chapter 6: DigiRack Real-Time TDM and RTAS Plug-ins 83



84
SignalTools Display Options

Both SignalTools plug-ins offer two display op-
tions: Phase Meter Display and Leq(A) Meter 
Display. 

To choose a display option:

� Click the corresponding button in the Op-
tions section of the plug-in window.

Phase Meter Display

The Phase Meter indicates the phase coherency 
of two channels of a multi-channel signal.

The Phase Meter is green when the channels are 
positively out of phase (values from 0 to +1) and 
red when the channels are negatively out of 
phase (values from 0 to –1).

At the center or zero position, the signal is a per-
fect stereo image. At the +1 position, the signal 
is a perfect mono image. At the –1 position, the 
signal is 100% out of phase.

SignalTools display options

SignalTools Phase Meter
DigiRack Plug-ins Guide
SurroundScope With SurroundScope you can se-
lect the two channels to compare by clicking the 
channel buttons around the Surround Display. 
Selected channels are indicated in blue.

PhaseScope With PhaseScope, the left and right 
channels are always compared.

Leq(A) Meter Display

The Leq(A) Meter display lets you view the true 
weighted average of the power level sent to any 
channel or combination of channels (except the 
LFE channel) in a multichannel track. 

The Leq(A) Meter display shows a floating aver-
age for the level over the interval chosen in the 
Window menu. For example, with a setting of 2 
seconds, the display shows the average value for 
the most recent 2 seconds of audio playback.

Selecting SurroundScope channels for phase metering 

SignalTools Leq(A) meter and controls



Selecting Channels for Leq(A) Metering

SurroundScope With SurroundScope, you can 
select any combination of channels for Leq(A) 
metering by clicking the channel buttons 
around the Surround Display. Selected channels 
are indicated in green.

PhaseScope With PhaseScope, you can select ei-
ther or both channel for Leq(A) metering by 
clicking the channel buttons in the corners of 
the Lissajous display. Selected channels are indi-
cated in green. 

Leq(A) Metering Controls

Window The Leq(A) window menu lets you 
choose the length of time the signal is measured 
before an average value is calculated. Settings 
range from 1 second to 2 minutes. 

When the Leq(A) meter is in INF (infinite) mode 
it is constantly averaging the signal without a 
floating averaging window.

Reset The Reset button lets you manually reset 
the start time of the Leq(A) measurement win-
dow. 

Selecting SurroundScope channels for Leq (A) metering 

Selecting PhaseScope channels for Leq(A) metering 
Auto Reset When enabled, causes the start time 
of the Leq(A) measurement window to be auto-
matically reset whenever playback starts in 
Pro Tools.

Hold on Stop When enabled, causes the Leq(A) 
measurement window timer to pause when 
playback stops, and resume when playback be-
gins again. 

SignalTools Level Meters

The SignalTools plug-ins let you choose the type 
of metering to use. Each meter type has a differ-
ent metering scale and response.

In any of the Loop Transport modes, the 
measurement start time is automatically re-
set each time playback goes back to the be-
ginning of the loop.

SignalTools level meters

Reference
mark

Meter Type
selectorPeak Hold

selector
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Meter Types

Peak (Default meter type) Uses the metering 
scale in DigiRack EQ III and Dynamics III plug-
ins.

RMS (Root Mean Square) was used in previous 
versions of the Digidesign SurroundScope plug-
in and uses the same “true” RMS metering scale.

Peak + RMS Uses a multi-color display to show 
both types of metering. Peak metering is shown 
in conventional green color, while RMS meter-
ing is shown in blue. 

VU (Volume Unit) Uses AES standards for signal 
level indication.

BBC Uses IEC-IIa standards for signal level indi-
cation. This style of metering suppresses short 
duration peaks that would not affect broadcast 
program material. Reference calibration (4 dB) is 
–18 dBFS.

Nordic Uses IEC Type I standards for signal level 
indication and provides greater resolution for 
readings between –10 dBu and +4 dBu. Refer-
ence calibration (0 dB) is –18 dBFS.

DIN Uses IEC Type I standards for signal level in-
dication and provides greater resolution for 
readings between –10 dBu and +5 dBu. Refer-
ence calibration (–9 dB) is –18 dBFS.

The “true” RMS meter scale is not the same 
as the AES 17 RMS scale. For a sine wave 
with a peak value of –20 dBFS, the “true” 
RMS meter will show a value of –23 dBFS. 
(The same sine wave will show a value of 
–20 dBFS on an AES 17 RMS meter.‚
DigiRack Plug-ins Guide
VENUE Provides Peak metering behavior with a 
meter scale calibrated specifically for Digidesign 
VENUE systems. Reference calibration (0 dB) is 
–20 dBFS. 

Meter Peak Hold Options

Each of the SignalTools plug-ins lets you choose 
the style of peak hold when peaks are shown in 
the plug-in meters. 

3 Second Displays peak levels for 3 seconds

Infinite Displays peak levels until meters are 
cleared

No Peak Hold Does not display peak levels

Reference Mark Options

Each SignalTools meter type lets you adjust the 
level of the reference mark on the side of the 
meter display. The mark is set by default to the 
reference level for the corresponding meter 
type. 

To change the reference level of a SignalTools 
meter:

� Drag the reference mark to a different location 
on the meter scale.

Meter values are always displayed on con-
trol surfaces in dBFS values, regardless of 
the Meter Type setting. 

SignalTools meters also change color to 
show different ranges of level. The relative 
range of color automatically adjusts to fol-
low the current Reference Mark setting in all 
meter types (except Peak+RMS). 



Pitch
(Pro Tools HD Only)

The Pitch plug-in is designed for a variety of au-
dio production applications ranging from pitch 
correction of musical material to sound design.

Pitch processing uses the technique of varying 
sample playback rate to achieve pitch transposi-
tion. Because changing audio sample playback 
rate results in the digital equivalent of vari-
speeding with tape, this is an unsatisfactory 
method since it changes the overall duration of 
the material.

Pitch transposition with the Pitch plug-in in-
volves a much more complex technique: digi-
tally adding or subtracting portions of the audio 
waveform itself, while using de-glitching cross-

Pitch plug-in
fades to minimize undesirable artifacts. The re-
sult is a processed signal that is transposed in 
pitch, but still retains the same overall length as 
the original, unprocessed signal.

Pitch Controls

Input Level Attenuates the input level of the 
Pitch plug-in to help prevent internal clipping.

Signal Present Indicator LED Indicates the pres-
ence of an input signal. 

Clip Indicator Indicates whether clipping has oc-
curred on output. It is a Clip-Hold Indicator. If 
clipping occurs at any time, the clip light will re-
main on. To clear the Clip Indicator, click it. 
Long delay times and high feedback times in-
crease the likelihood of clipping.

Mix Adjusts the ratio of dry signal to effected sig-
nal in the output. In general, this control should 
be set to 100% wet, unless you are using the 
Pitch plug-in in-line on an Insert for an individ-
ual track or element in a mix. This control can 
be adjusted over its entire range with little or no 
change in output level. 

Delay Sets the delay time between the original 
signal and the pitch-shifted signal. It has a max-
imum setting of 125 milliseconds. You can use 
the Delay control in conjunction with the Feed-
back control to generate a single pitch-shifted 
echo, or a series of echoes that climb in pitch.

Feedback Controls the amount and type of feed-
back (positive or negative) applied from the out-
put of the delay portion of the Pitch plug-in 
back into its input. It also controls the number 

The Pitch plug-in was formerly called 
DPP-1. It is fully compatible with all set-
tings and presets created for DPP-1.
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of repetitions of the delayed signal. You can use 
it to produce effects that spiral up or down in 
pitch, with each successive echo shifted in 
pitch. 

Coarse Adjusts the pitch of a signal in semitones 
over a two octave range. Pitch changes are indi-
cated both in the Semitones field and in the Mu-
sical Staff Relative section below this slider. Us-
ing the –8va and +8va buttons in conjunction 
with the Coarse slider provides a full 4-octave 
range of adjustment.

–8va and +8va Buttons Clicking the –8va button 
adjusts pitch down one octave from the current 
setting of the coarse and fine pitch controls. 
Clicking the +8va button adjusts pitch up one 
octave from the current setting of the coarse and 
fine pitch controls. 

Relative Pitch Entry (Musical Staff)

Clicking on any note on this musical staff selects 
a relative pitch transposition value that will be 
applied to an audio signal. If Middle C is illumi-
nated, it indicates that no pitch transposition 
has been selected. If a pitch transposition is se-
lected, the note interval corresponding to the se-
lected transposition value is indicated in yellow. 
Alt-clicking (Windows) or Option-clicking 
(Mac) on the staff will set the coarse pitch 
change value to zero.

Fine Controls the pitch of a signal in cents (hun-
dredths of a semitone) over a 100 cent range. 
The range of this slider is –49 to +50 cents. Pre-
cise Pitch change values are indicated in the 
Cents field. The flat, natural, and sharp signs be-
low this slider indicate deviation from the near-
est semitone. 

Relative pitch entry
DigiRack Plug-ins Guide
Ratio Indicates the ratio of transposition be-
tween the original pitch and the selected trans-
position value. 

Crossfade Adjusts crossfade length in millisec-
onds to optimize performance of the Pitch plug-
in according to the type of audio material you 
are processing. The Pitch plug-in performs pitch 
transposition by replicating or subtracting por-
tions of audio material and very quickly cross-
fading between these alterations in the wave-
form of the audio material. 

Crossfade length affects the amount of smooth-
ing performed on audio material to prevent au-
dio artifacts such as clicks from occurring as the 
audio is looped to generate the pitch shift.

In general, small, narrow-range pitch shifts re-
quire longer crossfades and large shifts require 
smaller ones. The disadvantage of a long cross-
fade time is that it will smooth the signal, in-
cluding any transients. While this is sometimes 
desirable for audio material such as vocals, it is 
not appropriate for material with sharp tran-
sients such as drums or percussion.

The default setting for this control is Auto. At 
this setting, crossfade times are set automati-
cally, according to the settings of the Coarse and 
Fine pitch controls. The Auto setting is appropri-
ate for most applications. However, you can 
manually adjust and optimize crossfade times 
using the Crossfade slider if necessary. For audio 
material with sharper attack transients, use 
shorter crossfade times. For audio material with 
softer attack transients, use longer crossfade 
times. 



Minimum Pitch Sets the minimum fundamental 
pitch that the Pitch plug-in will recognize when 
performing pitch transposition. Use this to opti-
mize the Pitch plug-in’s performance by adjust-
ing this control based on the lowest fundamen-
tal pitch of the audio material that you want to 
process. 

On audio material with a low fundamental pitch 
frequency content (such as an electric bass gui-
tar) setting this control to a lower frequency 
such as 30 Hz will improve the Pitch plug-in’s 
performance. The most important thing to re-
member when using this control is that the fun-
damental frequency of audio material you want 
to process must be above the frequency you set 
here. 

The range of this slider is from 15 Hz to 1000 Hz. 
The default setting is 60 Hz. Adjustment is tied 
to the current setting of the Maximum Pitch 
control so that the minimum range is never less 
than one octave, and the maximum range never 
more than five octaves. 

Maximum Pitch Adjusts the maximum funda-
mental pitch that the Pitch plug-in will recog-
nize when performing pitch transposition. To 
optimize the Pitch plug-in’s performance, adjust 
this setting (and the Minimum Pitch setting) 
based on the highest fundamental pitch of the 
audio material that you want to process. The 
range of this slider is from 30 Hz to 4000 Hz. The 
default setting is 240 Hz.
TimeAdjuster
The TimeAdjuster plug-in provides three func-
tions: 

• Compensation for delays due to TDM- or 
RTAS-based routing

• Gain compensation (+/– 24 dB)

• Phase inversion for correcting out-of-phase 
signals

The TimeAdjuster plug-in is an efficient way to 
compensate for DSP or host-based processing 
delays in your Pro Tools system.

There are three versions of the TimeAdjuster 
plug-in, each of which supports different sample 
delay ranges: 

Short Supports a maximum delay of 256 samples 
at all sample rates.

Medium Supports a maximum delay of 2048 
samples at all sample rates.

Long Supports a maximum delay of 8192 sam-
ples at all sample rates.

TimeAdjuster plug-in

For special information on Delay Compen-
sation and Time Adjuster, see the Pro Tools 
Reference Guide. 
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TimeAdjuster Controls

Phase Invert Inverts the phase (polarity) of the 
input signal. While most Digidesign plug-ins 
supply a phase invert button of their own, some 
third-party plug-ins may not. Phase inversion is 
also useful for performing delay compensation 
by tuning unknown delay factors by ear (see 
“Using TimeAdjuster for Manual Delay Com-
pensation” on page 90).

Gain Provides up to 24 dB of positive or negative 
gain adjustment. This control is useful for alter-
ing the gain of a signal by a large amount in real 
time. For example, when you are working with 
audio signals that are extremely low level, you 
may want to adjust the channel gain to a reason-
able working range so that a fader is positioned 
at its optimum travel position. Use the Gain 
control to make a wide range of gain adjustment 
in real time without having to permanently pro-
cess the audio files, as you would with an Audi-
oSuite plug-in.

Delay Provides up to 8192 samples of delay com-
pensation adjustment, or general adjustment of 
phase relationships of audio recorded with mul-
tiple microphones, depending on which version 
of TimeAdjuster is used. It defaults to a mini-
mum delay of four samples, which is the delay 
created by use of the TimeAdjuster plug-in itself.

While phase inversion controls have been used 
for many years by engineers as creative tools for 
adjustment of frequency response between mul-
tiple microphones, sample-level delay adjust-
ments provide far more control. Creative use of 
this control can provide a powerful tool for ad-
justing frequency response and timing relation-
ships between audio signals recorded with mul-
tiple microphones.
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Using TimeAdjuster for Manual 
Delay Compensation

DSP and host-based processing in all digital sys-
tems incurs delay of varying amounts. You can 
use the TimeAdjuster TDM plug-in to apply an 
exact number of samples of delay to the signal 
path of a Pro Tools track to compensate for de-
lay incurred by specific plug-ins. TimeAdjuster 
provides presets for common delay-compensa-
tion scenarios.

To compensate for several plug-ins in-line, use 
the delay times from each settings file as refer-
ences, and add them together to derive the total 
delay time.

Alternatively, look up the delay in samples for 
the plug-ins you want to compensate for, then 
apply the appropriate amount of delay.

To manually compensate for DSP-induced de-
lays, try one of the following methods:

Phase Inversion

If you are working with phase-coherent track 
pairs, or tracks recorded with multiple micro-
phones, you can invert the phase to negate the 
delay. If you don’t hear any audio when you in-
vert a signal’s phase, you have precisely adjusted 
and compensated for the delay. This is because 
when you monitor duplicate signals and invert 

Some plug-ins (such as Digidesign’s Maxim 
and DINR BNR) have different delays at 
different sample rates. Refer to the Digide-
sign Plug-ins Guide for more information 
about these plug-ins.

A delay table for DigiRack plug-ins appears 
in Appendix B, “DSP Delays Incurred by 
TDM Plug-ins.”



the polarity (phase) of one of them, the signals 
will be of opposite polarity and cancel each 
other out. This technique is convenient for find-
ing the exact delay setting for any plug-in. 

To determine the delay of a plug-in by inverting its 
signal phase:

1  Place duplicate audio regions on two different 
audio tracks and pan them to the center (mono). 

2  Apply the plug-in whose delay you want to 
calculate to the first track, and a Time Adjuster 
plug-in to the second track. 

3  With TimeAdjuster, invert the phase. 

4  Control-drag (Windows) or Command-drag 
(Mac) to fine-tune delay in one sample incre-
ments, or use the up/down arrow keys to change 
the delay one sample at a time until the audio 
signal disappears.

5  Change the polarity back to normal. 

6  Save the TimeAdjuster setting for later use.

Comb-Filter Effect Cancellation

Adjust the delay with the signal in phase until 
any comb-filter effects cancel out.

Viewing Channel Delay

Because plug-ins display their delay values in 
the channel delay indicators, this can be used as 
another method for determining delay compen-
sation.

To view time delay values and use TimeAdjuster to 
compensate for the delay:

1  Control-click (Windows) or Command-click 
(Mac) the Track Level Indicator to toggle be-
tween level (that appears on the display as 
“vol”), headroom (“pk”), and channel delay 
(“dly”) indications. Delay values are shown in 
samples. 
2  Apply the TimeAdjuster plug-in to the track 
whose delay you want to increase, and Control-
click (Windows) or Command-click (Mac) its 
Track Level indicator until the channel delay 
value is displayed for that track.

3  Change the delay time in TimeAdjuster by 
moving the Delay slider or entering a value in 
the Delay field, until the channel delay value 
matches that of the first track.

4  Test the delay values by duplicating an audio 
track and reversing its phase while compensat-
ing for delay.

When to Compensate for Delays

If you want to compensate for delays across your 
entire system with Time Adjuster, you will want 
to calculate the maximum delay incurred on 
any channel, and apply the delays necessary to 
each channel to match this channel.

However, this may not always be necessary. You 
may only really need to compensate for delays 
between tracks where phase coherency must be 
maintained (as with instruments recorded with 
multiple microphones or stereo pairs). If you are 
working with mono signals, and the accumu-
lated delays are small (just a few samples, for ex-
ample), you probably needn’t worry about delay 
compensation.

Determining the DSP delay of track inserts (Mix window 
shown)

For more information about delays and 
mixing with Pro Tools HD, see the 
Pro Tools Reference Guide.
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Trim
The Trim plug-in can be used to attenuate an au-
dio signal from –∞ (Infinity) dB to +6 dB or –∞ 
(Infinity) dB to +12 dB. For example, using a 
multi-mono Trim plug-in on a multi-channel 
track provides simple, DSP-efficient muting con-
trol over the individual channels of the track.

This capability is useful, since Track Mute but-
tons mute all channels of a multi-channel track 
and do not allow muting of individual channels 
within the track. 

Trim Controls

Phase Invert Inverts the phase (polarity) of the 
input signal to change the frequency response 
characteristics between multi-miked sources or 
to correct for miswired microphone cables.

Gain Provides –∞ dB to +6 dB or +12 dB of gain 
adjustment, depending whether the Gain toggle 
is set to +6 or +12.

Trim plug-in

Alt-click (Windows) or Option-click (Mac) 
the Trim selector to open a Plug-in window 
for each channel of a multi-channel track.
DigiRack Plug-ins Guide
+6/+12 Gain toggle Switches the maximum 
level of attenuation between –∞ dB to +6 dB and 
–∞ dB to +12 dB.

Output Meter Indicates the output level, includ-
ing any gain compensation added using the 
Gain control.

Mute Mutes the signal output. 

Automation data adjusts to reflect the cur-
rent Gain setting. When working with auto-
mation data from an older version of the 
Trim plug-in, ensure the Gain setting is set 
at +6 dB.

See also “Linking and Unlinking Controls 
on Multi-Mono Plug-ins” on page 21. 



chapter 7

DigiRack AudioSuite Plug-ins
EQ III
The EQ III Plug-in provides a high-quality 
7 Band, 2–4 Band, or 1 Band EQ for adjusting 
the frequency spectrum of audio material.

The EQ III Plug-in appears as two separate 
choices in the plug-in the AudioSuite menu: 
7 Band, or 1 Band. (2–4 Band is not available in 
AudioSuite format; use the 7 Band instead). 

7 Band EQ and 2–4 Band EQ 

The 7 Band EQ and the 2–4 Band EQ have the 
same window and identical controls, but on the 
2–4 Band EQ, a limited number of the seven 
available bands can be active at the same time.

7 Band EQ and 2–4 Band EQ window 
1 Band EQ

The 1 Band EQ has its own window, with six se-
lectable filter types.

The features of these plug-ins are non-real-time, 
but otherwise identical to their real-time coun-
terparts. 

EQ II

1 Band EQ window 

For information on the individual controls 
for these plug-ins, see “EQ III” on page 43

For information, see the Digidesign Legacy 
Plug-ins Guide.
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Dynamics III
Dynamics III provides three modules: 

• Compressor/Limiter

• Expander/Gate

• De-Esser

The features of these plug-ins are non-real-time, 
but otherwise identical to their real-time coun-
terparts.

For information on individual controls in 
these plug-ins, see “Dynamics III” on 
page 63.

Compressor/Limiter 3 plug-in

Expander/Gate 3 plug-in
DigiRack Plug-ins Guide
Dynamics II

De-Esser 3 plug-in

For information, see the Digidesign Legacy 
Plug-ins Guide.



Chorus
Chorus adds a shimmering quality to audio ma-
terial by combining a time-delayed, pitch-
shifted copy of an audio signal with itself.

Gain Adjusts the input volume of the chorus to 
prevent clipping or increase the level of the pro-
cessed signal. This slider is set to a default of 
+3 dB. If your source audio has been recorded 
very close to peak level, this +3 dB default set-
ting could cause clipping. Use this control to re-
duce the input level.

Selecting the Sum Input button sums the dry in-
put signals (mono or stereo) before processing 
them. The dry signal then appears in the center 
of the stereo field and the wet, effected signal 
will be output in stereo.

When the Sum Inputs button is selected, the 
LFO waveform on the right channel is automat-
ically phase inverted to enhance the mono-ste-
reo effect.

The Chorus plug-in was formerly called 
D-fx Chorus. It is fully compatible with all 
settings and presets created for D-fx Chorus.

Chorus plug-in

Sum Inputs button
Mix Adjusts the balance between the effected 
signal and the original signal and controls the 
depth of the effect. Mix is adjustable from 0% to 
100%. 

Low-Pass Filter Controls the cutoff frequency of 
the Low-Pass Filter. Use this to attenuate the 
high frequency content of the feedback signal. 
The lower the setting, the more high frequencies 
are removed from the feedback signal.

The range of the Low-Pass Filter is 20 Hz to 
19.86 kHz, with a maximum value of Off (which 
effectively means bypass).

Delay Sets the delay time between the original 
signal and the chorused signal. The higher the 
setting, the longer the delay and the wider the 
chorusing effect. Delay is adjustable from 0–20 
milliseconds.

LFO Rate Adjusts the rate of the LFO (low fre-
quency oscillator) applied to the delayed signal 
as modulation. The higher the setting, the more 
rapid the modulation. You can select either a 
sine wave or a triangle wave as a modulation 
source, using the LFO Waveform selector.

LFO Width Adjusts the intensity of the LFO ap-
plied to the delayed signal as modulation. The 
higher the setting, the more intense the modu-
lation. Use the LFO Waveform selector to select 
a sine or a triangle wave as a modulation source. 

Feedback Controls the amount of feedback ap-
plied from the output of the delayed signal back 
into its input. Negative settings provide a more 
intense effect.

LFO Waveform Selects a sine wave or triangle 
wave for the LFO. This affects the character of 
the modulation. The sine wave has a gentler 
ramp and peak than the triangle wave.
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Flanger
The Flanger animates and adds a swirling, mov-
ing quality to audio material by combing a time-
delayed copy of an audio signal with itself. 

The Flanger uses a through-zero flanging algo-
rithm that results in a tape-like flanging effect. 
This technique delays the original dry signal by 
256 samples, then modulates the delayed signal 
back and forth in time in relation to the dry sig-
nal, passing through its zero point on the way.

Gain Adjusts the input volume of the flanger to 
prevent clipping or increase the level of the pro-
cessed signal. This slider is set to a default of 
+3 dB. If your source audio has been recorded 
very close to peak level, this +3 dB default set-
ting could cause clipping. Use this control to re-
duce the input level.

Selecting the Sum Input button sums the dry in-
put signals (mono and stereo) before processing 
them. The dry signal then appears in the center 
of the stereo field and the wet, effected signal 
will be output in stereo. 

The Flanger plug-in was formerly called 
D-fx Flanger. It is fully compatible with all 
settings and presets created for D-fx 
Flanger.

Flanger plug-in
DigiRack Plug-ins Guide
When the Sum Inputs button is selected, the 
LFO waveform on the right channel is phase in-
verted to enhance the mono-stereo effect.

Mix Adjusts the balance between the effected 
signal and the original signal and controls the 
depth of the effect. Mix is adjustable from 0% to 
100%. 

High-Pass Filter Controls the cutoff frequency of 
the High-Pass Filter. Use this to attenuate the 
frequency content of the feedback signal and 
the frequency response of the flanging. The 
higher the setting, the more low frequencies are 
removed from the feedback signal.

LFO Rate Adjusts the rate of the LFO (low fre-
quency oscillator) applied to the delayed signal 
as modulation. The higher the setting, the more 
rapid the modulation. You can select either a 
sine wave or a triangle wave as a modulation 
source, using the LFO Waveform selector.

LFO Width Adjusts the intensity of the LFO ap-
plied to the delayed signal as modulation. The 
higher the setting, the more intense the modu-
lation. 

Feedback Controls the amount of feedback ap-
plied from the output of the delayed signal back 
into its input. Negative settings provide a more 
intense effect.

LFO Waveform Selects a sine wave or triangle 
wave for the LFO. This affects the character of 
the modulation. The sine wave has a gentler 
ramp and peak than the triangle wave.



Multi-Tap Delay
The Multi-Tap Delay adds up to four indepen-
dently-controllable delays or taps to the original 
audio signal. Use the Multi-tap delay to add spa-
tialization or complex rhythmic echo effects to 
audio material. You can individually control the 
delay time and number of repetitions of each of 
the four taps.

Gain The Gain slider for each of the Multi-Tap 
delay’s four delay lines controls the input level 
of that individual delay tap. Adjust Gain to pre-
vent clipping or increase the level of the pro-
cessed signal. 

The Multi-Tap Delay plug-in was formerly 
called D-fx Multi-Tap Delay. It is fully 
compatible with all settings and presets cre-
ated for D-fx Multi-Tap Delay.

Multi-Tap Delay plug-in
Selecting the Sum Input button sums the dry in-
put signals (mono or stereo) before processing 
them. The dry signal then appears in the center 
of the stereo field and the wet, effected signal 
will be output in stereo. 

Feedback Controls the amount of feedback ap-
plied from the output of the delay into its input. 
It also controls the number of repetitions of the 
delayed signal. For the feedback feature to func-
tion, the Gain slider must be raised above its 
lowest setting.

Pan The pan sliders for each of the four taps con-
trol their apparent location in the stereo field.

Delay Sets the delay time between the original 
signal and the delayed signal. The higher the 
setting, the longer the delay. This control is ad-
justable from 0–1500 milliseconds (1.5 seconds). 

Mix Adjusts the balance between the effected 
signal and the original signal and controls the 
depth of the effect. Mix is adjustable from 0% to 
100%. 

Selecting Audio for Processing with 
AudioSuite Delay

Because Multi-Tap Delay adds additional mate-
rial to the end of selected audio (a delay tap), 
make a selection that is longer than the original 
source material so AudioSuite Delay can write it 
into the audio file. 

Select only the original material, without leav-
ing additional space at the end, will produce a 
delay that occurs after the end of the region will 
be cut off. 
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To accommodate for this, place the region in a 
track, and select the desired audio plus an 
amount of blank space at the end of the region 
equal to the amount of delay that you have 
added in the plug-in. The plug-in will then have 
space at the end of the region in which to write 
the final delay. 

Ping-Pong Delay
The Ping-Pong Delay plug-in adds a controllable 
delay to the original audio signal. Use the Ping-
Pong delay to add spatialization, and panned 
echo to audio material. This plug-in feeds back 
delayed signals to their opposite channels, creat-
ing a characteristic ping-pong echo effect.

Gain Adjusts the input volume of the Ping-Pong 
Delay to prevent clipping or increase the level of 
the processed signal. 

Mix Adjusts the balance between the effected 
signal and the original signal and controls the 
depth of the effect. Mix is adjustable from 0% to 
100%. 

The Ping-Pong Delay plug-in was formerly 
called D-fx Ping-Pong Delay. It is fully com-
patible with all settings and presets created 
for D-fx Ping-Pong Delay.

Ping-Pong Delay plug-in
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Delay Sets the delay time between the original 
signal and the delayed signal. The higher the 
setting, the longer the delay. This control is ad-
justable from 0–1500 milliseconds (1.5 seconds). 

Low-Pass Filter Controls the cutoff frequency of 
the Low-Pass Filter. Use this to attenuate the 
high frequency content of the feedback signal. 
The lower the setting, the more high frequencies 
are removed from the feedback signal.

The range of the Low-Pass Filter is 20 Hz to 
19.86 kHz, with a maximum value of Off (which 
effectively means bypass).

Feedback Controls the amount of feedback ap-
plied from the output of the delay into its input. 
It also controls the number of repetitions of the 
delayed signal. 

Cross-Feedback Cross-Feedback feeds the de-
layed signals to their opposite channel: The left 
channel delay is fed to the right channel input 
and vice-versa. The result is a stereo echo that 
ping-pongs back and forth between the right 
and left channels.

Selecting Audio for Delay Processing

Because Ping-Pong Delay adds additional mate-
rial (a delay tap) to the end of selected audio, 
make a selection that is longer than the original 
source material to allow the delay tap to be writ-
ten into the end of the audio file. 

Selecting only the original material, without 
leaving additional space at the end, will cause 
delay taps that occur after the end of the region 
to be cut off. 



Invert
The Invert plug-in reverses the polarity of se-
lected audio. Positive sample amplitude values 
are made negative, and all negative amplitudes 
are made positive. 

This process is useful for altering the phase or po-
larity relationship of tracks. The Invert plug-in is 
useful during mixing for modifying frequency 
response between source tracks recorded with 
multiple microphones. You can also use it to 
correct audio recorded out of phase with an in-
correctly wired cable.

Duplicate
The Duplicate plug-in duplicates the selected 
audio in place. Depending on how its controls 
are configured, the new region will appear in ei-
ther the Regions List or playlist. You can use this 
to flatten or consolidate an entire track consist-
ing of multiple regions into one continuous au-
dio file that resides in the same place as the orig-
inal individual regions.

The audio is unaffected by Pro Tools volume or 
pan automation, or by any real-time plug-ins 
that may be in use on the track as inserts. The 
original audio file regions are merely rewritten 
in place to a single duplicate file.

Invert plug-in

Duplicate plug-in
The Duplicate plug-in works nondestructively. 
You cannot choose to overwrite files.

Delay
The Delay plug-in provides time delay-based ef-
fects, with up to 10.9 seconds of delay, at any 
session sample rate. You can also use it to pro-
duce multiple delay-based effects, including slap 
echo, doubling, chorusing, and flanging.

The controls of the AudioSuite Delay plug-in op-
erate in non-real-time, but are otherwise identi-
cal to the real-time Mod Delay II plug-in.

If you have the Mod Delay Plug-in installed, 
Short Delay, Slap Delay, Medium Delay, and 
Long Delay will be available in the AudioSuite 
menu in addition to Delay (Mod Delay II). The 
features of these plug-ins are identical to their 
real-time counterparts. The only difference is 
that the AudioSuite versions operate in non-real 
time.

Delay AudioSuite plug-in

For information on the individual controls 
for the AudioSuite Delay plug-in, see “Mod 
Delay II” on page 79.

For information on the individual controls 
for the AudioSuite Short Delay, Slap Delay, 
Medium Delay, and Long Delay plug-ins, 
see “Mod Delay II” on page 79.
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Selecting Audio Delay Processing

Because AudioSuite Delay adds additional mate-
rial (a delay tap) to the end of selected audio, 
make a selection that is longer than the original 
source material to allow the delay tap to be writ-
ten into the end of the audio file. 

Selecting only the original material, without 
leaving additional space at the end, will cause 
delay taps that occur after the end of the region 
to be cut off. 

Normalize
The Normalize plug-in optimizes the volume 
level of an audio selection. Use it on material re-
corded with too little amplitude, or on material 
whose volume levels are inconsistent (as in a 
poorly recorded narration). 

Unlike compression and limiting, which modify 
the dynamics of audio material, normalization 
preserves dynamics by uniformly increasing (or 
decreasing) amplitude. 

To prevent clipping during sample rate con-
version, Normalize to no greater than the 
range between –2 dB to –0.5 dB. Optimum 
settings will vary with your program mate-
rial and your Conversion Quality setting (in 
the Editing tab of the Preferences dialog).

Normalize plug-in
DigiRack Plug-ins Guide
Max Peak At Specifies how close to maximum 
level (clipping threshold) the peak level of a se-
lection is boosted. Set this value by adjusting the 
Max Peak At slider, by entering a numeric deci-
bel value below the clipping threshold, or by en-
tering a percentage of the clipping threshold.

You can normalize stereo pairs together so that 
two sides of a stereo signal are processed relative 
to each other. 

RMS/Peak Toggle Switches the calibration of 
normalizing between Peak or RMS modes. Peak 
normalizes the input signal at the maximum 
possible level without clipping. RMS normalizes 
the input signal at a level consistent with the 
RMS (Root-Mean-Square) value, or the effective 
average level of the selected region.

Normalizing Multiple Regions Across Tracks

When multiple regions are selected across mul-
tiple tracks, the Normalize plug-in can search for 
peaks in two different modes:

Peak On Each Chan/Track Searches for the peak 
level on a channel-by-channel or track-by-track 
basis.

Peak On All Chans/Tracks Searches for the peak 
level of the entire selection. If ten tracks are se-
lected, for example, the Normalize function will 
find the peak value from all ten.



Gain
The Gain plug-in boosts or lowers a selected re-
gion’s amplitude by a specific amount. Use it to 
smooth out undesired peaks and other dynamic 
inconsistencies in audio material.

Gain Specifies the desired gain level. Set this 
value by manually adjusting the Gain slider, or 
by entering a numeric decibel value, or by enter-
ing a percentage.

Find Level When clicked, displays the peak am-
plitude value of the current selection.

RMS/Peak Toggle Switches the calibration of 
gain adjustment between Peak or RMS modes. 
Peak adjusts the gain of the input signal to the 
maximum possible level without clipping. RMS 
adjusts the input signal to a level consistent 
with the RMS (Root-Mean-Square) value, or the 
effective average level of the selected region.

Reverse
The Reverse plug-in replaces the audio with a re-
versed version of the selection. 

Gain plug-in

Reverse plug-in
Signal Generator
The Signal Generator plug-in produces audio 
test tones in a variety of frequencies, waveforms, 
and amplitudes.

The features of this plug-in are non-real-time, 
but otherwise identical to its real-time counter-
part.

Signal Generator plug-in

You can use the AudioSuite Signal Genera-
tor plug-in for musical purposes as well as 
for testing purposes. For example, you might 
want to add a little color to a kick drum 
track by doubling it with a 50 Hz tone, us-
ing the kick track as the key input signal gat-
ing the tone track.
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To create an audio region using the Signal 
Generator plug-in:

1  Make a selection in the Tracks window.

2  Choose AudioSuite > Signal Generator.

3  Enter values for the Frequency, Level, and Sig-
nal controls.

4  Click Process in the Signal Generator plug-in.

DC Offset Removal
The DC Offset Removal plug-in removes DC off-
set from audio files. DC offset is a type of audio 
artifact (typically caused by miscalibrated ana-
log-to-digital convertors) that can cause pops 
and clicks in edited material. 

To check for DC offset, find a silent section in 
the audio material. If DC offset is present, a 
near-vertical fade-in with a constant or steady-
state offset from zero will appear in the wave-
form. Use the DC Offset Removal plug-in to re-
move it.

Select the Create Continuous File option for 
greater flexibility in making audio selec-
tions for use with the Signal Generator plug-
in.

For information on the individual controls 
for the Signal Generator plug-in, see “Signal 
Generator” on page 81.

DC Offset Removal plug-in
DigiRack Plug-ins Guide
Time Compression/ 
Expansion
The Time Compression/Expansion plug-in ad-
justs the duration of selected regions, increasing 
or decreasing their length without changing 
pitch.

It is especially useful in audio post production 
for adjusting audio to specific time or SMPTE 
durations for synchronization purposes. Time 
Compression/Expansion is nondestructive.

Source and Destination The Source fields display 
the length of the current selection before pro-
cessing in each of the listed formats. All fields 
are always active; a change made to one value is 
immediately reflected in the others.

The Destination fields both display and control 
the final length of the selection after processing. 
Enter the length of the Destination file by dou-
ble-clicking the appropriate field in the Destina-
tion column.

Time Compression/Expansion plug-in

Normalizing a selection before using Time 
Compressing/Expansion may produce better 
results.



Use the Ratio, Crossfade, Min Pitch, and Accu-
racy controls to fine-tune the Time Compres-
sion/Expansion process.

Ratio Sets the destination length in relation to 
the source length. Moving the slider to the right 
increases the length of the destination file, 
while moving the slider to the left decreases its 
length.

Crossfade Adjusts the crossfade length in milli-
seconds, optimizing performance of the Time 
Compression/Expansion according to the type 
of audio material being processed. (This plug-in 
achieves length modification by replicating or 
subtracting very small portions of audio mate-
rial and very quickly crossfading between these 
alterations in the waveform of the audio mate-
rial.)

Crossfade length affects the amount of smooth-
ing performed on audio material. This prevents 
audio artifacts such as clicks from occurring. 
Long crossfade times may over-smooth a signal 
and its transients. This may not be desirable on 
drums and other material with sharp transients.

Use the Crossfade slider to manually adjust and 
optimize crossfade times if necessary. For audio 
material with sharper attack transients, use 
smaller crossfade times. For audio material with 
softer attack transients, use longer crossfade 
times.
Min Pitch Sets the minimum, or lowest, pitch 
that will be used in the plug-in’s calculations 
during the Time Compression/Expansion pro-
cess. The control has a range of 40 Hz to 1000 
Hz. 

This control should be set lower when process-
ing bass guitar or audio material with a low fre-
quency range. Set this control higher when pro-
cessing higher frequency range audio material.

Accuracy Prioritizes the processing resources al-
located to audio quality (Sound) or timing 
(Rhythm). Moving the slider towards “Sound” 
generally results in better sonic quality and 
fewer audio artifacts. Moving the slider towards 
“Rhythm” puts the emphasis on keeping the 
tempo consistent. 

When you are working with audio loops, listen 
carefully and adjust the Accuracy slider until 
you find a setting that keeps timing solid within 
the region. If you don’t, start and end times may 
be precise, but the beats in rhythmic material 
may appear to be shuffled if too little priority is 
given to Rhythm.

Time Compression & Expansion settings 
created in version 4.x and later of Pro Tools 
for Windows are not compatible with later 
versions.
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Pitch Shift
The Pitch Shift plug-in adjusts the pitch of any 
source audio file with or without a change in its 
duration. This is a very powerful function that 
transposes audio a full octave up or down in 
pitch with or without altering playback speed.

Gain Adjusts input level, in 10ths of a dB. Drag-
ging the slider to the right increases gain, drag-
ging to the left decreases gain. 

Coarse and Fine Adjusts amount of pitch shift. 
The Coarse slider transposes in semitones (half 
steps). The Fine slider transposes in cents (hun-
dredths of a semitone). 

Time Correction Disabling this option has the ef-
fect of “permanently varispeeding” your audio 
file. The file’s duration will be compressed or ex-
tended according to the settings of the Coarse 
and Fine pitch controls. When Time Correction 

Pitch Shift plug-in
DigiRack Plug-ins Guide
is enabled, fidelity can be affected. For example, 
time expansion as a result of Time Correction 
when lowering pitch can cause the audio to 
sound granulated.

Ratio Adjusts the amount of transposition 
(pitch change). Moving the slider to the right 
raises the pitch of the processed file, while mov-
ing the slider to the left decreases its pitch. 

Crossfade Use this to manually adjust crossfade 
length in milliseconds to optimize performance 
of the Pitch Shift plug-in according to the type 
of audio material you are processing. This plug-
in achieves pitch transposition by processing 
very small portions of the selected audio mate-
rial and very quickly crossfading between these 
alterations in the waveform of the audio mate-
rial. 

Crossfade length affects the amount of smooth-
ing performed on audio material. This prevents 
audio artifacts such as clicks from occurring. In 
general, smaller pitch transpositions require 
longer crossfades; wider pitch transpositions re-
quire smaller crossfades. Long crossfade times 
may over-smooth a signal and its transients. 
This is may not be desirable on drums and other 
material with sharp transients. 

Use the Crossfade slider to adjust and optimize 
crossfade times. For audio material with sharper 
attack transients, use smaller crossfade times. 
For audio material with softer attack transients, 
use longer crossfade times. 

Min Pitch Sets the lowest pitch used in the plug-
in’s Pitch Shift processing. The control has a 
range of 40 Hz to 1000 Hz. Use it to focus the 
Pitch Shift process according to the audio’s spec-
tral shape. 

Use lower values when processing lower fre-
quency audio material. Use higher values when 
processing higher frequency audio material.



Accuracy Sets the processing resources allocated 
to audio quality (Sound) or timing (Rhythm). 
Set the slider toward Sound for better audio 
quality and fewer audio artifacts. Set the slider 
toward Rhythm for a more consistent tempo.

Reference Pitch Activates a sine wave-based 
pitch generator that you can use as an audible 
reference when pitch-shifting audio material.

Note Adjusts the frequency of the reference tone 
in semitones (half steps).

Detune Provides finer adjustment of the fre-
quency of the reference tone in cents (100ths of 
a semitone).

Gain Adjusts the volume of the reference tone 
in dB.

To use the Reference Pitch:

1  Select the audio material you want to use as a 
pitch reference. Click the preview button to be-
gin playback of the selected audio.

2  Click the Reference Pitch button to activate 
the reference sine wave tone.

3  Adjust the Note and Detune settings to match 
the reference tone to the pitch of the audio play-
back. Adjust the Gain setting to change the rel-
ative volume of the reference tone. It may also 
be helpful to toggle the Reference Pitch on and 
off to compare pitch.

4  Select the audio material to be pitch shifted. 

5  Adjust the Coarse and Fine Pitch Shift controls 
to match the pitch of the audio playback to the 
reference pitch.

6  Click Process to apply pitch shift to the selec-
tion.
Time Shift
Time Shift provides high quality time compres-
sion and expansion (TCE) algorithms and for-
mant correct pitch-shifting. Time Shift is ideal 
for music production, sound design, and post 
production applications. Use it to manipulate 
audio loops for tempo matching or to transpose 
vocal tracks using formant correct pitch shift-
ing. You can also use it in audio post production 
for pull up and pull down conversions as well as 
for adjusting audio to specific time or SMPTE 
durations for synchronization purposes. 

Time Shift Displays and Controls

The interface for Time Shift is organized in four 
parts: Audio, Time, Formant or Transient, and 
Pitch.

Time Shift plug-in
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Audio Use the controls in the Audio section to 
select the most appropriate time compression 
and expansion algorithm (mode) for the type of 
material you want to process, and to attenuate 
the gain of the processed audio to avoid clip-
ping.

Time Use the controls in the Time section to 
specify the amount of time compression or ex-
pansion you want to apply.

Formant or Transient Use the controls in the For-
mant or Transient section to adjust either the 
amount of formant shift or the transient detec-
tion parameters depending upon which mode 
you have selected in the Audio section. The For-
mant section is only available when Monopho-
nic is selected as the Audio Mode. The Transient 
section is available with slightly different con-
trols depending on whether Polyphonic or 
Rhythmic is selected as the Audio Mode.

Pitch Use the controls in the Pitch section to ap-
ply pitch shifting. Pitch shifting can also be for-
mant correct if you select the Monophonic au-
dio setting.

Audio

The Audio section of Time Shift provides con-
trols for specifying the type of audio you want to 
process and gain attenuation of the processed 
signal to avoid clipping.

Mode

The Audio Mode pop-up menu determines the 
type of TCE and pitch shift algorithm for pro-
cessing audio: Monophonic, Polyphonic, 
Rhythmic, or Varispeed. 

Time Shift plug-in, Audio section
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Monophonic Use for processing monophonic 
sounds (such as a vocal melody). 

Polyphonic Use for processing complex sounds 
(such as a multipart musical selection).

Rhythmic Use for processing percussive sounds 
(such as a mix or drum loop).

Varispeed Use to link time and pitch change for 
tape-like pitch and speed change effects, and 
post production workflows.

Range

The Audio Range pop-up menu determines the 
frequency range for analysis: Low, Mid, High, or 
Wide. For low-range material, such as a bass gui-
tar, select Low. For mid-range material, such as 
male vocals, select Mid. The high range control 
is for material with a high fundamental fre-
quency, such as female vocals. For more com-
plex material that covers a broad frequency 
spectrum, select Wide. 

In Polyphonic mode, Wide is the default setting 
and is usually best for all material when using 
the Polyphonic audio type.

In Monophonic mode, Mid is the default setting 
and is usually matches the range of most mono-
phonic material.

Rhythmic mode uses transient analysis for 
time shifting. If you select audio with no ap-
parent transients, or set the Transient 
Threshold control to a setting above any de-
tected transients, Time Shift assumes a “vir-
tual-transient” every three seconds to be 
able to process the file. Consequently, the 
file should be 20 bpm or higher (one beat ev-
ery three seconds) to achieve desirable re-
sults. For material that has no apparent 
transients, use Monophonic or Polyphonic 
mode.



The range pop-up menu is unavailable in Rhyth-
mic mode and Varispeed mode.

Gain

The Audio Gain control attenuates the input 
level to avoid clipping. Adjust the Gain control 
from 0.0 dB to –6.0 dB to avoid clipping in the 
processed signal.

Clip Indicator

The Clip indicator indicates clipping in the pro-
cessed signal. When using time compression or 
pitch shifting above the original pitch, it is pos-
sible for clipping to occur. The Clip indicator 
lights when the processed signal is clipping. If 
the processed signal clips, undo the AudioSuite 
process and attenuate the input gain using the 
Gain control. Then, re-process the selection.

Level Indicator

The Level indicator displays the level of the out-
put signal using a plasma LED, which uses the 
full range of plasma level metering colors.

Time

The Time section of Time Shift provides controls 
for specifying the amount of time compression 
or expansion as well as the timebase used for cal-
culating TCE. Adjust the Time control to change 
the target duration for the processed audio.

Time Shift plug-in, Time section
Original Displays the Start and End times, and 
Length of the edit selection. Times are displayed 
in units of the timebase selected in the Units 
pop-up menu.

Processed Displays the target End time and 
Length of the processed signal. Times are dis-
played in units of the timebase selected in the 
Units pop-up menu. You can click the Processed 
End and Length fields to type the desired values. 
These values update automatically when adjust-
ing the Time control.

Tempo Displays the Original Tempo and Pro-
cessed Tempo in beats per minute (bpm). You 
can click the Original Tempo and Processed 
Tempo fields to type the desired values. The Pro-
cessed Tempo value updates automatically 
when adjusting the Time control. 

Unit Select the desired timebase for the Original 
and Processed time fields: Bars|Beats, Min:Sec, 
Time Code, Feet+Frames, or Samples. 

Speed Displays the target time compression or 
expansion as a percentage of the original. Adjust 
the Time control or click the Speed field and 
type the desired value. Time can be changed 
from 25.00% to 400.00% of the original speed 
(or 4 to 1/4 times the original duration). The de-
fault setting is 100.00%, or no change. 25.00% 
results in 4 times the original duration and 
400.00% results in 1/4 of the original duration.

The Speed field only displays up to 2 decimal 
places, but lets you type in as many decimal 
places as you want (up to the IEEE standard). 
While the display rounds to 2 decimal places, 
the actual time shift is applied based on the 

Time Shift does not receive Bars|Beat and 
Feet+Frame information from Pro Tools 7.0 
or 7.1. Consequently, Bars|Beats and 
Feet+Frames are displayed as “N/A.”
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number you typed. This is especially useful for 
typing post production pull up and pull down 
factors (see “Post Production Pull Up and Pull 
Down Tasks” on page 110).

Formant

The Formant section of Time Shift lets you shift 
the formant shape of the selected audio inde-
pendently of the fundamental frequency. This is 
useful for achieving formant correct pitch shift-
ing. It can also be used as an effect. For example, 
you can formant shift a male vocal up by five 
semitones and it will take on the characteristics 
of a female voice.

The Formant section is only available when 
Monophonic is selected as the Audio Type. The 
Formant section provides a single control for 
transposing the formants of the selected audio 
by –24.00 semitones (–2 octaves) to +24.00 semi-
tones (+2 octaves), with fine resolution in cents. 
Adjust the Formant Shift control or click the 
Shift field and type the desired value.

Time Shift plug-in, Formant section
DigiRack Plug-ins Guide
Transient

The Transient section is only available when 
Polyphonic or Rhythmic is selected as the Audio 
Type, and provides slightly different controls for 
each. 

When Polyphonic is selected as the Audio Type, 
the Transient section provides controls for set-
ting the transient detection threshold and for 
adjusting the analysis window length for pro-
cessing audio.

Audio with a fundamental pitch has an 
overtone series, or set of higher harmonics. 
The strength of these higher harmonics cre-
ates a formant shape, which is apparent if 
viewed using a spectrum analyzer. The over-
tone series, or harmonics, have the same 
spacing related to the pitch and have the 
same general shape regardless of what the 
fundamental pitch is. It is this formant 
shape that gives the audio its overall char-
acteristic sound or timbre. When pitch 
shifting audio, the formant shape is shifted 
with the rest of the material, which can re-
sult in an unnatural sound. Keeping this 
shape constant is critical to formant correct 
pitch shifting and achieving a natural 
sounding result.

Time Shift plug-in, Transient section with Polyphonic 
selected as the Audio Type



When Rhythmic is selected as the Audio Type, 
the Transient section provides controls for set-
ting the transient detection threshold, and for 
adjusting the decay rate of the transients in the 
processed audio when time stretching.

Follow Enables an envelope follower that simu-
lates the original acoustics of the audio being 
stretched. Click the Follow button to enable or 
disable envelope following. Follow is only avail-
able when Polyphonic is selected as the Audio 
Type.

Threshold Sets the transient detection threshold 
from 0.0 dB to –40.0 dB. Disable transient detec-
tion by setting the Threshold control to Off 
(turn the knob all the way to the right). Part of 
Time Shift’s processing relies upon separating 
“transient” parts of the selection from “non-
transient” parts. Transient material tends to 
change its content quickly in time, as opposed 
to parts of the sound which are more sustained. 
Adjust the Threshold control or click the 
Threshold field and type the desired value. 

The default value for Threshold is –6.0 dB. For 
highly percussive material, lower the threshold 
for better transient detection, especially with 
the Rhythmic audio setting. For less percussive 
material, and for shifting with the Polyphonic 
audio setting, a higher setting can yield better 
results. Experiment with this control, especially 
when shifting drums and percussive tracks, to 
achieve the best results.

Time Shift plug-in, Transient section with Rhythmic 
selected as the Audio Type
Window Sets the analysis window length for pro-
cessing audio. You can set the Window from 6.0 
milliseconds to 185.0 milliseconds. Adjust the 
Window control or click the Window field and 
type the desired value. The Window control is 
only available when Polyphonic is selected as 
the Audio Type.

The default for Window size is 18.0 milliseconds 
and works well for many applications, but you 
may want to try different Window settings to 
get the best results. Try larger window sizes for 
low frequency sounds or sounds that do not 
have many transients. Try smaller window sizes 
for drums and percussion. 37.0 milliseconds 
tends to work well for polyphonic instruments 
such as piano or guitar. A setting as large as 71.0 
milliseconds works well for bass guitar. Settings 
in the 12 millisecond range work well on drums 
or percussion.

Decay Rate Determines how much of the decay 
from a transient is heard in the processed audio 
when time stretching. When time stretching us-
ing the Rhythmic setting, the resulting gaps be-
tween the transients are filled in with audio, and 
Decay Rate determines how much of this audio 
is heard by applying a fade out rate. Decay Rate 
is only available when Rhythmic is selected as 
the Audio Type. Adjust the Decay Rate up to 
100% to hear the audio that is filling the gaps 
created by the time stretching with only a slight 
fade, or adjust down to 1.0% to completely fade 
out between the original transients.
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Pitch

The Pitch section provides controls for pitch 
shifting the selected audio. Use the Pitch control 
to transpose the pitch from –24.00 semitones 
(–2 octaves) to +24.00 semitones (+2 octaves), 
with fine resolution in cents.

Transpose Displays the transposition amount in 
semitones. You can transpose pitch from –24.00 
semitones (–2 octaves) to +24.00 semitones (+2 
octaves), with fine resolution in cents. Adjust 
the Pitch control or click the Transpose field and 
type the desired value.

Time Shift plug-in, Pitch section

Table 8. Most commonly used TCE settings in Post workflo
DigiRack Plug-ins Guide
Shift Displays the pitch shift amount as a per-
centage. You can pitch shift from 25.00% (–2 oc-
taves) to +400.00% (+2 octaves). Adjust the 
Pitch control or click the Shift field and type the 
desired value. The default value is 100% (no 
pitch shift).

Post Production Pull Up and Pull 
Down Tasks

Table 8 on page 110 provides information on 
TCE settings for common post production tasks. 
Type the corresponding TCE% (represented to 
10 decimal places in Table 8) in the Time Shift 
field for the corresponding post production task 
and the process the selected audio.

Use the corresponding Time Shift Plug-in 
Setting for the desired post production task.

ws
Post workflow plug-in setting TCE% (to 10 decimal places) Frames

Pal to Film –4%.tfx 96.0% 25 to 24/30

PAL to NTSC –4.1%.tfx 95.9040959041% 25 to 23.976/29.97 

Film to PAL +4.1667%.tfx +104.1666666667% 24/30 to 25

Film to NTSC –0.1%.tfx 99.9000999001% 24/30 to 23.976/29.97

NTSC to Pal +4.2667%.tfx +104.2708333333% 23.976/29.97 to 25

NTSC to Film +0.1%.tfx +100.10% 23.976/29.97 to 24/30



AudioSuite Input Modes

Time Shift supports the Pro Tools 
AudioSuite Input Mode selector for use on 
mono or multi-input processing.

Mono Mode Processes each audio region as a 
mono file with no phase coherency maintained 
with any other simultaneously selected regions.

Multi-Input Mode Processes up to 48 input chan-
nels and maintains phase coherency within 
those selected channels.

AudioSuite Preview

Time Shift supports Pro Tools AudioSuite Pre-
view and Bypass. For more information on using 
AudioSuite Preview and Bypass, see the DigiRack 
Plug-ins Guide.

AudioSuite Input mode selector

AudioSuite Preview and Bypass are un-
available with Time Shift in Pro Tools 7.0 
and 7.1.
AudioSuite TCE Plug-in Preference

The Time Shift plug-in’s high quality time com-
pression and expansion algorithms that can be 
used with the Pro Tools TCE Trim tool.

To select Time Shift for use with the TCE Trim tool:

1  Choose Setup > Preferences.

2  Click the Processing tab.

3  From the TC/E Plug-in pop-up menu, select 
Time Shift.

4  Select the desired preset setting from the De-
fault Settings pop-up menu.

5  Click OK.

TCE Plug-in option in Processing Preferences page

Time Shift is not available with the TCE 
Trim tool in Pro Tools 7.0 and 7.1.

Refer to the Pro Tools Reference Guide for 
more information about the TCE Trim tool.
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Processing Audio

Time Shift lets you change the time and pitch of 
selected audio independently or concurrently. 

To change the time of a selected audio region:

1  Select AudioSuite > Pitch Shift > Time Shift.

2  Select the Audio Mode appropriate to the type 
of material you are processing (Monophonic, 
Polyphonic, or Rhythmic).

3  In Monophonic or Polyphonic mode, select 
the appropriate Range for the selected material 
(Low, Mid, High, or Wide).

4  If compressing the duration of the selection, 
attenuate the Gain control as necessary.

5  If using Monophonic mode, adjust the For-
mant Shift control as desired.

6  If using Polyphonic or Rhythmic mode, adjust 
the Transient controls as desired.

7  Make sure Pitch Shift is set to 100% (unless 
you also want to change the pitch of the selec-
tion).

8  Adjust the Time Shift control to the desired 
amount of time change. Time change is mea-
sured in terms of the target duration using the 
selected timebase or as a percentage of the orig-
inal.

9  Click Process.

Normalizing a selection before using Time 
Shift may produce better results.
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To change the pitch of a selected audio region:

1  Select AudioSuite > Pitch Shift > Time Shift.

2  Select the Audio Mode appropriate to the type 
of material you are processing (Monophonic, 
Polyphonic, or Rhythmic).

3  In Monophonic or Polyphonic mode, select 
the appropriate Range for the selected material 
(Low, Mid, High, or Wide).

4  If transposing the pitch of the selection up, at-
tenuate the Gain control as necessary.

5  If using Monophonic mode, adjust the For-
mant Shift control as desired.

6  If using Polyphonic or Rhythmic mode, adjust 
the Transient controls as desired.

7  Make sure Time Shift is set to 0% (unless you 
also want to change the duration of the section).

8  Adjust the Pitch Shift control to the desired 
amount of pitch change. Pitch change is mea-
sured in semitones (and cents) or as a percentage 
of the original.

9  Click Process.

To change the time and pitch of a selected audio 
region:

1  Select AudioSuite > Pitch Shift > Time Shift.

2  Select Varispeed from the Audio Mode pop-up 
menu.

3  Adjust either the Time Shift or Pitch Shift con-
trol to match the desired amount of time and 
pitch change in terms of a percentage of the 
original.

4  Click Process.

Using the Monophonic, Polyphonic, or 
Rhythmic modes, you can adjust both the 
Time Shift and Pitch Shift controls indepen-
dently before processing.



chapter 8

Elastic Audio Plug-ins
Elastic Audio Plug-in 
Parameters
Pro Tools provides several TCE algorithms for 
real-time and rendered track-based Elastic Audio 
processing. The selected Elastic Audio plug-in 
determines how the audio is processed. Each 
plug-in uses different algorithms for Elastic Au-
dio processing. Different algorithms are better 
suited to different types of audio. Select the 
plug-in whose algorithm is appropriate to the 
material on the track you want to process.

Elastic Audio plug-ins have their own unique se-
lector that is only available in the Edit window. 
You cannot insert Elastic Audio plug-ins on 
track Plug-in Inserts (TDM, RTAS, and hardware 
inserts).

Elastic Audio plug-ins provide few to no adjust-
able parameters. The adjustable controls, if any, 
for Elastic Audio plug-ins are available in the 
Elastic Audio Plug-in window. Elastic Audio 
plug-in parameters cannot be automated.
To open an Elastic Audio Plug-in window:

� Click the Elastic Audio Plug-in button.

Elastic Audio Plug-in Window 
Controls

The Elastic Audio Plug-in window provides a set 
of controls in the window header that are com-
mon to all Elastic Audio plug-ins.

Elastic Audio plug-in button

Elastic Audio Plug-in controls

Elastic Audio
Plug-in button

Settings menu

Track selector

Librarian menu
Target 
button

Clip 
LED

Plug-in selector

Real-Time or 
Rendered
Processing
indicator

Next and Previous Settings buttons

Compare button
Plug-ins Settings Select button
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Track Selector Accesses any other audio track in 
the session.

Plug-in Selector Lets you select any Elastic Audio 
plug-in or disable Elastic Audio.

Real-Time or Rendered Processing 
Indicator Lights when Elastic Audio processing is 
real-time and dims when Elastic Audio process-
ing is rendered (see “Real-Time and Rendered 
Elastic Audio Processing” on page 120).

Clip LED Lights red to indicate clipping in the 
Elastic Audio processing. Clipping can occur 
when time compressing audio. If clipping oc-
curs, you can lower the Input Gain in the Elastic 
Properties window (see “Input Gain” on 
page 124), or attenuate the Default Input Gain 
in the Processing Preferences page (see “Elastic 
Audio Preferences” on page 125). 

You can also undo any Elastic Audio processing 
and apply an appropriate amount of AudioSuite 
Gain reduction, and then try the Elastic Audio 
processing again. The Clip LED only functions 
for Real-Time Elastic Audio processing; it does 
not function for Rendered Elastic Audio process-
ing.

Settings Menu Lets you copy, paste, save, and 
import plug-in settings.

Librarian Menu Recalls settings files saved in the 
plug-in’s root settings folder or in the current 
session’s Settings folder.

For Rendered Elastic Audio processing, clip-
ping is indicated by the appearance of the 
Elastic Audio Processing Clip indicator on 
the region. 
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Next (+) and Previous (–) Setting Buttons Let 
you select the next or previous plug-in setting 
from the Librarian menu.

Plug-ins Settings Select Button Accesses the 
Plug-in Settings dialog, which lists the settings 
files for the current plug-in. From this list, you 
can select a new setting, or audition a series of 
settings.

Compare Toggles between the original saved 
plug-in setting and any changes you have made 
to it so you can compare them.

Target Button When multiple Elastic Audio 
Plug-in windows are open, clicking this button 
selects that plug-in as the target for any com-
puter keyboard commands. Deselecting the Tar-
get button lets you open another targeted Elastic 
Audio Plug-in window.

Polyphonic

The Polyphonic plug-in is the default plug-in for 
previewing and importing. It is a general, all-
purpose algorithm that is effective with a wide 
range of material. For complex loops and multi-
instrument mixes, use the Polyphonic plug-in. 

You will lose the current settings if they are 
not saved before you use the Next and Pre-
vious Setting buttons. Always save your set-
tings to the Librarian menu.

Elastic Audio plug-in: Polyphonic



Follow

Selecting the Follow option enables an envelope 
follower that simulates the original acoustics of 
the audio being stretched. The Follow button 
highlights when the Follow option is selected.

Window

The Polyphonic plug-in provides a single con-
trol for adjusting the analysis window length for 
TCE processing. Experiment with adjusting the 
Window size for different types of material until 
you achieve the best results. The following table 
provides some recommended Window sizes for 
different types of material.

Type of material
Recommended 
Window size

General purpose 30–40 ms

Percussive 20 ms or lower

Pads and other legato 
material

60 ms or higher

If you frequently work with distinct types of 
material, you may want to find the best 
Window settings for each type of material 
and save them as Plug-in Settings for quick 
and easy recall.
Rhythmic

The Rhythmic plug-in is best suited to material 
with clear attack transients, such as drums. 

Decay Rate

The Decay Rate control determines how much 
of the decay from a transient is heard in the pro-
cessed audio when time stretching. When the 
Rhythmic plug-in is selected, any gaps between 
transients resulting from time stretching are 
filled in with audio. The Decay Rate determines 
how much of this audio is heard by applying a 
fade out rate. Adjust the Decay Rate up to 100% 
to hear the audio that is filling the gaps created 
by the time stretching with only a slight fade, or 
adjust down to 1.0% to completely fade out be-
tween the original transients.

Elastic Audio plug-in: Rhythmic
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Monophonic

The Monophonic plug-in is best suited to 
monophonic material where you want to keep 
the formant relationships intact, such as with 
vocals. The Monophonic plug-in is also well 
suited to monophonic instrumental lines, such 
as a bass track. The Monophonic plug-in pro-
vides no plug-in specific parameters.

Elastic Audio plug-in: Monophonic

The Monophonic plug-in analyzes pitch as 
well as peak transients in order to provide 
higher quality TCE to pitched material. 
Consequently, analysis for the Monophonic 
algorithm takes longer than for the Poly-
phonic, Rhythmic, and Varispeed algo-
rithms. Also, when switching from another 
Elastic Audio plug-in to Monophonic, 
Pro Tools reanalyzes any audio on the track 
to collect the extra analysis data.
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Varispeed

Use the Varispeed plug-in to link time and pitch 
change for tape-like pitch and speed change ef-
fects, and post production workflows. The 
Varispeed plug-in provides no plug-in specific 
controls.

X-Form
(Rendered Only)

The X-Form Elastic Audio plug-in is a modified 
version of Digidesign’s standalone X-Form 
AudioSuite processing plug-in. The X-Form Elas-
tic Audio plug-in is for Rendered Elastic Audio 
processing only and cannot process in real-time 
or as an AudioSuite plug-in. It provides the 
highest quality time compression algorithms for 
music production, sound design, and audio 
loop applications.

Elastic Audio plug-in: Varispeed

Try using Varispeed with Quantize on drum 
loops for some interesting effects.

Elastic Audio plug-in: X-Form



Quality

Select either Maximum or Low (Faster) from the 
Quality pop-up menu. Maximum is the slowest 
processing algorithm, but provides the highest 
quality results. Low (Faster) produces relatively 
good results and is much faster than the Maxi-
mum setting.

Formant

For audio material with clear formants, enable 
Formant to preserve the formant shape of audio 
when applying TCE processing.

Audio with a fundamental pitch has an 
overtone series, or set of higher harmonics. 
The strength of these higher harmonics cre-
ates a formant shape, which is apparent if 
viewed using a spectrum analyzer. The over-
tone series, or harmonics, have the same 
spacing related to the pitch and have the 
same general shape regardless of what the 
fundamental pitch is. It is this formant 
shape that gives the audio its overall char-
acteristic sound or timbre. When pitch 
shifting audio, the formant shape is shifted 
with the rest of the material, which can re-
sult in an unnatural sound. Keeping this 
shape constant is critical to formant correct 
pitch shifting and achieving a natural 
sounding result.
Elastic Audio Tracks
Any audio track in your Pro Tools session can be 
Elastic Audio enabled. Elastic Audio tracks can 
be either sample- or tick-based. However, only 
tick-based Elastic Audio tracks automatically ap-
ply TCE based on tempo changes.

To enable Elastic Audio on a track:

1  Create a new audio track or use an existing au-
dio track.

2  From the track’s Elastic Audio Plug-in selector, 
select the Elastic Audio plug-in appropriate to 
your track material. 

Any audio regions on the track temporarily go 
offline while they are analyzed and come back 
online when the analysis is finished. The wave-
form for audio regions that are offline for Elastic 
Audio analysis appears grayed out.

When recording to a real-time Elastic Audio–en-
abled track, once recording is stopped, the 
newly recorded audio temporarily goes offline 
while it is analyzed and comes back online as 
soon as the analysis is finished.

For complete information on working with 
Elastic Audio, see the Pro Tools Reference 
Guide.

Elastic Audio Plug-in Selector pop-up menu
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3  From the track’s Elastic Audio Plug-in pop-up 
menu, select Real-Time Processing or Rendered 
Processing for Real-Time or Rendered Elastic Au-
dio processing. 

To disable Elastic Audio on a track:

1  From the track’s Elastic Audio Plug-in selector, 
select None – Disable Elastic Audio.

2  If the track had any Elastic Audio-based pro-
cessing, you are prompted to Cancel, Revert, or 
Commit.

Cancel Leaves Elastic Audio enabled on the 
track.

Revert Removes any Elastic Audio processing, 
reverts regions on the track to their original du-
ration, and disables Elastic Audio on the track.

Commit Renders and commits any Elastic Audio 
processing on the track, writes new files to disk, 
and disables Elastic Audio on the track.

Elastic Audio processing can be Real-Time 
or Rendered. Real-Time Elastic Audio pro-
cessing is immediate, but it is more de-
manding of system resources. Rendered 
Elastic Audio processing is non-real-time, 
but is less demanding of system resources. If 
you are working on a system with limited re-
sources, use Rendered Elastic Audio process-
ing. For more information, see “Real-Time 
and Rendered Elastic Audio Processing” on 
page 120.

Commit Elastic Audio dialog
DigiRack Plug-ins Guide
Committed Regions

Regions that are committed, either by disabling 
Elastic Audio on a track or by moving a region to 
a track without Elastic Audio enabled, are writ-
ten to disk as new audio files. These new audio 
files include the audio in the region, plus any 
fades, and also an additional 5 seconds of audio 
before and after the region, if available. 

Alternate Playlists

Disabling Elastic Audio on a track affects all 
playlists on the track. All playlists on the track 
are committed or reverted depending on which 
option you choose.

Elastic Audio Track Controls

Audio tracks provide a new set of controls for 
Elastic Audio. 

Elastic Audio Plug-in Selector Selects the Elastic 
Audio plug-in for Elastic Audio processing. You 
can also use the Elastic Audio Plug-in selector to 
disable Elastic Audio processing, and to select ei-
ther Real-Time or Rendered processing (see 
“Real-Time and Rendered Elastic Audio Process-
ing” on page 120).

Elastic Audio Track controls

Elastic Audio
Plug-in selector

Elastic Audio
Plug-in button

Real-Time or 
Rendered
Processing
indicator



Elastic Audio Plug-in Button Displays the name 
of the selected Elastic Audio plug-in. Click the 
Elastic Audio Plug-in button to open the Elastic 
Audio Plug-in window (see “Elastic Audio Plug-
in Parameters” on page 113).

Real-Time or Rendered Processing 
Indicator Lights when Elastic Audio processing is 
Real-Time and dims when Elastic Audio process-
ing is Rendered (see “Real-Time and Rendered 
Elastic Audio Processing” on page 120).

Elastic Audio Analysis
When recording, pasting, moving, or importing 
un-analyzed audio to an Elastic Audio–enabled 
track, or when enabling Elastic Audio on an ex-
isting audio track, Pro Tools automatically ana-
lyzes the audio for transient events. In Wave-
form view, the waveform initially appears 
grayed out because regions go offline during 
Elastic Audio analysis. Once the analysis is com-
plete, the audio comes back online. Elastic Au-
dio analysis is file-based, which means that even 
if you are only working with a small region of a 
large file, the entire audio file is analyzed.

Elastic Audio analysis detects transient events in 
the audio file. These transient events are indi-
cated by Event markers. Event markers are dis-
played in both the Warp and Analysis track 
views. Elastic Audio analysis also calculates the 
native tempo of the analyzed audio file and its 
duration in bars and beats.

Elastic Audio analysis data (detected events, 
tempo, and duration in Bars:Beats) is stored 
with the file. In DigiBase browsers, analyzed au-
dio files are indicated by a check mark to the left 
of the file name, and these files display their du-
ration in Bars|Beats, their timebase as ticks, and 
their native tempo in BPM.
Tempo Detection

Elastic Audio analysis does its best to detect a 
regular tempo for all analyzed audio. Any audio 
containing regular periodic rhythm can be suc-
cessfully analyzed for tempo and duration in 
bars and beats. Analyzed files in which a tempo 
was detected are treated as tick-based files. Tick-
based files can be conformed to the session 
tempo for preview and import.

Analyzed files in which no tempo was detected 
are treated as sample-based files. If there is only 
a single transient in the file (such as with a sin-
gle snare hit), no tempo will be detected. Also, 
longer files that contain tempo changes or ru-
bato, or that do not contain regular periodic 
rhythmic patterns will probably not have a de-
tected tempo and will be treated as sample-
based files.

Event Confidence

Transient events are detected with a certain de-
gree of confidence. The level of confidence is 
based on the relative clarity of transients.

For example, a drum loop is likely to have clear, 
sharp transients. These will be detected with a 
high degree of confidence. However, a legato vi-
olin melody may not have clear, sharp tran-
sients, so transients will be detected with a lower 
degree of confidence. 
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Pro Tools is very aggressive with its transient de-
tection in order to detect every possible audio 
event. Consequently, it is possible to have erro-
neously detected events. These events will be 
analyzed with a low degree of confidence and 
can be filtered out by lowering the Event Sensi-
tivity in the Elastic Properties window. Filtering 
out any false transients can result in higher 
quality Elastic Audio processing. 

Conversely, for material with few clear tran-
sients, Elastic Audio analysis may not accurately 
detect audio events, and those detected may be 
detected with a low level of confidence. You can 
relocate or add Event markers where necessary 
in Analysis view. 

For example, a slow synth pad may not have 
clear transients and detected Event markers may 
be incorrectly located or may have not been de-
tected at all. In Analysis view, you can relocate, 
remove, and add Event markers as necessary 
(such as where the chord changes). Accurately 
locating Event markers yields better results 
when applying Elastic Audio processing.

Note that peak amplitude is not the most 
important measure for event confidence. 
The clarity of transients is measured in part 
by the spectral transition from one moment 
to the next. This tends to favor higher fre-
quency content in terms of event confidence. 
For example, changing the Event Sensitivity 
in the Elastic Properties window for a se-
lected drum loop results in the clearer tran-
sients of the higher frequency hi-hat hits 
having more event confidence than the less 
well defined transients of the lower fre-
quency kick drum hits even though kick 
drum hits have a higher peak amplitude.
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Real-Time and Rendered 
Elastic Audio Processing
Real-Time Elastic Audio processing means that 
any changes to Elastic Audio processing—
whether it be a tempo change or a manual TCE 
warp—take effect immediately. However, Real-
Time Elastic Audio processing can be very de-
manding on your system’s resources. Conse-
quently, you may want to use Rendered Elastic 
Audio processing in some cases. With Rendered 
Elastic Audio processing, when you make a 
change to Elastic Audio processing, any affected 
audio regions temporarily go offline, a new 
“rendered” audio file is generated and the af-
fected audio regions come back online.

When processing non-rhythmic audio (such 
as legato strings) with the Polyphonic plug-
in, reducing the number of Event markers 
often yields better sounding results. You can 
either manually remove Event markers in 
Analysis view or lower the Event Sensitivity 
setting in the Elastic Properties window for 
the region you want to process (see “Event 
Sensitivity” on page 124).

For information on editing in Analysis 
view, see the Pro Tools Reference Guide.

In Rendered mode, any change you make is 
rendered using the original source audio to 
avoid generational loss from multiple subse-
quent edits.



To set an Elastic Audio track to Real-Time or 
Rendered:

1  Click the track’s Elastic Audio Plug-in selector.

2  From the pop-up menu, select the desired 
Elastic Audio plug-in.

3  From the pop-up menu, select one of the fol-
lowing:

• Real-Time Processing

• Rendered Processing

Select Real-Time processing for tick-based 
Elastic Audio processing (such as tempo 
changes). Rendered audio processing can be 
useful for sample-based Elastic Audio pro-
cessing or if you need to save system re-
sources.

Elastic Audio Plug-in Selector pop-up menu

To toggle between Real-Time and Rendered 
Elastic Audio processing, Control-Start-
click (Windows) or Command-Control-
click (Mac) the Elastic Audio Plug-in but-
ton.
About Rendered Files

Pro Tools creates temporary files for Rendered 
Elastic Audio processing. These files are kept in a 
new, auto-created Rendered Files folder in the 
session folder. Once you commit Rendered Elas-
tic Audio processing to a track (by disabling 
Elastic Audio on a track and clicking Commit in 
the Commit Elastic Audio dialog), a new file is 
written to disk in the Audio Files folder, and the 
temporary rendered file from which it was cre-
ated is deleted from the Rendered Files folder.

Region Clip Indicator

(Rendered Processing Only)

Since Rendered Elastic Audio processing is not 
real-time, it does not report clipping due to Elas-
tic Audio processing in the Elastic Audio plug-in 
window. Instead, when clipping occurs due to 
Rendered Elastic Audio processing, the region 
displays an Elastic Audio Processing Clip indica-
tor just to the left of the Warp icon. To avoid 
clipping on playback, lower the Input Gain for 
the region in the Elastic Properties window (see 
“Elastic Properties Window” on page 122).

Elastic Audio Region Clip Indicator

Elastic Audio Region
Clip indicators

Warp icons
Chapter 8: Elastic Audio Plug-ins 121



122
Elastic Properties
Each region on an Elastic Audio–enabled track 
has specific Elastic Audio properties (such as 
tempo, meter, TCE factor, and Input Gain). 

The Elastic Properties window lets you view and 
change the properties for selected regions. For 
example, you can reduce the Input Gain for 
Elastic Audio processing to avoid clipping that 
can occur during processing.

From the Elastic Properties window, you can 
also filter Event markers for Elastic Audio re-
gions on tick-based tracks. Filtering Event mark-
ers can result in better quality Elastic Audio pro-
cessing of material with ambiguous transients.

To view the Elastic Properties for a region:

1  Select a region on an Elastic Audio–enabled 
track. The track can be either sample- or tick-
based.

2  Do one of the following:

• Choose Region > Elastic Properties. 

– or –

• Right-click the region and choose Elastic 
Properties from the pop-up menu.
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If the track is sample-based, a reduced set of 
Elastic Audio Properties are displayed.

Elastic Properties Window

The Elastic Properties window displays informa-
tion about Elastic Audio processing and analysis 
for one or more regions. You can also use the 
Elastic Properties window to adjust Elastic Audio 
processing and analysis data.

Region

The Region property displays the name of the 
region and indicates whether or not the region 
is on a tick or sample-based track. If more than 
one region is selected, the number of selected re-
gions is displayed. If regions on both tick and 
sample-based tracks are selected, only the re-
duced set of properties are displayed.

Elastic Properties, tick-based

Elastic Properties, sample-based



Source Length (Tick-Based Tracks Only)

The Source Length property displays the length 
of the region based on the source file in bars and 
beats. If the length of the source file was ana-
lyzed incorrectly, you can change it. 

To change the Source Length of a region:

1  Open the Elastic Properties window for the re-
gion.

2  Do one of the following:

• Type the correct bar, beat, and tick values 
in the Source Length field.

• If the duration was incorrectly analyzed as 
being half the duration of the source file, 
click the x2 button.

• If the duration was incorrectly analyzed as 
being twice the duration of the source file, 
click the 1/2 button.

Source Tempo (Tick-Based Tracks Only)

The Source Tempo property displays the average 
tempo of the source file, which is calculated 
based on the detected transient events and the 
length of the file. If the tempo of the source file 
was analyzed incorrectly, you can change it.

Changing the duration of a region on an 
Elastic Audio–enabled track using the TCE 
Trimmer tool updates the Source Length in 
the Elastic Properties window.
To change Source Tempo of a region:

1  Open the Elastic Properties window for the re-
gion.

2  Select the correct note value for the beat from 
the Tempo Resolution pop-up menu. For exam-
ple, if the source file is in 5/8, select 1/8 note.

3  Do one of the following:

• Type the tempo in the Source Tempo field.

• If the tempo was incorrectly analyzed as 
being half the tempo of the source file, 
click the x2 button.

• If the tempo was incorrectly analyzed as 
being twice the tempo of the source file, 
click the 1/2 button.

Meter (Tick-Based Only)

Elastic Audio analysis does not calculate meter 
and assumes all files are in 4/4. If you work with 
meters other than 4/4, use the Meter property to 
correctly identify the source meter.

To change Meter of a region:

1  Open the Elastic Properties window for the re-
gion.

2  Click in the Meter nominator field and type 
the correct number of beats per measure. For ex-
ample, if the region is in 3/4, type 3.

3  Click the Meter denominator field and type 
the correct note value. For example, if the meter 
is in 6/8, type 8.

Elastic Properties, selecting the Tempo Resolution
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TCE Factor

The TCE Factor property displays the percentage 
of change applied to the source file. On tick-
based tracks, this property is display only and 
cannot be edited. On sample-based tracks, you 
can change the TCE Factor to apply TCE to the 
region. The percentage of the TCE factor is al-
ways calculated in relation to the source file.

Event Sensitivity

The Event Sensitivity property lets you filter 
Event markers based on the analysis confidence 
level. The confidence level for any detected 
transient event is based, in part, on the clarity of 
the transient. For example, if the file is a drum 
loop, loud accented hits will be analyzed with a 
higher degree of confidence than a soft, unac-
cented hit. 

The Event Sensitivity acts like a threshold for 
showing only the transient events that were de-
tected with a high degree of confidence. In 
Warp or Analysis track views you will see the 
number of Event markers decrease or increase as 
you lower or raise the Event Sensitivity. 

Lowering the event sensitivity can help reduce 
the number of erroneously detected transients. 
In turn, this can result in better sounding Elastic 
Audio processing. Pro Tools preserves the de-
tected transients when applying TCE in order 
avoid flamming and granulation of the tran-
sients. Consequently, false transients are also 
preserved and the resulting sound quality can be 
less than desirable. If you are working with au-
dio material that does not have clearly defined 
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transients, you may want to lower the Event 
Sensitivity in the Elastic Properties, or you may 
want to even edit the Event markers in Analysis 
view.

Input Gain

It is possible to encounter clipping when time 
compressing audio. Real-Time Elastic Audio 
plug-ins provide a Clip indicator to let you 
know when clipping has occurred. Rendered 
Elastic Audio regions display a Clip indicator on 
the region when clipping has occurred (see “Re-
gion Clip Indicator” on page 121).

If you encounter clipping when processing Elas-
tic Audio, use the Input Gain property to atten-
uate the gain of the audio signal before it is pro-
cessed.

For REX files, Pro Tools converts the slices 
as Events with 100% confidence. Conse-
quently, setting the Event Sensitivity from 
99% to 1% does not filter out any events 
based on slices. However, if you set the 
Event Sensitivity to 0%, all markers are fil-
tered out regardless.



Elastic Audio Preferences
Pro Tools provides several preferences for Elastic 
Audio that determine which Elastic Audio plug-
in is used for preview and import, and whether 
or not new tracks are created with Elastic Audio 
enabled using the selected default plug-in.

Default Plug-in Lets you select any Real-Time 
Elastic Audio plug-in as the default plug-in for 
previewing and importing Elastic Audio. The se-
lected Default Elastic Audio plug-in is also used 
when new tracks are created with Elastic Audio 
enabled. The Elastic Audio Plug-in selector in 
DigiBase browsers inherits the selected Default 
Plug-in. Likewise, changing the selected plug-in 
in DigiBase browsers updates the selected De-
fault Plug-in in the Processing preferences.

Default Input Gain Lets you attenuate the signal 
input to Elastic Audio plug-ins by 0 to –6 dB for 
preview and import. If you experience clipping 
due to Elastic Audio processing during preview 
or after import, you may want to set the Default 
Input Gain to slightly attenuate the audio signal 
input for Elastic Audio processing. This prefer-
ence also applies to any audio imported to an 
Elastic Audio–enabled track.

If you commit any regions on a track (by dis-
abling Elastic Audio on the track) that were im-
ported with Input Gain, their region-based In 
put Gain is reset to 0.

Processing Preferences, Elastic Audio 
The Elastic Properties window inherits the De-
fault Input Gain preference. To apply further re-
gion-based Input Gain for Elastic Audio process-
ing, select the region and adjust the Input Gain 
setting in the Elastic Properties window (see 
“Elastic Properties Window” on page 122).

Enable Elastic Audio on New Tracks When se-
lected, new tracks are created with Elastic Audio 
enabled. The selected Default Plug-in is used.

If the Enable Elastic Audio on New Tracks 
option is selected, you may want to also se-
lect the New Tracks Default to Tick Time-
base option in the Editing Preferences page.
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chapter 9

Plug-in Settings
Using the Librarian
The Settings Librarian makes it easy to create 
your own library of plug-in settings. Using the 
Librarian and Settings pop-up menus, you can 
copy, paste, save, and import these settings from 
plug-in to plug-in, or from session to session.

Once you create and save settings files to disk 
(and tell Pro Tools where to find them by assign-
ing their root folder) they will appear in the Li-
brarian menu (and in the Plug-in Settings dia-
log).

Librarian menu

You can also use the Plug-in Settings dialog 
to select settings or audition them. See 
“Plug-in Settings Dialog” on page 130.
The Settings Menu

Use the Settings menu commands to save, copy, 
paste, and manage plug-in settings files.

Settings menu commands include:

Save Settings Saves the current settings. This 
command overwrites any previous version of 
the settings. The setting then appears in the Li-
brarian menu.

Save Settings As Saves the current settings un-
der a different name.

Copy Settings Copies the current settings. You 
can then apply these settings to the same type of 
plug-in on a different track by choosing the 
track in the Plug-in window and pasting the set-
tings with the Paste Settings command.

Settings menu
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Paste Settings Pastes settings copied with the 
Copy Settings command.

Import Settings Imports a settings file from a lo-
cation other than the Root Settings folder or Ses-
sion folder. 

Delete Current Settings File Permanently deletes 
the current settings file from disk.

Lock Settings File Prevents the current settings 
from being overwritten by the Save command. If 
you attempt to save control settings, you will be 
required to save them using a different name or 
disk location.

Set As User Default Defines the current settings 
as the User Default for a specific plug-in.

Settings Preferences

The Settings Preferences sub-menus are for 
choosing preferences for saving and importing 
plug-in settings. They include:

Set Plug-in Default To Sets the default setting to 
either Factory Default (the standard default set-
ting for that plug-in) or User Default (your cus-
tom setting you specify with the Set As User De-
fault command).

Save Plug-in Settings To Selects the folder where 
plug-in settings are saved. If you choose Session 
Folder, the settings are saved in a folder named 
“Plug-in Settings” within the current Session 
folder. If you choose Root Settings Folder, the 
settings are saved in the folder you specified 
with the Set Root Settings Folder command (see 
below).

Set Root Settings Folder Selects a location or 
root folder for saving and importing settings. 
This root settings folder must be named “Plug-in 
Settings.” Use this command only if you want to 
choose a location other than the default Plug-in 
Settings folder.
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The default location for the Root Plug-in Set-
tings folder is as follows:

Windows Program Files\Common Files\
Digidesign\DAE\Plug-in Settings

Mac Library/Application Support/
Digidesign/Plug-in Settings 

Choosing a Destination for 
Settings

Before you save plug-in settings, select their des-
tination folder.

To select a destination folder: 

� From the Settings pop-up menu, choose Set-
tings Preferences > Save Plug-in Settings To, and 
choose Session Folder or Root Settings Folder.

If you choose Root Settings folder, Pro Tools 
saves settings to the default Root Plug-in Set-
tings folder unless you have specified a different 
location for the Root Settings folder.

To select a different Root Settings folder:

1  From the Settings pop-up menu, choose Set-
tings Preferences > Set Root Settings Folder.

2  Select the folder you want to use as your Root 
folder and click Select. 

To save plug-in settings to any location 
other than the default Plug-in Settings 
folder, you must first create a folder named 
“Plug-in Settings” in the new location and 
then save to that folder.



Managing Settings

Use the Settings pop-up menu to manage set-
tings.

To save a setting: 

1  Choose Save Settings from the Settings pop-up 
menu.

2  Type a name and click OK. The setting appears 
in the Librarian menu.

To load a previously saved setting:

� Choose the setting from the Librarian pop-up 
menu.

To import a setting: 

1  Choose Import Settings from the Settings pop-
up menu.

2  Locate the settings file you want to import 
and click Open. Pro Tools loads the setting and 
copies it to the root destination folder.

To copy a setting: 

� Choose Copy Settings from the Settings pop-
up menu.

Unlinked multi-mono plug-ins have specific 
rules for settings. See “Editing Settings on 
Unlinked Multi-Mono Plug-ins” on 
page 130.

Press Control+Shift+S (Windows) or Com-
mand+Shift+S (Mac) to save plug-in set-
tings.

Press Control+Shift+C (Windows) or Com-
mand+Shift+C (Mac) to copy plug-in set-
tings.
To paste a setting: 

1  Open the source plug-in.

2  Choose Copy Settings from the Settings pop-
up menu.

3  Open the destination plug-in.

4  Choose Paste Settings from the Settings pop-
up menu.

To create a custom User Default setting: 

1  Create and save a setting.

2  Choose Set As User Default from the Settings 
pop-up menu. 

To make a plug-in default to your custom setting: 

� From the Settings pop-up menu, choose Set-
tings Preferences > Set Plug-in Default To > User 
Setting.

Creating Subfolders for Settings

To make it easier to find specific types of set-
tings, you can subdivide settings files by creat-
ing subfolders for them.

Press Control+Shift+V (Windows) or Com-
mand+Shift+V (Mac) to paste plug-in set-
tings.

Librarian menu with subfolders for settings
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To create a settings subfolder:

1  From the Settings pop-up menu, choose Save 
Settings.

2  Click the New Folder button and type a name 
for the subfolder.

3  Name the setting and click Save. The setting is 
saved within the subfolder. 

Changing Settings with the 
Next (+) and Previous (–) Settings 
Buttons

The Next (+) and Previous (–) Settings buttons 
let you select the next or previous setting of the 
Librarian menu.

To change plug-in settings using the Next (+) and 
Previous (–) Settings buttons:

� Press the Plus (+) or Minus (–) buttons to select 
the next or previous plug-in settings file. The 
next (or previous) settings file are enabled, and 
the Librarian menu changes to reflect the new 
setting.

Editing Settings on Unlinked Multi-
Mono Plug-ins

When a multi-mono plug-in is unlinked, im-
porting, copying, pasting, or bypassing settings 
affects only the currently selected channel.

To apply an operation to all channels of an 
unlinked plug-in:

� Hold down the Alt key (Windows) or Option 
key (Mac) while performing the command.
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Plug-in Settings Dialog
The Plug-in Settings dialog lists the settings files 
for the current plug-in type. From this list, you 
can select a new setting, or audition a series of 
settings. Auditioning plug-in settings is espe-
cially useful for selecting patch names for virtual 
MIDI instrument plug-ins or trying out different 
effects types applied to your audio. 

The Plug-in Settings dialog includes the follow-
ing:

Folder This pop-up menu lets you switch be-
tween session settings located in root or session 
folders (and any available subfolders)

Patch Field This field displays the name of the 
active (highlighted) setting.

Increment Patch Every X Sec This option lets 
you audition contiguous plug-in settings on-
the-fly by automatically scrolling through them 
for a specified number of seconds.

Plug-in Settings dialog



To change plug-in settings using the Plug-in 
Settings dialog:

1  Click the Settings Select button.

2  Do one of the following:

• From the dialog list, select the desired plug-
in setting.

– or –

• Use the Arrow keys to scroll through the 
available settings. 

3  Click Done.

Auditioning Plug-in Settings

When the Plug-in Settings dialog is open, you 
can have Pro Tools automatically scroll through 
and audition the settings files saved in the plug-
in’s root settings folder or in the current ses-
sion’s Settings folder.

Plug-in header settings

To switch between settings folders, press 
Control (Windows) or Command (Mac) 
and use the Up/Down Arrow keys.

Settings 
Select
To audition plug-in settings:

1  Click the Settings Select button.

2  From the Settings dialog, click a setting—the 
starting point from which you will scroll 
through the settings files.

3  Enter a value for the number of seconds that 
will elapse between each program change, and 
press Enter.

4  Select the option for Increment Patch.

After the specified number of seconds, Pro Tools 
selects the next setting. 

5  When you are finished auditioning settings, 
do one of the following:

• Click Done to stop incrementing patches, 
and to close the Plug-in Settings dialog.

– or –

• Select the Increment Patch option to stop 
incrementing patches and keep the Plug-in 
Settings dialog open.
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DigiBase and Plug-in Settings 
Files
DigiBase browsers recognize plug-ins settings 
files (.txf) as a known Type and lets you drag and 
drop them to Pro Tools plug-in windows and In-
serts. You can also search for plug-in settings by 
type.

Searching for Plug-in Settings Files

To search for plug-in settings files:

1  In the Workspace browser, click the Search 
icon.

2  Select Plug-in Settings File from the Type pop-
up menu.

3  To further narrow your search, type all or part 
of the name of the plug-in settings file you want.

4  Click Search.

Searching for plug-in settings files
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5  To sort your search by Plug-in Name or Man-
ufacturer, click the corresponding column title.

Plug-in settings files found in the Workspace browser 
and sorted by Plug-in Name

With DigiBase Pro (Pro Tools HD and LE 
with DV Toolkit 2 only), you can create cat-
alogs of specific plug-in settings that you 
work with frequently to streamline your 
workflow. For more information on Digi-
Base Pro and Catalogs, see the Pro Tools 
Reference Guide.



Dragging and Dropping Plug-in Settings Files

You can insert a plug-in with a specific plug-in 
settings file, as well as change plug-in settings of 
inserted plug-ins by dragging and dropping 
plug-in settings files from a DigiBase browser, 
Windows Explorer, or the Mac Finder.

To insert a plug-in by drag and drop:

� Drag and drop a plug-in settings file from a 
DigiBase browser, Windows Explorer, or the Mac 
Finder to an Insert in the Mix (or Edit) window.

Dragging and dropping a plug-in settings file to an Insert
To change plug-in settings by drag and drop:

� Drag and drop a plug-in settings file from a 
DigiBase browser, Windows Explorer, or the Mac 
Finder to the plug-in window. The plug-in set-
tings file must be for the same plug-in name. For 
example, you cannot replace a 1-Band EQ 3 with 
a plug-in setting for 4-Band EQ 3.

Dragging and dropping a plug-in settings file to a plug-in
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chapter 10

Using ReWire with Pro Tools
Pro Tools supports ReWire version 2.0 technol-
ogy developed by Propellerheads Software. Re-
Wire is available using the DigiRack RTAS plug-
in.

ReWire provides real-time audio and MIDI 
streaming between applications, with sample-
accurate synchronization and common trans-
port functionality.

Using ReWire, Pro Tools can send and receive 
MIDI to and from a ReWire client application, 
such as a software synthesizer, and receive audio 
back from the ReWire client. Pro Tools applies 
MIDI time stamping to all incoming MIDI. For a 
diagram of audio and MIDI signal flow with Re-
Wire, see Figure 1 on page 136.

ReWire RTAS plug-in

Pro Tools does not support sending audio to 
ReWire client applications.
Compatible ReWire client applications are auto-
matically detected by Pro Tools and are avail-
able in the RTAS Plug-ins Insert menus in 
Pro Tools. Selecting a ReWire client application 
within Pro Tools automatically launches that 
application (if the client application supports 
this feature). Any corresponding MIDI nodes for 
that application are available in any Instrument 
track’s MIDI Output selector (Instrument view) 
and any MIDI track’s Output selector.

Once the outputs of your software synthesizers 
and samplers are routed to Pro Tools, you can:

• Process incoming audio signals with plug-
ins

• Automate volume, pan, and plug-in con-
trols

• Bounce To Disk

• Take advantage of the audio outputs of 
your Digidesign audio interfaces

Not all ReWire client applications support 
automatic launch from a ReWire-mixer ap-
plication. For these applications, launch the 
ReWire client application separately, and 
then select it as a plug-in insert in 
Pro Tools.

Exchange of additional metadata such as 
controller and note names between 
Pro Tools and ReWire clients is not sup-
ported.
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Figure 1.  Audio and MIDI signal flow between Pro Tools and a ReWire client application (Reason shown)

Audio from ReWire client (Reason) to Pro  Tools

MIDI from Pro  Tools to ReWire client (Reason)

MIDI from ReWire client (Reason) to Pro  Tools



ReWire Requirements
To use the ReWire plug-in, you will need: 

• A Digidesign-qualified Pro Tools system

• ReWire-compatible client software (such as 
Reason from Propellerheads Software)

ReWire support is also under development for 
other third-party companies. For availability, 
check with the manufacturer or visit the Digide-
sign website (www.digidesign.com).

ReWire and Track Count with 
Pro Tools HD

With Pro Tools HD, the ReWire RTAS plug-in 
can be inserted on any kind of track. Each chan-
nel of audio transmitted through ReWire then 
uses the same amount of resources as the audio 
track on which it is inserted. 

Consequently, you can only use a total combi-
nation of audio tracks and ReWire audio streams 
that does not exceed the maximum number of 
possible voices for your system. For example, if 
you are playing 40 audio tracks in a 48 kHz/24-
bit session on a 128-voice Pro Tools|HD 2 sys-
tem, that will leave 88 channels of audio (88 
mono, or 44 stereo) available for use with Re-
Wire. (However, ReWire only supports a maxi-
mum of 64 audio streams per application.)

Client software must support the same 
sample rate as the session using ReWire. 
For example, third-party client software 
that does not support sample rates beyond 
48 kHz cannot be used in 96 kHz Pro Tools 
sessions.
        

Using ReWire at higher sample rates will in-
crease the load on the CPU. For example, CPU 
load at 96 kHz is double the load at 48 kHz. You 
can monitor Pro Tools CPU usage in the System 
Usage window, making sure to not overtax your 
system.

 

ReWire and Track Count on 
Pro Tools LE Systems

 

With Pro Tools LE, performance is determined 
by several factors, including host CPU speed, 
available memory, and buffer settings. Digide-
sign cannot guarantee 64 simultaneous audio 
channel outputs with ReWire on all computer 
configurations.

For the latest information on recommended 
CPUs and system configurations, visit the 
Digidesign website (www.digidesign.com).

  

With Pro Tools HD, the standard Hardware 
Buffer size of 512 samples is strongly rec-
ommended for using ReWire in sessions 
with sample rates above 48 kHz.
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Using ReWire
The ReWire plug-in is installed when you install 
Pro Tools. All inter-application communica-
tions between Pro Tools and ReWire client soft-
ware is handled automatically. 

To use a ReWire client application with Pro Tools:

1  Make sure that the ReWire client application 
is installed properly and that you have restarted 
your computer.

2  In Pro Tools, choose Track > New and specify 
one Instrument track (or audio or Auxiliary In-
put track), and click Create.

3  In the Mix window, click the Insert selector on 
the track and assign the ReWire RTAS client 
plug-in to the track insert.

Inserting a ReWire client on a track (Reason shown)
DigiRack Plug-ins Guide
           

The ReWire client application launches auto-
matically in the background (if the client appli-
cations supports auto-launch). 

 

4  

 

Configure the ReWire client application to 
play the sounds you want.

 

5  

 

In Pro Tools, set the output of the client appli-
cation in the ReWire plug-in window. This is the 
audio output of the ReWire client to Pro Tools.

  

If the client application does not support 
auto-launch, launch it manually. Some Re-
Wire client applications may need to be 
launched and configured before launching 
Pro Tools (such as Cycling 74’s 
MAX/MSP). Others may need to be 
launched after Pro Tools is launched (such 
as Ableton Live). For more information, 
consult the manufacturer’s documentation 
for your ReWire client application.

 

Selecting the audio output from a ReWire client



6  In the Mix window, click the track’s MIDI Out-
put selector a and select the ReWire client appli-
cation. Some ReWire clients (such as Reason) 
may list multiple devices. If so, choose the de-
vice that you want. 

7  Choose Options > MIDI Thru and record en-
able the MIDI track. Play some notes on your 
MIDI controller to trigger the client application.

The selected ReWire device responds to MIDI 
sent from Pro Tools and plays back audio 
through the assigned Pro Tools track (Instru-
ment, Auxiliary Input, or audio track).

If your ReWire client application is a sequencer 
and you want to begin synchronized playback 
with Pro Tools, press the Spacebar or click the 
Play button on the Pro Tools Transport. 

Selecting the ReWire client device to receive MIDI from 
Pro Tools

If you experience system performance prob-
lems while using Pro Tools with ReWire cli-
ent applications, you may need to increase 
the Pro Tools CPU Usage Limit. See “CPU 
Usage Limit” on page 11 for instructions.
       

MIDI Automation with ReWire

 

You can use Pro Tools MIDI tracks to record 
MIDI continuous controller (CC) data from a 
ReWire client application, and then play back 
MIDI from Pro Tools to send the recorded MIDI 
CC data back to the ReWire client application. 
In this way, you can adjust parameters in the Re-
Wire client application (using the mouse or an 
external MIDI controller) and record those 
changes in Pro Tools. 

 

Recording MIDI Continuous Controller 
Data Over ReWire

 

The first step in automating a ReWire client ap-
plication’s parameters is to record the CC data 
to a MIDI track in Pro Tools.
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To record MIDI from a ReWire client application in 
Pro Tools:

1  In Pro Tools, create a new MIDI track.

2  From the track’s MIDI Input selector, select 
the ReWire device that you want to record.

3  Record enable the MIDI track.

4  Start recording in Pro Tools.

5  Switch to the ReWire client application.

Selecting the ReWire client device to record MIDI CC 
data in Pro Tools

You must select the ReWire device from 
which you want to record MIDI controller 
data. Leaving the track’s MIDI Input set to 
All does not record any MIDI data over Re-
Wire.
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6  

 

Adjust the parameter for which you want to 
record MIDI CC data. Parameter changes are re-
corded to the Pro Tools MIDI track as CC data.

 

7  

 

When you are done adjusting the parameter, 
return to Pro Tools and stop recording.

8  Record disable the MIDI track.

9  From the MIDI Track View selector in the Edit 
window, select the view for the CC data you just 
recorded.

Adjusting a parameter in a ReWire client application 
(Reason’s SubTractor shown)

If your external MIDI controller is correctly 
mapped to the corresponding ReWire client 
application’s parameters, and it is correctly 
routed through Pro Tools, use your MIDI 
controller to adjust the parameter you want 
to record.

MIDI CC data recorded from a ReWire client application



                 
Playing Back MIDI Continuous 
Controller Data Over ReWire

Once you have recorded MIDI CC data from the 
ReWire client application to a MIDI track, con-
figure the MIDI track to play the ReWire client 
application. You can also edit the MIDI CC data 
in Pro Tools until you achieve the best results.

To play back MIDI CC data over ReWire:

1  From the MIDI track’s MIDI Output selector, 
select the ReWire client application device you 
want to control (the same device from which 
you recorded the MIDI CC data).

2  Start playback in Pro Tools.

3  Switch to the ReWire client application. No-
tice that the corresponding parameter changes 
according the MIDI CC data from Pro Tools.

Quitting ReWire Client 
Applications
When quitting Pro Tools sessions that integrate 
ReWire client applications, quit the client appli-
cation first, then quit Pro Tools.

If you quit Pro Tools before quitting ReWire 
client applications, a warning dialog may 
appear stating that “one or more ReWire 
applications did not terminate.” To avoid 
this, quit all ReWire client applications be-
fore quitting Pro Tools. 
Tempo and Meter Changes
Pro Tools transmits both Tempo and Meter data 
to ReWire client applications, allowing ReWire-
compatible sequencers to follow any tempo and 
meter changes in a Pro Tools session. 

With the Pro Tools Conductor button selected, 
Pro Tools always acts as the Tempo master, us-
ing the tempo map defined in its Tempo Ruler.

With the Pro Tools Conductor button dese-
lected, the ReWire client acts as the Tempo mas-
ter. In both cases, playback can be started or 
stopped in either application.

Pro Tools supports tempo values from 
30–300 bpm. When slaved to a ReWire cli-
ent application, Pro Tools playback will be 
restricted to this range even if the client ap-
plication’s tempo is outside this range. Ad-
ditionally, some ReWire client applications 
(such as Reason) may misinterpret 
Pro Tools meter changes, resulting in mis-
matched locate points and other unexpected 
behavior. To prevent this, avoid using meter 
changes in Pro Tools when using Reason as 
a ReWire client.
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Looping Playback
Because Pro Tools does not offer separate loop 
markers as found in other third party applica-
tions such as Reason, if you want to loop play-
back, do one of the following:

To loop playback in Pro Tools:

1  In the Pro Tools Timeline, select the time 
range that you want to loop.

2  Begin playback by pressing the Spacebar or 
clicking the Transport’s Play button. 

To loop playback within a ReWire client sequencer

� With playback stopped, specify the loop 
within the ReWire client application and begin 
playback. 

If you create a playback loop by making a 
selection in the Pro Tools Timeline, once 
playback is started, any changes made to 
loop or playback markers within the Re-
Wire client application will deselect the 
Pro Tools Timeline selection and remove 
the loop.
DigiRack Plug-ins Guide
Automating ReWire Input 
Switching
ReWire supports automation for switching in-
puts during playback.

To automate switching inputs during playback:

1  Set the track’s automation to write.

2  Do one of the following:

• Change the input link pop-up menu man-
ually.

– or –

• Draw the automation in the Edit window.

For information on drawing automation, 
see the Pro Tools Reference Guide.
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DSP Requirements for TDM Plug-ins
The number of TDM plug-ins you can use at one 
time depends on how much DSP power is avail-
able in your system. Since the TDM hardware on 
Pro Tools cards provide dedicated DSP for plug-
ins, plug-in performance is not limited by CPU 
processing power.

The DSP tables on the following pages show the 
theoretical total number of instances of each Di-
giRack TDM plug-in that can be powered by a 
single DSP chip on Pro Tools|HD-series cards. 
DSP usage differs according to card type and DSP 
chip availability. 

DSP tables show the theoretical maximum 
performance when no other plug-ins or sys-
tem tasks (such as I/O) are sharing avail-
able DSP resources. You will typically use 
more than one type of plug-in simulta-
neously. The data in these tables are pro-
vided as guidelines to help you gauge the 
relative efficiency of different plug-ins on 
your system. They are not guaranteed per-
formance counts that you should expect to 
see in typical real-world sessions and usage. 
There are a total of nine DSP chips on a 
Pro Tools|HD card (HD Core, HD Process, and 
HD Accel). HD Core and HD Process cards pro-
vide identical chip sets. HD Accel cards provide 
newer, more powerful DSP chips (making the 
HD Accel card ideal for DSP-intensive plug-ins, 
and for high sample rate sessions).

Not all plug-ins are supported on all types of 
chips. The following tables indicate the number 
of compatible chips per card.

DSP Requirements
DSP requirements for DigiRack TDM plug-ins 
are provided on the following pages.
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Mono and Stereo DigiRack Plug-ins on HD Cards

The following table compares the maximum number of instances of each DigiRack TDM plug-in that 
can be powered by a single DSP chip on an HD Accel card to that of HD Core and HD Process cards. 
Maximum instances of real-time TDM plug-ins per DSP chi
DigiRack Plug-ins Guide
p for Pro Tools|HD cards at 44.1 and 48 kHz
Maximum instances are approximately half at 88.2 kHz and 96 kHz, and approximately a quarter at 
176.4 and 192 kHz. Actual results will likely be less due to system and session variables.

Plug-in
HD Accel HD Core and HD Process

mono/stereo mono/stereo

EQ III (1-band) 66 33 28 14

EQ III (2–4 band) 36 18 15 7

EQ III (7-band) 23 11 10 5

Click 18 n/a 3 n/a

Dither 46 43 34 18

D-Verb 6 6 4 4

Compressor/Limiter III 18 11 7 5

Expander/Gate III 16 11 7 5

De-Esser III 12 8 5 3

Mod Delay II (short) 74 36 43 21

Mod Delay II (slap) 73 36 32 16

Mod Delay II (medium) 36 18 16 8

Mod Delay II (long) 17 7 8 4

Mod Delay II (extra long) 4 2 2 1

Pitch 1 1 1 1

POW-r Dither 22 10 9 4

Signal Generator 48 n/a 25 n/a

PhaseScope (SignalTools) n/a 13 n/a 5

Time Adjuster (short) 146 72 117 58

Time Adjuster (medium) 32 16 114 56

Time Adjuster (long) 72 36 32 16

Trim 145 n/a 119 n/a



Multi-Mono and Multi-Channel DigiRack Plug-ins

Plug-ins used in multi-mono format on greater-than-stereo tracks require one mono instance per 
channel of the multi-channel audio format. A multi-mono EQ used on a 5.1 format track, for exam-
ple, requires six mono instances since there are six audio channels in the 5.1 format. Because multi-
channel versions of the Compressor II, Limiter II, and Expander/Gate II plug-ins are available for use 
on greater-than-stereo tracks, separate instance counts are given for those configurations.
Table 2.   Theoretical maximum instances of real-time TDM
 plug-ins per DSP chip for a Pro Tools HD Core and HD 

Process card at 48 kHz**

Plug-in LCR
Quad 

& 
LCRS

5.0 
5.1 & 
6.0

6.1 & 
7.0

7.1
DSP Chips per 

HD Card

DigiRack Pitch partial partial partial partial partial partial 9

D-Verb partial partial partial partial partial partial 9

Compressor/Limiter III 3 3 2 2 2 2 9

Expander/Gate III 3 3 2 2 2 2 9

De-Esser III

Mod Delay I (short) 14 11 8 7 6 5 9

Mod Delay I (slap) 10 8 6 5 4 4 9

Mod Delay I (medium) 5 4 3 2 2 2 9

Mod Delay I (long) partial partial partial partial partial partial 9

Mod Delay II (short) 14 11 8 7 6 5 9

Mod Delay II (slap) 10 8 6 5 4 4 9

Mod Delay II (medium) 5 4 3 2 2 2 9

Mod Delay II (long) 2 2 1 1 1 1 9

Mod Delay II (extra 
long)

partial partial partial partial partial partial 9

Dither 12 9 7 6 5 4 9

POW-r Dither 3 2 1 1 2 1 9

Time Adjuster (short) 30 22 18 15 13 11 9
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“Partial” indicates that a single instance of the multi-mono plug-in is sharing more than 1 DSP chip.

* Instance counts are provided for multi-mono versions of plug-ins that have no available multichannel ver-
sion.

** Maximum instances are approximately half at 88.2 kHz and 96 kHz, and approximately a quarter at 
176.4 and 192 kHz. Actual results will likely be less due to system and session variables.

Time Adjuster 
(medium)

30 22 18 15 13 11 9

Time Adjuster (long) 10 8 6 5 4 4 9

Trim* 39 29 23 19 16 14 9

Signal Generator* 8 6 5 4 3 3 9

SurroundScope 
(SignalTools)

4 3 2 2 1 1 9

Table 2. (Continued) Theoretical maximum instances of real-time TDM plug-ins per DSP chip for a Pro Tools HD Core 
and HD Process card at 48 kHz**

Plug-in LCR
Quad 

& 
LCRS

5.0 
5.1 & 
6.0

6.1 & 
7.0

7.1
DSP Chips per 

HD Card
Monitoring DSP Usage
DigiRack Plug-ins Guide
The System Usage window (Window > System Usage) shows approximately how much DSP is avail-
able in your system and how it is being used in the current Pro Tools session.
For more information about DSP usage and allocation, see the Pro Tools Reference Guide.
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DSP Delays Incurred by TDM Plug-ins
Virtually all TDM plug-ins incur some amount 
of signal delay.

If you are working with mono tracks, or are pro-
cessing all channels with the same plug-in, the 
signal delays are not long enough to be signifi-
cant and should not be a concern.

This signal delay is significant only if you use a 
plug-in on one channel of a stereo or multichan-
nel signal but not the others, since this can 
cause the channels to be slightly out of phase.

Table 3 shows the delays inherent in each type 
of Digidesign TDM plug-in.

Pro Tools|HD systems provide automatic 
Delay Compensation to compensate for sig-
nal processing delays. For detailed informa-
tion, see the Pro Tools Reference Guide.
≈

Table 3.  Samples of delay incurred by each real-time 
DigiRack TDM plug-in on HD cards

Plug-in
Samples of Delay on 
HD Cards

EQ III (1-band) 4

EQ III (2–4 band) 4

EQ III (7-band) 4

Compressor II 4

De-esser 4

DigiRack Pitch 3

D-Verb 3

Compressor/Limiter III 4

Expander/Gate III 92

De-Esser III 4

Limiter II 4

Gate II 4

Expander/Gate II 4

Mod Delay I/II (short) 4

Mod Delay I/II (slap) 4
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Mod Delay I/II 
(medium)

4

Mod Delay I/II (long) 4

Mod Delay II (extra 
long)

4

Dither 4

POW-r Dither 4

Time Adjuster 4

Signal Generator 4

SignalTools 
SurroundScope

4

SignalTools 
PhaseScope

4

Table 3. (Continued)Samples of delay incurred by each 
real-time DigiRack TDM plug-in on HD cards

Plug-in
Samples of Delay on 
HD Cards
DigiRack Plug-ins Guide



Numerics
7 Band, 2–4 Band, or 1 Band (EQ III) 43

A
Accuracy control 103, 105
adjusting plug-in parameters

computer keyboard 41
keyboard shortcuts 41
mouse 41
scroll wheel 42
toggling switches 42

Algorithm control 62
AudioSuite

buffer size 38
Input Mode selector 111
Invert 99
multichannel processing 35
plug-ins 2
Preview 111
processing 39
processing preferences 37, 111

AudioSuite plug-in selector 32
AudioSuite plug-ins

Chorus 95
DC Offset Removal 102
Delay 99
Duplicate 99
Flanger 96
Gain 101
Invert 99
Multi-Tap Delay 97
Normalize 100
Ping-Pong Delay 98
Pitch Shift 104
Reverse 101
Signal Generator 101
Time Compression/Expansion 102
using 39
AudioSuite processing on networked hard drives 
39

AudioSuite window 32
Audition pop-up menu 35
Auto button 18
automation

Auto Latch mode 26
Auto Touch mode 26
creating 26
plug-in 24
preferences 24
Safe button 18

Automation Safe button 18
Auxiliary Inputs

inserting RTAS plug-ins 27

B
BBC (metering) 86
bit resolution for Dither plug-in 59, 60
buffer size for AudioSuite processing 37
Bypass button 35

for real-time plug-ins 18

C
Category 6
Cents control 88
Chan/Track Process Mode 34
Channel selector 19
Chorus plug-in 95
Church algorithm 62
Click plug-in 58

Accented control 58
Unaccented control 58

Clip indicator
DigiRack Pitch 87
D-Verb 62

Clip LED 18
index
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clipping 18
closing multiple plug-in windows 20
Coarse & Fine controls 104
Compare button 18
compensating for DSP delays 147
Compressor/Limiter (AudioSuite) 94
computer keyboard

adjusting plug-in parameters 41
configuring AudioSuite Buffer 38
Convert Plug-in pop-up 18
Copy Settings command 127
copying a plug-in setting 129
CPU meter 10
CPU power requirements for RTAS plug-ins 10
CPU Usage Limit 10
Create Continuous File command 34
Create Individual Files command 33
creating a settings subfolder 130
Crossfade control 88, 103, 104
Cross-Feedback control 98

D
D2

adjusting parameters 64
DC Offset Removal plug-in 102
Decay control 63
De-Esser (AudioSuite) 94
Delay 6
delay

DSP induced 13, 91
Delay control 87, 95, 97
Delete Current Settings File command 128
destination fields 102
destination folder for plug-in settings 128
Diffusion control 63
DIN (metering) 86
Dither 6
Dither bit depth for AudioSuite 38
Dither plug-in 59, 60
DSP

and EQ III 54
DSP delay compensation 14, 90, 91
DSP delays 147
DSP delays inherent in plug-ins 147
Duplicate plug-in 99
DigiRack Plug-ins Guide
duplicating inserts 17
D-Verb 61
Dynamics 6
Dynamics II plug-ins 63
Dynamics III 94

AudioSuite 94

E
Effects 6
effects

recording with 15
Elastic Audio

analysis 119
Clip indicator (Rendered) 121
disabling 118
Elastic Audio–enabled tracks 117
enabling 117
event confidence 119
Monophonic plug-in 116
Plug-in window 113
Plug-in window controls 113
plug-ins 2, 113
Polyphonic plug-in 114
Real-Time processing 120
Region Clip indicator 121
Rendered processing 120
Rhythmic plug-in 115
TCE algorithms 113
tempo detection 119
track controls 118
Varispeed plug-in 116
X-Form plug-in 116

Entire Selection mode 34
EQ 6

EQ III 43
EQ II plug-ins 57, 93
EQ III 43

DSP management 54
Frequency Graph Display 45
gain (inverting) 44

Expander/Gate (AudioSuite) 94
external audio source, using for side-chain 23
External Key 23
external side-chain processing 22
Extra Long Delay plug-in 79



F
favorites 6
Feedback control 87, 95, 96, 97
File Mode selector 33
Fine control 88
Flanger plug-in 96
flattening a track 99
Frequency control 81
Frequency Graph display (EQ III) 45

G
Gain control 97
Gain plug-in 101

H
Hall algorithm 62
Hardware 6
Hardware Buffer Size 10
Harmonic 6
HD-series cards

DSP delays 147
Hi Frequency Cut control 63
High-Pass Filter control 96
host processing 2

I
Import Settings command 128
importing plug-in settings 129
Increment Patch 130
Input Level control 98
Input mode

Mono 111
Multi-Input 111

Insert Position selector 18
inserts 15

post-disk 15
pre-fader 15
pre-fader operation 15

Instrument 6
internal side-chain processing 22
Invert plug-in 99
inverting gain (EQ III) 44
K
key input 22

definition 22
Key Input selector 19
using for external side-chain

processing 23
Key Input selector 23, 36
Key Listen control 23
keyboard shortcuts 64

adjusting plug-in parameters 41

L
latency

and RTAS 10
Leq(A)

Auto Reset 85
Hold on Stop 85
Reset 85
Window 85

Leq(A) Meter 84
Level control 81
LFE Enable button 19
LFO Rate control 95, 96
LFO Waveform control 95, 96
LFO Width control 95, 96
Librarian menu 18
Link Enable buttons 19
linking plug-in controls 21
Lissajous Meter 83
Lock Settings File command 128
locked regions and AudioSuite processing 39
Long Delay plug-in 79
Low-Pass Filter control 63, 95

M
Manufacturer 6
Master Faders

inserting RTAS plug-ins 27
Master Link button 19
Max Peak At control 100
Maximum Pitch control 89
Medium Delay 79
metering

BBC 86
DIN 86
for VENUE 86
Index 151



152
Leq(A) 84
level meters 85
Lissajous in PhaseScope 83
multichannel SurroundScope 82
Nordic 86
Peak 86
Peak + RMS 86
peak hold options 86
Phase Meter 84
PhaseScope 83
reference mark 86
RMS 86
VU 86

MIDI Beat Clock 23, 80
MIDI Output selector 139
Minimum Pitch control 89, 103, 104
Mix control 95, 97
Mod Delay II

Tempo Sync 24
Mod Delay II plug-ins 79
Modulation 6
mono plug-ins 15
mouse

adjusting plug-in parameters 41
moving inserts 17
multi-channel plug-ins 16
multi-mono plug-ins 15
MultiShell II compatible plug-ins 10
Multi-Tap Delay plug-in 97
muted regions and AudioSuite processing 39

N
Noise Reduction 6
Noise Shaping 60
non-real-time plug-ins 31
Nordic (metering) 86
Normalize plug-in 100
Note control 105

O
opening multiple plug-in windows 20
ordering RTAS and TDM plug-ins 28
Other 6
Output Meter 61
Overwrite File command 33
DigiRack Plug-ins Guide
P
Pan control 97
Paste Settings command 128
pasting plug-in settings 129
Peak 86
Peak + RMS 86
peak hold 86
Peak On All Chans/Tracks mode 34
Peak On All Tracks mode 100
Peak On Each Chan/Track mode 34
Peak On Each Track mode 100
phase cancellation 91
Phase Invert button 19, 90
Phase Meter 84
PhaseScope 83
Ping-Pong Delay plug-in 98
pink noise 81
Pitch plug-in 87
Pitch Shift 6
Pitch Shift plug-in 104
Pitch transposition 87
Playlist command 32
plug-in controls

adjusting 64
linking 21

Plug-in Controls Default to Auto-Enabled 24
Plug-in selector

for AudioSuite plug-ins 32
for real-time plug-ins 18

plug-in settings librarian 36, 127
Plug-in window 18

closing multiple windows 20
opening multiple windows 20

plug-in-induced delays 14
plug-ins

adjusting parameters 41
as Inserts 15
auditioning settings 130
automating 24
creating a default setting 129
inserting 16
Manufacturer view 6
mono 15
moving and duplicating 17
multichannel 16
multi-mono 15



removing 16
post-disk inserts 15
POW-r Dither plug-in 60
Pre-delay control 63
pre-fader inserts 15
preferences

Plug-in Controls Default to Auto-Enabled 24
previewing AudioSuite effects 35
Process Mode selector 34
processing

AudioSuite 35
multichannel for AudioSuite 35
preferences 37
requirements of real-time plug-ins 9

R
Ratio control 88, 103, 104
real-time plug-ins 9
recording with plug-in effects 15
reference mark in SignalTools 86
Reference Pitch control 105
Region by Region mode 34
Region List command 33
Relative Pitch Entry 88
Reset Leq(A) 85
Reverb 6
Reverse plug-in 101
ReWire 135

and voices 137
automating input switching 142
client applications 135
looping playback 142
meter changes 141
MIDI automation 139
playing back MIDI continuous controller (CC) 

data 141
plug-in 138
quitting client applications 141
recording MIDI continuous controller (CC) data 

139
recording MIDI over 140
requirements 137
signal flow for audio and MIDI 136
software synthesizer 135
tempo sync 141
track count 137
using with Pro Tools 138
RMS 86
Root Settings folder 128

specifying 128
RTAS plug-ins 2

additional latency 28
improving performance 10
ordering with TDM plug-ins 28
placing after TDM plug-ins 27
placing on Auxiliary Inputs or Master Faders 27
voice usage 28

RTAS Processors setting 11

S
saving plug-in settings 129

Save Plug-in Settings To command 128
Save Settings As command 127
Save Settings command 127

screen response 10
scroll wheel

adjusting plug-in parameters 42
selecting tracks for AudioSuite processing 39
Selection Reference selector 32
Set As User Default command 128
Set Plug-in Default To command 128
Set Root Settings Folder command 128
settings 36

choosing a destination for 128
copying 129
creating subfolders 129
creating User Default 129
importing 129
pasting 129
saving 129
Settings Preferences command 128

Settings menu 18
Short Delay plug-in 79
shortcuts for keyboard input 64
sibilants 74
side-chain

definition 22
filters 22
processing 19

Side-Chain Listen 23
side-chain processing 22
Signal control 81
signal delay 147
Signal Generator plug-in 81, 101
Index 153



154
Signal Present Indicator 87
SignalTools

level meters 85
Size control 62
Slap Delay plug-in 79
Sound Field 6
Source and Destination controls 102
subfolders, creating for settings 129
SurroundScope 82
switches

adjusting plug-in parameters 42
system settings

RTAS Processors 11
System Usage window 146

RTAS 10
TDM 9

T
Target button 19
TC/E control 38
TCE Trim tool 111
TCE Trim tool preference 38
TDM plug-ins 1, 9

DSP requirements 143
inserting on tracks 16
moving and duplicating 17
ordering with RTAS plug-ins 28
removing from tracks 16

tempo
Tempo Sync 23

Tempo Sync 20, 23, 80
Mod Delay II 80

through-zero flanging 96
Time Compression/Expansion plug-in 102
Time Correction control 104
Time Shift 105

Audio Gain control 107
Audio Mode pop-up menu 106
Audio Range pop-up menu 106
Audio section 106
changing pitch 112
changing time 112
changing time and pitch 112
Clip indicator 107
Decay Rate 109
displays and controls 105
Follow button 109
DigiRack Plug-ins Guide
Formant section 108
Level indicator 107
Monophonic mode 106
Original time 107
Pitch section 110
Pitch Shift 110
Polyphonic mode 106
post production workflow 110
Processed time 107
pull up/pull down TCE percentages 110
Rhythmic mode 106
Speed 107
Tempo displays 107
Threshold control 109
Time section 107
timebase 107
Transient section 108
Transpose 110
Unit pop-up menu 107
Varispeed mode 106
Window 109

TimeAdjuster plug-in 89
using for delay compensation 13

Track selector 18
tracks

affect of RTAS 10
Trim plug-in 92

U
unlinking plug-in controls 21
Use in Playlist button 33
User Default setting, creating 129

V
VENUE (metering for) 86
voices

and ReWire 137
and RTAS 10, 28

VU 86

W
website 3
white noise 81
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